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Introduction 
Welcome to your Learner‘s Guide for the (Media Developer) ―Audio/Video Editor‖ level 3. It will help you complete the training and go on with 
further study or go straight into employment. 

The Audio/Video Editor Level 3 training is to engage young people with a program of development that will provide them with the knowledge, 
skills and understanding to start this career in Pakistan. This qualification will not only build the capacity of existing workers of this light Media 
sector but also support the youth to acquire skills best fit for this sector. 

The main elements of your learner‘s guide are:  

• Introduction:  
o This includes a brief description of your guide and guidelines for you to use it effectively 

• Modules:  
o The modules form the sections in your learner‘s guide  

• Learning Units:  
o Learning Units are the main sections within each module 

• Learning outcomes:  
o Learning outcomes of each learning units are taken from the curriculum document  

• Learning Elements:  
o This is the main content of your learner‘s guide with detail of the knowledge and skills (practical activities, projects, assignments, 

practices etc.) you will require to achieve learning outcomes stated in the curriculum 
o This section will include examples, photographs and illustrations relating to each learning outcome 

• Summary of modules:  
o This contains the summary of the modules that make up your learner‘s guide 

• Frequently asked questions:  
o These have been added to provide further explanation and clarity on some of the difficult concepts and areas. This further helps 

you in preparing for your assessment.  
• Multiple choice questions for self-test:  

o These are provided as an exercise at the end of your learner‘s guide to help you in preparing for your assessment. 

 





Modules 

Module 1: 0211009---Plan and Organize Work 

Objective of the module: After successful completion of this module, the student is competent in plan & organize work according to 
professional standards 

Duration: 20 Hrs Theory: 05 Hrs Practical: 15 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU 1: Set 
objectives and 
plan work 
activities 

  

The trainee will be able 
to: 

Identify work objectives 
in consultation with 
supervisor and 
consistent with 
organizational aims. 

Determine work activities 

are determined, 

consistent with, and 

linked to objectives and 

broken down into steps 

in accordance with set 

time frames. 

Establish work activity 

priorities and deadlines 

in consultation with 

others, as appropriate, 

Define communication skills: sharing information, listening and 

understanding, negotiation, facilitation and team collaboration 

 

Define conducting team meetings, coordinating, leading, 

motivation skills 

 

Explain organization‘s strategic plan, policies rules and 

regulations, laws and objectives for work unit activities and 

priorities 

 

Explain organizations policies, strategic plans, guidelines related 

to the role of the work unit  

 

Explain organizing, planning and presentation skills 

 

Explain team work and consultation strategies 

 

Computer 

Multimedia 

Printer 

 

 



optimizing the use of 

time and resources. 

Identify own and team 

responsibilities and 

levels of authority to 

ensure understanding of 

roles. 

Develop feedback 

mechanisms, key dates 

and performance 

indicators for monitoring 

and evaluation purposes 

 

Assess & allocate 

resource implications of 

the work activities for 

appropriate consistent 

with workplace 

procedures. 

LU2: 

Plan and 
schedule work 
activities 

The trainee will be able 

to: 

Schedule of work 

activities is coordinated 

Define communication skills: sharing information, listening and 

understanding, negotiation, facilitation and team collaboration 

Define conducting team meetings, coordinating, leading, 

motivation skills 

Computer 

Multimedia 

Printer 

 



with personnel 

concerned. 

Conduct work within 

established workplace 

policies and the business 

goals of the workplace. 

Schedule work tasks. 

Explain organization‘s strategic plan, policies rules and 

regulations, laws and objectives for work unit activities and 

priorities 

Explain organizations policies, strategic plans, guidelines related 

to the role of the work unit  

Explain organizing, planning and presentation skills 

Explain team work and consultation strategies 

 

LU3: Implement 
work plans 

 

The trainee will be able 

to: 

Identify Work methods 

and practices in 

consultation with 

personnel concerned. 

Implement Work plans in 

accordance with set time 

frames, resources and 

standards. 

Define communication skills: sharing information, listening and 

understanding, negotiation, facilitation and team collaboration 

Define conducting team meetings, coordinating, leading, 

motivation skills 

Explain organization‘s strategic plan, policies rules and 

regulations, laws and objectives for work unit activities and 

priorities 

Explain organizations policies, strategic plans, guidelines related 

to the role of the work unit  

Explain organizing, planning and presentation skills 

Explain team work and consultation strategies 

 

Computer 

Multimedia 

Printer 

 

 

LU4: Monitor 
work activities 

 

The trainee will be able 

to: 

Monitor & Compare work 

Define communication skills: sharing information, listening and 

understanding, negotiation, facilitation and team collaboration 

Define conducting team meetings, coordinating, leading, 

Computer 

Multimedia 

Printer 

 



activities are monitored 

with set objectives. 

Monitor work 

performance. 

Report deviations from 

work activities and 

recommend with 

appropriate personnel 

and in accordance with 

set standards. 

Compile reporting 

requirements with in 

accordance with 

recommended format. 

Prepare & maintain files 

in accordance with 

standard operating 

procedures. 

motivation skills 

Explain organization‘s strategic plan, policies rules and 

regulations, laws and objectives for work unit activities and 

priorities 

Explain organizations policies, strategic plans, guidelines related 

to the role of the work unit  

Explain organizing, planning and presentation skills 

Explain team work and consultation strategies 

 

LU5: Review 
and evaluate 
work plans and 
activities 

. 

The trainee will be able 

to: 

Review work plans, 

strategies and 

implementation based on 

relevant and current 

Define communication skills: sharing information, listening and 

understanding, negotiation, facilitation and team collaboration 

Define conducting team meetings, coordinating, leading, 

motivation skills 

Explain organization‘s strategic plan, policies rules and 

regulations, laws and objectives for work unit activities and 

Computer 

Multimedia 

Printer 

 



information. 

Review is based on 

comprehensive 

consultation with 

appropriate personnel on 

outcomes of work plans 

and reliable feedback. 

Identify & Develop ways 

to improve competence 

within available 

opportunities accordingly 

to feedback. 

Conduct performance 

appraisal in accordance 

with organization rules 

and regulations. 

Prepare performance 

appraisal report as per 

organization 

requirements. 

Prepare 

recommendations and 

presented to appropriate 

priorities 

Explain organizations policies, strategic plans, guidelines related 

to the role of the work unit  

Explain organizing, planning and presentation skills 

Explain team work and consultation strategies 

 



personnel/authorities. 

Prepare & Implement 

feedback mechanisms in 

line with organization 

policies. 

 

 

Examples and illustrations 

 

For more detailed information, please visit: Link 

Also visit  

Also visit  

 

VIDEOS: 

 

 

Video Link 

  

  

  

  

 

  





Module 2: 021100991 Develop Library 

 

Objective of the module: After successful completion of this module, the student is competent in Develop Library according to professional 
standards.  

Duration: 20 Hrs Theory: 04 Hrs Practical: 16 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU1: Collect 
Storyboard/Script 

 

The trainee will be able 
to: 

Review Script & 

Storyboard 

Identify requirement for 

video editing as per 

script/storyboard 

Make notes for editing 

 

 

Explain content of story board and concept 

Explain video editing 

Explain video editing requirements 

Explain how to store, manage and archive data 

Explain the importance of making notes for editing 

 

Tools & equipment; 

Computer 

Multimedia 

Adobe Creative Suit 

Final Cut Pro 

LU2: Collect 
Stock Footage 

 

The trainee will be able 
to: 

Receive video shoot log 

sheet 

Label received 

tapes/drives 

Ensure desired quality of 

the footage 

Prepare stock footage 

Explain Log Sheets and importance  

How to use Log Sheets 

Labeling and its Importance 

Explain editing software and its functions 

Explain Video Quality 

Explain Stock Footage and its uses 

Importance of Organizing data in folders 

Explain patch and connect in video & audio grabbing 

Tools & equipment; 

Computer 

Multimedia 

Adobe Creative Suit 

Final Cut Pro  



record 

Organize footage in 

respective folders 

 

 

LU3: Grab Video 

 

The trainee will be able 
to: 

Check equipment 

availability and 

performance  

Verify patching / 

connectivity  

Create project with 

relevant settings 

Log and Capture video 

Preview after capture 

Introduction to Equipment  

Connecting/Patching Equipment 

Different types of video card cables 

Explain different Video file formats 

Explain different size and resolution of project 

Explain editing software tools for grabbing video 

Tools & equipment; 

Computer 

Multimedia 

Adobe Creative Suit 

Final Cut Pro 

LU4: Grab Audio 

 

The trainee will be able 

to: 

Check equipment 

availability and 

performance 

Verify patching / 

connectivity 

Log and capture (audio 

only) 

Connecting/Patching Equipment 

Different types of sound cables 

Explain Audio formats 

Explain patching 

Define Audio channels and levels 

Define audio settings in detail 

 

 

Tools & equipment; 

Computer 

Multimedia 

Adobe Creative Suit 

Final Cut Pro 



Preview after capture 

Import into project If 

audio is in digital format, 

 

  



Examples and illustrations 

What Is a Storyboard? 

A storyboard is a visual outline for your video. It‘s made up of a series of thumbnail images that convey what happens in your video, from 
beginning to end. It also includes notes about what‘s happening in each frame. A finished storyboard looks like a comic strip. 

Storyboards can be simple or complex. They‘re usually hand-drawn, although some people prefer to use storyboarding software to create their 
images. A storyboard is similar to a script, but the two aren‘t quite the same – storyboards are visual, while scripts are text-based. 

A storyboard is a graphic organizer that plans a narrative. Storyboards are a powerful way to visually present information; the linear direction of 

the cells is perfect for storytelling, explaining a process, and showing the passage of time 

 

 



 

 

 

Creating a storyboard might just sound like an extra step in the process of making a video for your business, but trust us — it‘s a step you won‘t 
want to ignore. Here are three reasons why you need a storyboard.  

 

 

 

 

 

TVET SSP does not secure copyright of these pictures

https://www.vyond.com/


Script and its purpose: 

 

Screenwriting, also called scriptwriting, is the art and craft of writing scripts for mass media such as feature films, television 
productions or video games. It is often a freelance profession. 

Screenwriters are responsible for researching the story, developing the narrative, writing the script, screenplay, dialogues and delivering it, in 
the required format, to development executives. Screenwriters therefore have great influence over the creative direction and emotional impact 
of the screenplay and, arguably, of the finished film. Screenwriters either pitch original ideas to producers, in the hope that they will be optioned 
or sold; or are commissioned by a producer to create a screenplay from a concept, true story, existing screen work or literary work, such as a 
novel, poem, play, comic book, or short story. 

A video script is a chronological run-down of scenes, shots, action and dialogue specifying who is saying and doing what, and when they're 
saying or doing it. Each page of the script represents roughly one minute of screen time. 

 

 

https://en.wikipedia.org/wiki/Screenplay
https://en.wikipedia.org/wiki/Mass_media
https://en.wikipedia.org/wiki/Feature_film
https://en.wikipedia.org/wiki/Television_production
https://en.wikipedia.org/wiki/Television_production
https://en.wikipedia.org/wiki/Video_game
https://en.wikipedia.org/wiki/Freelance
https://en.wikipedia.org/wiki/Screenwriter
https://en.wikipedia.org/wiki/Pitch_(filmmaking)


Concept: 

Concept development is one of the steps in the new product/project development. After idea generation and screening, concept 
development is the detail version of idea, explained keeping in mind consumers’ needs. Which section of customers can be targeted, 
who will buy this, etc. are some basis for concept development. It is a process to ensure how you want the customers to perceive your 
product or service in the market.   

The creative ideas that you come up with during content development are what will make your video engaging to your audience. The 
unique ideas that are mined through your brainstorming and development process are the keys to getting your message out in a way 
that grabs your target market. 

The first key step in brainstorming your video concept is determining your primary message. It can be something specific or vague (i.e. 
‘Getting Leads via Pinterest’ or ‘Video Marketing’). Either way, you will start with this one message and end up with your perfect video 
concept. 

Data Archives  

Data archiving is the process of moving data that is no longer actively used to a separate storage device for long-term retention. Archive data 
consists of older data that remains important to the organization or must be retained for future reference or regulatory compliance reasons. 
Data archives are indexed and have search capabilities, so files can be located and retrieved. 

Large Media Files Sizes Slow Down Backup 

The most obvious nuance is that media files are BIG. While most business documents are under 30 MB in size, a single second of video could 
be larger than 30 MB at higher resolutions and frame rates. Backing up such large file sizes can take longer than the traditional backup 
windows of overnight for incremental backups and a weekend for full backup. And you can‘t expect deduplication to shorten backup times or 
reduce backup sizes, either. Video and images don‘t dedupe well. 

Meanwhile, the editing process generates a flurry of intermediate or temporary files in the active content creation workspace that don‘t need to 
be backed up because they can be easily regenerated from source files 

https://searchstorage.techtarget.com/definition/data-retention
https://searchcompliance.techtarget.com/definition/regulatory-compliance


Another difference is that archiving to reduce production storage costs is much more common in professional media workflows than with 
business documents, which are more likely to be archived for compliance. High-resolution video editing in particular requires expensive, high-
performance storage to deliver multiple streams of content to multiple users simultaneously without dropping frames. With the large file sizes 
that come with high-resolution content, this expensive resource fills up quickly with content not needed for current productions. Archiving 
completed projects and infrequently-used assets can keep production storage capacities under control. 

How to Archive Your Data  

Since long-term retention is the name of the game, you want to store your archived data on a storage medium that will last for as long as 
possible. Since different storage mediums have different life expectancies, not just any medium will do the trick. 

Depending on how much data you want archived, you also may want a cheap solution, since the cost of storage can add up quickly when you 
need to archive terabytes of data. 

 Hard Drives 

 Portable Hard Disk 

 Flash Storage 

 Blu-ray Discs 

 LTO Tapes 

 

Archiving to Save Space on Production Storage 

https://www.howtogeek.com/356473/how-to-archive-your-data-for-virtually-forever/


  

 

For more detailed information, please visit https://searchdatabackup.techtarget.com/definition/data-archiving 

 

 

 

Also visit https://valoso.com/ultimate-guide-to-video-marketing/chapter-8.html 

And https://www.noahdavidsonfilm.com/blog/2016/2/10/7-tips-for-creating-a-video-concept-for-your-business 

 

Log sheet  

A video shot log is a written record of the shots on a tape or disk. The shot log can be made either as the shoot progresses or after the shoot 
finishes. If possible, it really helps to do the shot log during the shoot — it will be easier and save you time later. 

There are no hard and fast rules regarding the format of the shot log. Basically, whatever works for you is fine. If you are working in a larger 
team environment you will probably have a standardised format so everyone uses the same system and gets the required information. 

Below is one example of how a shot log can be formatted. See the links below to download a blank printable version. 

https://searchdatabackup.techtarget.com/definition/data-archiving
https://valoso.com/ultimate-guide-to-video-marketing/chapter-8.html
https://www.noahdavidsonfilm.com/blog/2016/2/10/7-tips-for-creating-a-video-concept-for-your-business


 

 

 

 

Shot Log – Tired of wasting time looking for the right video clip while you‘re trying to edit? Proper shot logs form the essential guide to your 
inventory of footage when you‘re ready to edit. Record the precise times and lengths of scenes to make editing easier. 

1. The most obvious is for continuity because we shoot a script and even scenes out of sequence. Was her hair down or up for 
that scene? Was she holding the paper in her right or left hand? 

2. Reshoots and additional shots. It‘s easy for us to edit during the production phase which gives us the advantage of seeing 
and fulfilling the need for reshoots or added shots. Knowing key information on a scenes lighting and camera setup can be 
crucial. 

3. And last but not least, notes for postproduction like circle takes, used by the editor and director. While shooting you may 
remember why a decision was made onset for a shot but you won't remember days or weeks later when you're editing.  

There are three areas on set we focus on for our production notes. One is our subject: people, places, and props. The other is the 
lights that light them and third the camera that records it all.  



Script Supervisor Notes 
The first form is one of the most important, called Script Supervisor notes, and is sometimes called the circle take list. 

 

 

It actualizes the shot list. You know, that long list you thought you would get through in one day. It shows what you actuall y shot, not 
want you wanted to and is therefore very important for the editor.  
There are many versions of this sheet. None are the definitive right one. Use what works for you.  



 

 

Organizing your data 

Once you create, gather, or start manipulating data and files, they can quickly become disorganised. To save time and prevent errors later on, 
you and your colleagues should decide how you will name and structure files and folders. Including documentation (or 'metadata') will allow you 
to add context to your data so that you and others can understand it in the short, medium, and long-term. 



 

Organization is a common pain point among video editors.  Maybe its that most editors are creative right-brained leaning types, and they 

inherently have trouble keeping their files efficiently organized.   Add to that the fact that Editors are usually working under intense time 

constraints.  It‘s easy to get files misplaced, especially when media surfaces at different stages of the editing process. 



Good media management, file structure, versioning and a dedicated organization system is imperative to editing successfully.  Files that are 

saved to the wrong location can go missing, costing you time trying to pinpoint them…or worse, they get deleted. 

For tips on file naming check out my previous post: File Naming for Video Editors, Designers and Photographers. 
 

all the folders you need for the project‘s duration.  It‘s a free media management tool, so its definitely worth downloading it and testing it out in 

your workflow. 

Other Reddit users shared their own folder structures: 

 Footage (with subfolders for specific shoot dates if necessary) 

 Edits (put the timelines there) 

 Graphics 

 Audio 

 Images 

This particular structure is pretty standard for editing, but I‘d imagine it‘s best used to organize your media within your video editing 
application, not on your media drive.  If you set this up at the start of every project it‘ll be easier to organize your media as you bring it into the 
app through post production.  If you‘re looking for a folder structure for your hard drive, I liked this one: 

 00_Projects 

 01_MEDIA 

 02_AUDIO 

 03_GFX 

 04_SFX 

 05_MUSIC 

 06_OUTPUTS 

 07_DOCS 

http://www.premiumbeat.com/blog/file-naming/
http://www.reddit.com/r/editors/comments/19hvpt/does_anyone_have_a_system_for_keeping_their_files/
http://www.reddit.com/r/editors/comments/19hvpt/does_anyone_have_a_system_for_keeping_their_files/c8ol2do


Create a main folder for every new project and then dump this folder structure into it.   This simple list covers the broad file types that will be 

associated with most video editing projects (don‘t forget the Documents folder, an important inclusion).   The numerical prefixes help to keep 

the folders in order. 

Ultimately, the best folder structure is the one that works best for you.  Once you find one that works for your needs, BE CONSISTENT. 

It‘s easy to get lazy with file organization when you‘re in a video editing session and under pressure – saving files to your Desktop with 

obscure file names.  If you work this way, which is of course inadvisable, ALWAYS clean off your Desktop and Downloads folder at the end of 

the session day.  Move the files into their appropriate organized folder and then go back and relink them in your video editing app. You‘ll end 

up thanking yourself that you took the time. 

 

Grab Video: 

A video capture is a digitized version of an external video feed. Capturing video usually requires encoding or post-production software in 
addition to whatever hardware is being used to transmit the original feed into its digital file format (which can include a tape deck, digital storage 
or a video camera). 

 

Video capture cards come in two main types: internal circuit boards you install inside your computer and external boxes that connect via USB 
or another interface. Internal cards plug into standard PCI and PCI Express slots on a desktop computer's motherboard. Both types of video 
capture devices have one or more input jacks that accept analog or digital video. Computer chips on the card process the video input and send 
a stream of data through the PCI slot or USB connector. 

Input and Tuning 

The video capture card's input jacks take in video from a variety of sources. Depending on the card, it may be digital-only or it may have inputs 
for older analog sources such as DVD players. For example, RCA and S-video jacks support analog video; an HDMI connector accepts high-
definition video from digital sources. Some cards have tuner circuits that select channels from an antenna or broadband cable TV signal. Using 
a video capture card with a tuner, you can watch TV shows in one window on your computer screen while checking your email in another 
window. 

http://i.viglink.com/?key=535fb381c276aba2df16c56f4cdce13c&insertId=23d444532392eb56&type=H&exp=60%3ACI1C55A%3A15&libId=k0g90px201021li9000DAc5zra656&loc=https%3A%2F%2Fitstillworks.com%2Fvideo-capture-card-work-1715.html&v=1&iid=23d444532392eb56&opt=true&out=https%3A%2F%2Fwww.amazon.com%2Fdp%2FB07L35RB53&ref=https%3A%2F%2Fwww.google.com%2F&title=How%20Does%20a%20Video%20Capture%20Card%20Work%3F%20%7C%20It%20Still%20Works&txt=%3Cspan%3EComputer%20%3C%2Fspan%3E%3Cspan%3Echips%3C%2Fspan%3E


 

Conversion 

A specialized high-speed chip on the capture card analyzes the incoming video signal, turning it into a stream of digital images. The source 
largely determines the quality of the image and frame rate; generally, digital sources produce higher-resolution images at faster rates. Because 
analog signals have lower quality to begin with, a capture card typically processes these at a VGA-standard 640-by-480 resolution at 30 frames 
per second. HD signals have more picture information; the 1080p standard, for example, has a resolution of 1,920 by 1,080 pixels at up to 60 
frames per second. 

Buffering 

Once the video is converted into data, the processor chip on the capture card stores the video images into a memory area called a buffer. The 
buffer acts as a reservoir, keeping a certain amount of video data ready to send to the PC. The capture card may produce more data than the 
computer can handle at a given moment, so the buffer helps the PC stay in sync with incoming video images. 

Drivers and Editing Software 

The video capture card manufacturer provides software called drivers along with the card itself. When you install the capture card, Windows 
automatically loads the drivers, which become part of the computer's operating system. The drivers enable Windows to recognize the card and 
handle the data coming from it. To use the card, you connect it to a video source and start a video editing program. The program displays the 
video on your computer screen and helps you add, remove or rearrange scenes and then save the results to a file on the hard drive. 

http://i.viglink.com/?key=535fb381c276aba2df16c56f4cdce13c&insertId=cca71919b3c8ee92&type=KW&exp=60%3ACI1C55A%3A15&libId=k0g90px201021li9000DAc5zra656&loc=https%3A%2F%2Fitstillworks.com%2Fvideo-capture-card-work-1715.html&v=1&iid=cca71919b3c8ee92&opt=true&out=https%3A%2F%2Fanimoto.com%2Fpricing&ref=https%3A%2F%2Fwww.google.com%2F&title=How%20Does%20a%20Video%20Capture%20Card%20Work%3F%20%7C%20It%20Still%20Works&txt=%3Cspan%3Evideo%20%3C%2Fspan%3E%3Cspan%3Eediting%3C%2Fspan%3E


Audio  
Audio is a term used to describe any sound or noise that is within a range the human ear is capable of hearing. Measured in hertz, the audio 
signal on a computer is generated using a sound card and is heard through speakers or headphones. 
Any digital information that contains speech or music that can be stored on and played through a computer is referred to as an audio 
file or sound file. One of the most common types of audio file formats used today is the MP3. Clicking the triangular button on the 
following embedded player will play a short MP3 file in your browser 

 

There are compressed and uncompressed audio files, which may have either a lossy or lossless quality to it. Lossless files can be enormous in 
size, but if have ample storage (e.g., a PC or laptop, network storage drive, media server, etc.), and you own higher-end audio equipment, 
there are benefits to using uncompressed or lossless audio. 

But if space is at a premium, such as on smartphones, tablets, and portable players, or you plan to use basic headphones or speakers, then 
the smaller-sized compressed files are really all you need. 

So how do you choose? Here‘s a breakdown of common format types, some of their important characteristics, and reasons why you would use 
them. 

https://www.computerhope.com/jargon/s/sound.htm
https://www.computerhope.com/jargon/h/hertz.htm
https://www.computerhope.com/jargon/s/souncard.htm
https://www.computerhope.com/jargon/s/speaker.htm
https://www.computerhope.com/jargon/h/headphon.htm
https://www.computerhope.com/jargon/f/file-format.htm
https://www.computerhope.com/jargon/m/mp3.htm
https://www.computerhope.com/jargon/e/embedded.htm
https://www.lifewire.com/free-audio-converter-software-programs-2622863
https://www.lifewire.com/turn-smartphone-into-portable-media-player-4125165


 

MP3: Designed by the Moving Pictures Experts Group (MPEG), an organization that develops standards for coded audio and video programs, 
the MPEG-1/MPEG-2 Layer 3 (MP3) is arguably the most common and supported audio file type. 

 MP3 is both a compressed and lossy audio format, with bitrates ranging from 8 kbit/s up to a maximum of 320 kbit/s, and 
sampling frequencies ranging from 16 kHz to a maximum of 48 kHz. The smaller file sizes of MP3s means faster file transfers 
and less space used, but at the cost of some reduction in sound quality when compared to lossless file formats. 

AAC: Made popular by Apple iTunes, the Advanced Audio Coding (AAC) format is similar to MP3, but with one added benefit of greater 
efficiency. 

 AAC is both a compressed and lossy audio format, with bitrates ranging from 8 kbit/s up to a maximum of 320 kbit/s, and sampling 
frequencies ranging from 8 kHz to a maximum — with the right encoding process — of 96 kHz. 

 AAC files can deliver the same audio quality as an MP3 while taking up less space. ACC also supports up to 48 channels, while most 
MP3 files can handle only two. AAC is widely compatible with but not limited to iOS, Android, and handheld gaming devices. 

WMA: Developed by Microsoft as a competitor to the MP3, Windows Media Audio files offer a similar, albeit proprietary experience. The 
standard WMA is both a compressed and lossy audio format, although newer, distinct sub-versions with more advanced codecs can offer a 
lossless option. 

https://www.lifewire.com/m3u8-file-2621956
https://www.lifewire.com/best-free-audio-tools-for-splitting-up-large-files-2438496
https://www.lifewire.com/what-makes-an-audio-format-lossy-2438561
https://www.lifewire.com/aac-file-2619429
https://www.lifewire.com/mp3-file-2622780
https://www.lifewire.com/wav-wave-files-2622395


 While many types of portable media and home entertainment players support WMA files by default, few mobile devices like 
smartphones and tablets do. Many require downloading a compatible app in order to play WMA audio, which can make it less 
convenient to use versus MP3 or AAC. 

FLAC: Developed by the Xiph.Org Foundation, the Free Lossless Audio Codec (FLAC) has much appeal because of its royalty-free 
licensing and open format. 

 FLAC is both a compressed and lossless audio format, with file quality able to reach up to 32-bit/96 kHz (by comparison, a CD is 16-
bit/44.1 kHz). FLAC enjoys the advantage of a reduced file size (about 30 to 40 percent smaller than the original data) without having to 
sacrifice audio quality, which makes it an ideal medium for digital archiving (i.e., using it as the master copy in order to create 
compressed/lossy files for general listening). 

ALAC: Apple's version of FLAC, the Apple Lossless Audio Codec (ALAC) shares much with respect to audio quality and file size with FLAC. 

 ALAC is both a compressed and lossless audio format. It's also fully supported by iOS devices and iTunes, whereas FLAC may not be 
supported. As such, ALAC would most commonly be used by those using Apple products. 

WAV: Also developed by Microsoft, the Waveform Audio File Format is a standard for Windows-based systems and compatible with a variety of 
software applications. 

 WAV is both an uncompressed (but can also be coded as compressed) and lossless audio format, essentially an exact copy of the 
source data. Individual files can take up a significant amount of space, making the format more ideal for archiving and audio 
editing. WAV audio files are similar to PCM and AIFF audio files. 

AIFF: Also developed by Apple, the Audio Interchange File Format (AIFF) is a standard for storing audio on Mac computers. 

 AIFF is both an uncompressed (there is also a compressed variant) and lossless audio format. Like Microsoft's WAV file format, AIFF 
files can take up a lot of digital storage space, making it best for archiving and editing. 

PCM: Used to digitally represent analog signals, Pulse Code Modulation (PCM) is the standard audio format for CDs, but also for computers 
and other digital audio applications. 

 PCM is both an uncompressed and lossless audio format, quite often acting as the source data for creating other audio file types. 

https://www.lifewire.com/flac-file-2621334
https://www.lifewire.com/what-is-flac-audio-format-2438548
https://www.lifewire.com/what-is-alac-audio-format-2438531
https://www.lifewire.com/convert-wav-to-mp3-with-free-switch-audio-file-converter-2438832
https://www.lifewire.com/what-is-pcm-1846928


 

 

 

For more detailed information, please visit: https://www.mediacollege.com/video/production/shot-log/ 

https://www.videomaker.com/video-production-forms-download 

http://amazingstudiosinc.com/video-editing-organization-production-raleigh-nc/ 

https://itstillworks.com/video-capture-card-work-1715.html 

https://www.makeuseof.com/tag/audio-file-format-right-needs/ 

https://blog.online-convert.com/whats-the-difference-between-stereo-and-mono-audio-example/ 

 

Videos: 

 

Collect Storyboard/Script 

https://www.youtube.com/watch?v=KHT8atuN8aI 

https://www.youtube.com/watch?v=hg2aJ2SIqqs 

https://www.youtube.com/watch?v=IMep2s_T89c 

https://www.youtube.com/watch?v=Fu3vhFlXV0w 

 

Collect Stock Footage 

https://www.youtube.com/watch?v=WGpf7sgdJmg 

https://www.youtube.com/watch?v=x1_r4E1NPGk 

https://www.youtube.com/watch?v=KYvoj9ImT2k 

https://www.youtube.com/watch?v=0MIldAi6Zqk 

https://www.youtube.com/watch?v=zoHHoFbSUSw 

https://www.youtube.com/watch?v=VCPDOGV8xn0 

https://www.mediacollege.com/video/production/shot-log/
https://www.videomaker.com/video-production-forms-download
http://amazingstudiosinc.com/video-editing-organization-production-raleigh-nc/
https://itstillworks.com/video-capture-card-work-1715.html
https://www.makeuseof.com/tag/audio-file-format-right-needs/
https://blog.online-convert.com/whats-the-difference-between-stereo-and-mono-audio-example/
https://www.youtube.com/watch?v=KHT8atuN8aI
https://www.youtube.com/watch?v=hg2aJ2SIqqs
https://www.youtube.com/watch?v=IMep2s_T89c
https://www.youtube.com/watch?v=Fu3vhFlXV0w
https://www.youtube.com/watch?v=WGpf7sgdJmg
https://www.youtube.com/watch?v=x1_r4E1NPGk
https://www.youtube.com/watch?v=KYvoj9ImT2k
https://www.youtube.com/watch?v=0MIldAi6Zqk
https://www.youtube.com/watch?v=zoHHoFbSUSw
https://www.youtube.com/watch?v=VCPDOGV8xn0


 

 

Grab Video 

https://www.youtube.com/watch?v=IcChR9gvsj0 

https://www.youtube.com/watch?v=oYMszuMyGG4 

https://www.youtube.com/watch?v=s9vgx7CVNls 

https://www.youtube.com/watch?v=BD-YEarLd7w 

 

Grab Audio 

https://www.youtube.com/watch?v=JZjqVLvyX30 

https://www.youtube.com/watch?v=mAJxwuejPIY 

https://www.youtube.com/watch?v=kWzyUUe6pTg 

https://www.youtube.com/watch?v=WIIKXOrt3bk 

 

https://www.youtube.com/watch?v=IcChR9gvsj0
https://www.youtube.com/watch?v=oYMszuMyGG4
https://www.youtube.com/watch?v=s9vgx7CVNls
https://www.youtube.com/watch?v=BD-YEarLd7w
https://www.youtube.com/watch?v=JZjqVLvyX30
https://www.youtube.com/watch?v=mAJxwuejPIY
https://www.youtube.com/watch?v=kWzyUUe6pTg
https://www.youtube.com/watch?v=WIIKXOrt3bk




Module 4: 021100996 Perform Compositing 

 

Objective of the module: After successful completion of this module, the student is competent in perform compositing according to 
professional standards. 

Duration: 80 Hrs Theory: 30 Hrs Practical: 50 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU1: 

Review Project 
Brief 

 

The trainee will be able 
to: 

Identify instructions & 

specification for 

compositing 

Identify objective of 

compositing 

Collect information for 

compositing 

Arrange data (images, 

Elements) as per project 

brief 

 

Explain basics about titling, break bumpers, and end credits 

Define Compositing 

Define Animation 

Explain difference between animation & compositing 

Explain difference between 2D & 3D animation 

Explain in detail aftereffect workspace and all panels 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

 

LU2: 

Set 
Compositing 
Properties 

The trainee will be able 

to: 

Select video format as 

per project requirement 

Select frame rate as per 

Explain Compositing software 

Explain file formats 

Explain video formats & its types 

Explain image formats & its types 

Explain resolution 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

 



project requirement 

Select resolution as per 

project requirement 

Set composition duration 

as per project 

requirement 

Set Background Color as 

per project requirement 

Set composition duration 

as per project 

requirement 

Explain aspect ratios 

Explain color adjustment  

LU3: 

Import Media 

The trainee will be able 

to: 

 

Create data folders in 

compositing software 

Import images in 

compositing software as 

per project requirement 

Import elements in 

compositing software as 

per project requirement 

Explain types of images  

Explain types of videos 

Explain ways of importing different files in compositing 

software 

Explain importing composition in composition 

How to import as image sequence 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

 

LU4: 

Set 

The trainee will be able 

to: 

Describe Composition 

Explain different parts of composition 

Computer with Graphic 
Card 



Compositing 
Duration 

Set start frame as per 

project requirement 

Set end frame as per 

project requirement 

Explain Panels 

Explain about safe frame 

Explain compositing techniques 

Explain key frames 

 

Multimedia 

Adobe Creative Suit 

 

LU5: 

Create 
Animation 

The trainee will be able 

to: 

Place elements/images 

into composition as per 

project requirement 

Use solid layer for 

compositing as per 

project requirement 

Use 2D/3D layers for 

compositing as per 

project requirement 

Use cameras for 

compositing as per 

project requirement 

Use key frames for 

compositing as per 

project requirement 

Apply effects on layers 

Define layer in compositing software 

Explain layers types in compositing software 

Define properties of Layers 

Define panels on timeline 

Explain techniques of using camera for compositing 

Explain composting software tools & their function 

Explain compositing software filters and their functions 

Explain about rendering 

Explain techniques to generate output 

Explain output formats 

 

 
 

 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

 



as per project 

requirement 

Perform compositing as 

per project requirement 

Set output format as per 

project requirement 

Perform rendering as per 

set out format 

LU6: 

Make Revisions 

The trainee will be able 
to: 

Check final output 

Make corrections if 

needed 

Explain importance of revision 

Explain ways to review project 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

 

  



Illustration and Examples  

 

Compositing 

Compositing is the combination of multiple layers of images or video elements to render a final still or moving image. The combination of layers 
can be a physical or software-based operation. Rotoscoping is one compositing method. 

Compositing is the process of bringing all of your VFX elements together. So it‘s no surprise that every great VFX studio has a great compositor 
on-staff. However, you don‘t have to be a Hollywood-level VFX artist to composite like a pro. All it takes is a little creativity and time in After 
Effects. 

Adobe After Effects is a digital visual effects, motion graphics, and compositing application developed by Adobe Systems and used in the post-
production process of film making and television production. Among other things, After Effects can be used for keying, tracking, compositing, 
and animation. It also functions as a very basic non-linear editor, audio editor, and media transcoder.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://whatis.techtarget.com/definition/image
https://whatis.techtarget.com/definition/rotoscoping
https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Motion_graphics
https://en.wikipedia.org/wiki/Compositing
https://en.wikipedia.org/wiki/Application_software
https://en.wikipedia.org/wiki/Adobe_Systems
https://en.wikipedia.org/wiki/Post-production
https://en.wikipedia.org/wiki/Post-production
https://en.wikipedia.org/wiki/Film_making
https://en.wikipedia.org/wiki/Television_production
https://en.wikipedia.org/wiki/Chroma_key
https://en.wikipedia.org/wiki/Match_moving
https://en.wikipedia.org/wiki/Compositing
https://en.wikipedia.org/wiki/Animation
https://en.wikipedia.org/wiki/Non-linear_editor
https://en.wikipedia.org/wiki/Transcoding


Animation  

Animation is a method in which pictures are manipulated to appear as moving images. In traditional animation, images are drawn or painted by 
hand on transparent celluloid sheets to be photographed and exhibited on film. Today, most animations are made with computer-generated 
imagery (CGI). Computer animation can be very detailed 3D animation, while 2D computer animation can be used for stylistic reasons, low 
bandwidth or faster real-time renderings. Other common animation methods apply a stop motion technique to two and three-dimensional 
objects like paper cutouts, puppets or clay figures. 

Difference between 2D and 3D animation: 

 

 

2D Animation 3D Animation 

2D animation implies that the object is two dimensional. 3D animation implies that the object 

2D animation comprises of characters or objects only in height 
and width. In other words, in X- axis (horizontal dimension) and 

Y – axis (vertical dimension). 

3D animation comprises of objects in height, width, and 
depth. In other words, characters are going to be more a 

realistic contrast to 2D characters. 

TVET SSP does not secure copyright of these pictures

https://en.wikipedia.org/wiki/Traditional_animation
https://en.wikipedia.org/wiki/Cel
https://en.wikipedia.org/wiki/Film
https://en.wikipedia.org/wiki/Computer-generated_imagery
https://en.wikipedia.org/wiki/Computer-generated_imagery
https://en.wikipedia.org/wiki/Computer_animation
https://en.wikipedia.org/wiki/3D_computer_graphics
https://en.wikipedia.org/wiki/2D_computer_graphics
https://en.wikipedia.org/wiki/Real-time_rendering
https://en.wikipedia.org/wiki/Stop_motion
https://en.wikipedia.org/wiki/Cutout_animation
https://en.wikipedia.org/wiki/Puppet
https://en.wikipedia.org/wiki/Clay_animation


2D animation objects are created by traditional drawing method. 
Each move of the character has to be created frame by frame 

with hand-drawing, also called as a cell-animation method. 
However, today‘s 2D animators make use of software in 

developing action sequences. But creating the first action scene 
has to be created and the tool will generate the rest of the 

motion sequences automatically. 

In 3D animation, everything is going to be done in available 
computer software. The development consists of several 

phases or steps such as modelling, texturing, lighting, 
rigging, rendering etc. 

2D animation comes for a less price compared to 3D animation 
since you only need expert candidates who can draw and sketch 

aptly. 

Well, the cost of 3D animation depends on the money you 
spent in rendering. You have to shell out for each second; 
which is why the 3d animation course demands more from 

your pocket. Since the final product has to go through 
several steps, you gotta have a skilled professional for 

expected outcome. 

2D animation is all about frames. 3D animation is all about movements. 

It is not suitable for conceptual drawing as you can only 
represent in two dimensions. 

3D animation is impeccable for conceptual designing as it 
results in all the three-dimensional views. The software 

helps the animators to create a detailed character 
concentrating every possible 

2D animation is widely implemented in advertisements, films, 
cartoon shows, websites, e-learning courses, engineering 

etcetera. 

3D animation is widely used in gaming, movies, medical, 
biotechnology, aerospace etceter 

 



 

 

For more detailed information, please visit: https://www.rocketstock.com/blog/the-power-of-compositing-4-must-watch-after-effects-tutorials/ 

Also visit: https://pixelloid.com/blog/what-is-the-difference-between-2d-and-3d-animation/ 

And: https://www.dbswebsite.com/blog/what-is-the-difference-between-3d-and-2d-animation/ 

 

https://www.rocketstock.com/blog/the-power-of-compositing-4-must-watch-after-effects-tutorials/
https://pixelloid.com/blog/what-is-the-difference-between-2d-and-3d-animation/
https://www.dbswebsite.com/blog/what-is-the-difference-between-3d-and-2d-animation/


Compositing Software  

Adobe After Effects is a digital visual effects, motion graphics, and compositing application developed by Adobe Systems and used in the post-
production process of film making and television production. Among other things, After Effects can be used for keying, tracking, compositing, 
and animation. It also functions as a very basic non-linear editor, audio editor, and media transcoder. 

 

 

 

Targa (TGA) 

TGA files are very common in the industry because they can still offer great quality and are very widely supported. This file format was 
originally created by Truevision. And although TGA files aren't HDR, they are a solid choice if you're not working in HDR and you're not sure 
what other format to use. When you're using the TGA format, you'll most commonly run into an option to save in either 24 or 32-bit. That extra 8 

https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Motion_graphics
https://en.wikipedia.org/wiki/Compositing
https://en.wikipedia.org/wiki/Application_software
https://en.wikipedia.org/wiki/Adobe_Systems
https://en.wikipedia.org/wiki/Post-production
https://en.wikipedia.org/wiki/Post-production
https://en.wikipedia.org/wiki/Film_making
https://en.wikipedia.org/wiki/Television_production
https://en.wikipedia.org/wiki/Chroma_key
https://en.wikipedia.org/wiki/Match_moving
https://en.wikipedia.org/wiki/Compositing
https://en.wikipedia.org/wiki/Animation
https://en.wikipedia.org/wiki/Non-linear_editor
https://en.wikipedia.org/wiki/Transcoding


bits is the alpha channel; so basically a 24-bit TGA includes red, green and blue (RGB) channels whereas a 32-bit TGA file will include red, 
green, blue and alpha (RGBA) channels. 

Video File Formats  

 

A normal video file in a digital format is made up of two parts, a ―codec‖ and a ―container‖. A ―codec‖ is used to compress and decompress a 

video file, as there are times where video files are too large and may cause difficulty when trying to download or play the file. Some examples 

of ―codecs‖ are FFMpeg, DivX, XviD, and x264. A ―container‖ is a collection of files that stores information about the digital file. It simply means 



there is a combination of both audio and video data in a single file to allow for simultaneous audio-with-video playback. Some popular types of 

―containers‖ are AVI, FLV, WMV, MP4, and MOV. 

 

AVI (Audio Video Interleave) 

Developed by Microsoft and introduced to the public in November 1992 as part of its Video for Windows technology, the AVI format is one of 
the oldest video formats. It is so universally accepted that many people consider it the de facto standard for storing video and audio information 
on the computer. Due to it‘s simple architecture, AVI files are able to run on a number of different systems like Windows, Macintosh, Linux; is 
also supported by popular web browsers. AVI files stores data that can be encoded in a number of different codec‘s, although most commonly 
with M-JPEG or DivX codecs. This means that all AVI files, while they may look similar on the outside, differ substantially from one another on 

the inside.  

 



 

FLV (Flash Video Format) 

FLV files are videos that are encoded by Adobe Flash software, usually with codecs following the Sorenson Spark or VP6 video compression 
formats. They can be played via the Adobe Flash Player, web browser plugins or one of several third party programs. Since virtually everyone 
has the player installed on their browsers, it has become the most common online video viewing platform used on the Web today. As almost all 
video sharing sites such as Youtube stream videos in Flash, practically all browsers support and are compatible with the Flash Video format 
and can play the video with ease. In addition to being an online video viewing format, the Flash Video format is also what many video-sharing 
sites convert videos to, from formats that were uploaded by their users in something other than Flash. This is because videos in the FLV format 
remain in high quality even after compression to a smaller file size, which means that the videos on the Web load quickly and won‘t spend a lot 
of time using up bandwidth. Some notable users of the Flash Video are Youtube, Yahoo! Video, VEVO, Hulu and Myspace among many 
others. 

 

WMV (Windows Media Video) 

Developed by Microsoft, WMV was originally designed for web streaming applications, as a competitor to RealVideo, but it can now cater to 
more specialized content. WMV files are the tiniest video files over the Web, as their file size decreases significantly after compression, which 
results in poor video quality. However, one advantage of this small file size is that it is probably the only video file format that allows users to 
upload and share their videos through the e-mail system. Being a Microsoft software, the Windows Media Player is the main application that is 
used to play WMV files on all Microsoft‘s Windows operating systems, but there are also WMV players available for free for the Macintosh 
operating system. 

 



 

MOV (Apple QuickTime Movie) 

Developed by Apple. Inc, the QuickTime file format is a popular type of video sharing and viewing format amongst Macintosh users, and is 
often used on the Web, and for saving movie and video files. In recent years, Apple came up with a newer version called QuickTime X, 
currently available on Mac OS X Snow Leopard, Lion and Mountain Lion. MOV files are most commonly opened via the Apple QuickTime 
Player for the Macintosh Operating System. However, MOV files are not just limited to being played on Apple computers, as there is a free 
version of the QuickTime Player available for the Windows Operating System among many other players. Considered one of the best looking 
file formats, MOV files are of high quality and are usually big in file size. 



 

MP4 (Moving Pictures Expert Group 4) 

MP4 is an abbreviated term for MPEG-4 Part 14, a standard developed by the Motion Pictures Expert Group who was responsible for setting 
industry standards regarding digital audio and video, and is commonly used for sharing video files on the Web. First introduced in 1998, the 
MPEG-4 video format uses separate compression for audio and video tracks; video is compressed with MPEG-4 or H.264 video encoding; and 
audio is compressed using AAC compression. The MP4 file format is also another great file sharing format for the Web, MP4 file sizes are 
relatively small but the quality remains high even after compression. MP4 standard is also becoming more popular than FLV for online video 
sharing, as it compatible with both online and mobile browsers and also supported by the new HTML5. 



Image File Formats: 

 

 



Most image files fit into one of two general categories—raster files and vector files—and each category has its own specific uses. This 
breakdown isn‘t perfect. For example, certain formats can actually contain elements of both types. But this is a good place to start when 
thinking about which format to use for your projects. 

The different types of image file formats: 

1. Raster file formats 

1. JPEG 

2. GIF 

3. PNG 

4. TIFF 

5. RAW 

6. PSD 

2. Vector file formats 

1. PDF 

2. EPS 

3. AI 

 

What is a raster image 

Raster images are made up of a set grid of dots called pixels where each pixel is assigned a color. Unlike a vector image, raster images are 
resolution dependent, meaning they exist at one size. When you transform a raster image, you stretch the pixels themselves, which can result 
in a ―pixelated‖ or blurry image. When you enlarge an image, your software is essentially guessing at what image data is missing based on the 
surrounding pixels. More often than not, the results aren‘t great. 

https://99designs.com/blog/tips/image-file-types/#raster
https://99designs.com/blog/tips/image-file-types/#JPEG
https://99designs.com/blog/tips/image-file-types/#GIF
https://99designs.com/blog/tips/image-file-types/#PNG
https://99designs.com/blog/tips/image-file-types/#TIFF
https://99designs.com/blog/tips/image-file-types/#RAW
https://99designs.com/blog/tips/image-file-types/#PSD
https://99designs.com/blog/tips/image-file-types/#vector
https://99designs.com/blog/tips/image-file-types/#PDF
https://99designs.com/blog/tips/image-file-types/#EPS
https://99designs.com/blog/tips/image-file-types/#AI


 

Raster images are typically used for photographs, digital artwork and web graphics (such as banner ads, social media content and email 
graphics). Adobe Photoshop is the industry-standard image editor that is used to create, design and edit raster images as well as to add 
effects, shadows and textures to existing designs. 

CMYK vs. RGB 

All raster images can be saved in one of two primary color models: CMYK and RGB. 

https://99designs.com/banner-ad-design
https://99designs.com/blog/tips/correct-file-formats-rgb-and-cmyk/


 

 
 

CMYK a four-color printing process that stands for cyan, magenta, yellow and key (black). These colors represent the four inks that will 
combine during the printing process. Files saved in this format will be optimized for physical printing. 

RGB is a light-based color model that stands for red, green and blue. These are the three primary colors of light that combine to produce other 
colors. Files saved in this format will be optimized for the web, mobile phones, film and video—anything that appears on a screen. 

JPEG/JPG 

JPEG is a lossy raster format that stands for Joint Photographic Experts Group, the technical team that developed it. This is one of the most 
widely used formats online, typically for photos, email graphics and large web images like banner ads. JPEG images have a sliding scale of 
compression that decreases file size tremendously, but increases artifacts or pixelation the more the image is compressed. 

 



 

 

 

You should use a JPEG when… 

 You‘re dealing with online photos and/or artwork. JPEGs offer you the most flexibility with raster editing and compression making 
them ideal for web images that need to be downloaded quickly. 

 You want to print photos and/or artwork. At high resolution files with low compression, JPEGs are perfect for editing and then printing. 

 You need to send a quick preview image to a client. JPEG images can be reduced to very small sizes making them great for emailing. 

Don’t use a JPEG when… 

 You need a web graphic with transparency. JPEGs do not have a transparency channel and must have a solid color background. GIF 
and PNG are your best options for transparency. 

 You need a layered, editable image. JPEGs are a flat image format meaning that all edits are saved into one image layer and cannot be 
undone. Consider a PSD (Photoshop) file for a fully editable image. 



GIF 

GIF is a lossless raster format that stands for Graphics Interchange Format. The big question: how is it pronounced? The creator of GIF says 
―JIFF‖ like the peanut butter. This writer (and lots of the world) says ―GIFF‖ because graphics starts with a ―guh.‖ Anyway, we‘ll leave that up to 
you. GIF is also a widely used web image format, typically for animated graphics like banner ads, email images and social media memes. 
Though GIFs are lossless, they can be exported in a number of highly customizable settings that reduce the amount of colors and image 
information, which in turn reduces the file size. 

You should use a GIF when… 

 You want to create web animation. GIF images hold all of the animation frames and timing information in one single file. Image editors 
like Photoshop make it easy to create a short animation and export it as a GIF. 

 You need transparency. GIF images have an ―alpha channel‖ that can be transparent, so you can place your image on any colored 
background. 

 You need a small file. The compression techniques in the GIF format allow image files to shrink tremendously. For very simple icons 
and web graphics, GIF is the best image file format. 

Don’t use a GIF when… 

 You need a photographic-quality image. Though GIFs can be high resolution, they have a limit of 256 colors (unless you know a few 
tricks). Photos typically have thousands of colors and will look flat and less vibrant (and sometimes weird due to color banding) when 
converted to GIF. 

 You need to print an image. Because of the color limit, most printed photos will lack depth. If you need to print photos, look at TIFF, 
PSD and JPG. 

PNG 

PNG is a lossless raster format that stands for Portable Network Graphics. Think of PNGs as the next-generation GIF. This format has built-in 
transparency, but can also display higher color depths, which translates into millions of colors. PNGs are a web standard and are quickly 

becoming one of the most common image formats used online. 

 



 

 

You should use a PNG when… 

 You need high-quality transparent web graphics. PNG images have a variable ―alpha channel‖ that can have any degree of 
transparency (in contrast with GIFs that only have on/off transparency). Plus, with greater color depths, you‘ll have a more vibrant 
image than you would with a GIF. 

 You have illustrations with limited colors. Though any image will work, PNG files are best with a small color palette. 

 You need a small file. PNG files can shrink to incredibly tiny sizes—especially images that are simple colors, shapes or text. This 
makes it the ideal image file type for web graphics. 

Don’t use a PNG when… 

 You‘re working with photos or artwork. Thanks to PNGs‘ high color depth, the format can easily handle high resolution photos. However, 
because it is a lossless web format, file sizes tend to get very large. If you‘re working with photos on the web, go with JPEG. 



 You‘re dealing with a print project. PNG graphics are optimized for the screen. You can definitely print a PNG, but you‘d be better off 
with a JPEG (lossy) or TIFF file. 

TIFF/TIF 

TIFF is a lossless raster format that stands for Tagged Image File Format. Because of its extremely high quality, the format is primarily used in 
photography and desktop publishing. You‘ll likely encounter TIFF files when you scan a document or take a photo with a professional digital 
camera. Do note that TIFF files can also be used as a ―container‖ for JPEG images. These files will be much smaller than traditional TIFF files, 
which are typically very large. 

 

You should use a TIFF when… 

 You need high-quality print graphics. Along with RAW, TIFF files are among the highest quality graphic formats available. If you‘re 
printing photos—especially at enormous sizes—use this format. 

 You are making a high-quality scan. Using TIFF to scan your documents, photos and artwork will ensure that you have the best 
original file to work off of. 

Don’t use at TIFF when… 

 You‘re working with web graphics. While many web browsers support it, TIFF files are optimized for print. Go with JPEG or PNG when 
you need to display high-quality images online. 



RAW 

A raw image format contains the unprocessed data captured by a digital camera or scanner‘s sensor. Typically, images are processed 
(adjusted for color, white balance, exposure, etc.) and then converted and compressed into another format (e.g. JPEG or TIFF). Raw images 
store the unprocessed and processed data in two separate files, so you‘re left with the highest quality image possible that you can edit non-
destructively with a photo editing application like Photoshop. There are dozens and dozens of raw formats, but some of the typical formats are 
CRW (Canon), NEF (Nikon), and DNG (Adobe). 

 

 

 



You should use RAW when… 

 You are shooting and editing photos. Make sure your camera is set to RAW so you can capture the most versatile image. Then, use 
a compatible photo-editing application to adjust your image. 

Don’t use RAW when… 

 You‘re working with web graphics. RAW is built for photo editing. When you‘re ready to present your photos for the web, convert them to 
JPEG. 

 You‘re ready to print your photos. Many printers won‘t accept raw formats, so first convert to JPEG or TIFF. 

PSD 

PSD is a proprietary layered image format that stands for Photoshop Document. These are original design files created in Photoshop that are 
fully editable with multiple layers and image adjustments. PSDs are primarily used to create and edit raster images, but this unique format can 
also contain vector layers as well, making it extremely flexible for a number of different projects. A PSD can be exported into any number of 
image file formats, including all of the raster formats listed above. 

 



You should use a PSD when… 

 It‘s time to retouch photos. Need to color correct a photo? Or add a layer of text? PSD = photos. 

 You need to edit artwork for digital or print. That could be a photo, painting, drawing, or anything else. Photoshop is the right tool to 
make sure every line, shadow and texture is in place. 

 You want digital images for the web like social media images, banner ads, email headers, videos etc. Creating these images in 
Photoshop will ensure they‘re right size and optimized for the web. 

 You have to create a website or app mockup. Layers make it easy to move UI elements around. 

 You want to get fancy with animation and video. Photoshop makes it easy to cut together simple video clips and add graphics, filters, 
text, animation and more. 

Don’t use a PSD when… 

 You need to post a photo online or send a preview to a client. The web is JPEG friendly. Convert first to make sure your audience can 
see your image (and so it won‘t take several minutes to download). 

 You‘re ready to print your photos. Many printers won‘t accept the PSD format, so first convert to JPEG or TIFF. 

What is a vector image 

Vector images are digital artwork in which points, lines and curves are calculated by the computer. They essentially giant math equations, and 
every ―equation‖ can be assigned a color, stroke or thickness (among other styles) to turn the shapes into art. Unlike raster images, vector 
images are resolution independent. When you shrink or enlarge a vector image, your shapes get larger, but you won‘t lose any detail or get any 
pixelation. Because your image will always render identically, no matter the size, there is no such thing as a lossy or lossless vector image 
type. 

Vector images are typically used for logos, icons, typesetting and digital illustrations. Adobe Illustrator is the industry-standard image editor that 
is used to create, design and edit vector images (though it can also incorporate raster images, as well). 

 

 



 

 

 

Pixel 

A pixel is the smallest unit/dot or square of a image or graphics. 

The pixel (a word invented from "picture element") is the basic unit of programmable color on a computer display or in a computer image. 

 

Megapixel: 

A megapixel is equal to one million pixels 



 

 

Resolution 

Resolution is a measurement of the output quality of an image. 

 

 

 



 

Video Resolution and Aspect Ratio:  

The color graphics technology was first developed by IBM. CGA was first, followed by EGA and VGA - color graphics adapter, enhanced 
graphics adapter, video graphics array. Regardless of the capability of your monitor, you would still have to choose from one of the few options 
available through your graphics card's drivers. For the sake of nostalgia, here is a look at how things looked on a once well-known CGA 
display. 

 

With the advent of high definition video and the increased popularity of the 16:9 aspect ratio (we explain aspect ratios in a bit), selecting a 
screen resolution is not the simple affair it once was. However, this also means that there are a lot more options to choose from, with 
something to suit almost everyone's preferences. Let's look at what today's terminology is, and what it means: 

The screen is what by what? 

The term "resolution" is not correct when it is used to refer to the number of pixels on a screen. That says nothing about how densely the pixels 
are clustered. That is covered by another metric, called PPI (Pixels Per Inch). 

"Resolution" is technically the number of pixels per unit of area, rather than the total number of pixels. In this article, we are using the term as it 
is commonly understood, rather than the absolutely technologically correct usage. Since the beginning, the resolution has been 
described (accurately or not) by the number of pixels arranged horizontally and vertically on a monitor. For example, 640 x 480 = 
307200 pixels. The choices available were determined by the capability of the video card, and they differed from manufacturer to manufacturer. 

https://www.digitalcitizen.life/simple-questions-what-ppi-and-does-it-matter


 

The resolutions built into Windows were limited, so if you did not have the driver for your video card, you would be stuck with the lower-
resolution screen that Windows provided. If you have watched the old Windows Setup or installed a newer version of a video driver, you may 
have seen the 640 x 480 low-resolution screen for a moment or two. It was ugly, but that was the Windows default. 

As monitor quality improved, Windows began offering a few more built-in options, but the burden was still mostly on the graphics card 
manufacturers, especially if you wanted a really high-resolution display. The more recent versions of Windows can detect the default screen 
resolution for your monitor and graphics card and adjust accordingly. This does not mean that what Windows chooses is always the best 
option, but it works, and you can change it if you wish, after you see what it looks like. If you need guidance, read Change the screen resolution 
and make text and icons bigger in Windows 10. 

https://www.digitalcitizen.life/change-screen-resolution-make-text-icons-bigger-windows-10
https://www.digitalcitizen.life/change-screen-resolution-make-text-icons-bigger-windows-10


 

You may have seen the screen resolution described as something like 720p, 1080i or 1080p. What does that mean? To begin with, the letters 
tell you how the picture is "painted" on the monitor. A "p" stands for progressive, and an "i" stands for interlaced. 

The interlaced scan is a holdover from television and early CRT monitors. The monitor or TV screen has lines of pixels arranged horizontally 
across it. The lines were relatively easy to see if you got up close to an older monitor or TV, but nowadays the pixels on the screen are so small 
that they are hard to see even with magnification. The monitor's electronics "paint" each screen line by line, too quickly for the eye to see. An 
interlaced display paints all the odd lines first, then all the even lines. Since the screen is being painted in alternate lines, flicker has always 
been a problem with interlaced scans. Manufacturers have tried to overcome this problem in various ways. The most common way is to 
increase the number of times an entire screen is painted in a second, which is called the refresh rate. The most common refresh rate was 60 
times per second, which is acceptable for most people, but it could be pushed a bit higher to get rid of the flicker that some people still 
perceived. 



 

As people moved away from the older CRT displays, the terminology changed from refresh rate to frame rate, because of the difference in the 
way an LED monitor works. The frame rate is the speed with which the monitor displays each separate frame of data. The most recent versions 
of Windows set the framerate at 60 Hertz or 60 cycles per second, and LED screens do not flicker. Moreover, the system changed 
from interlaced scan to progressive scan because the new digital displays are so much faster. In a progressive scan, the lines are painted on 
the screen in sequence rather than first the odd lines and then the even lines. If you want to translate, 1080p, for example, is used for displays 
that are characterized by 1080 horizontal lines of vertical resolution and a progressive scan. There's a rather eye-boggling illustration of the 
differences between progressive and interlaced scans on Wikipedia here: Progressive scan. For another fascinating history lesson, also 
read Interlaced video. 

What about the numbers: 720p, 1080p, 1440p, 2K, 4K and 8K? 

When high-definition TVs became the norm, manufacturers developed a shorthand to explain their display resolution. The most common 
numbers you see are 720p, 1080p, 1140p or 4K. As we have seen, the "p" and the "i" tell you whether it is a progressive-scan or an interlaced-

http://en.wikipedia.org/wiki/Progressive_scan
http://en.wikipedia.org/wiki/Interlaced_scan


scan display. Moreover, these shorthand numbers are sometimes used to describe computer monitors as well, even though in general a 
monitor is capable of a higher definition display than a TV. The number always refers to the number of horizontal lines on the display. 

Here's how the shorthand translates: 

 720p = 1280 x 720 - is usually known as HD or "HD Ready" resolution 
 1080p = 1920 x 1080 - is usually known as FHD or "Full HD" resolution 
 1440p = 2560 x 1440 - is commonly known as QHD or Quad HD resolution, and it is typically seen on gaming monitors and on high-end 

smartphones. 1440p is four times the resolution of 720p HD or "HD ready." To make things even more confusing, many premium 
smartphones feature a so-called 2960x1440 Quad HD+ resolution, which still fits into 1440p. 

 4K or 2160p = 3840 x 2160 - is commonly known as 4K, UHD or Ultra HD resolution. It is a huge display resolution, and it is found on 
premium TVs and computer monitors. 2160p is called 4K because the width is close to 4000 pixels. In other words, it offers four times 
the pixels of 1080p FHD or "Full HD." 

 8K or 4320p = 7680 x 4320 - is known as 8K and it offers 16 times more pixels than the regular 1080p FHD or "Full HD" resolution. For 
now, you see 8K only on expensive TVs from Samsung and LG. However, you can test whether your computer can render such a large 
amount of data using this 8K video sample: 

https://youtu.be/ChOhcHD8fBA 

The problem with 2K is that it does not exist for consumer devices 

In cinematography, the 2K resolution exists, and it refers to 2048 × 1080. However, in the consumer market, it would be considered 1080p. To 
make things worse, some display manufacturers use the term 2K for resolutions like 2560x1440, because their displays have a horizontal 
resolution of 2000 pixels or more. Unfortunately, that is incorrect, as this resolution is 1440p, or Quad HD, and not 2K. 

https://en.wikipedia.org/wiki/2K_resolution


 

Therefore, when you hear about a TV, computer monitor, smartphone or tablet having a 2K resolution, this statement is incorrect. The real 
resolution is likely to be something like 1440p or Quad HD. 

Can you see high-resolution videos on lower resolution screens? 

You might wonder whether you can watch a high-resolution video on a smaller resolution screen. For example, is it possible to use a 720p TV 
to watch a 1080p video? The answer is yes! Regardless of what your screen resolution is, you can watch any video on it, no matter the video's 
resolution (higher or lower). However, if the video you want to watch has a higher resolution than that of your display, your device converts the 
video's resolution to one that fits the resolution of your display. For example, if you want to watch a video with a 4K resolution on a 720p 
screen, that video is shown at 720p resolution, because that is all that your screen can offer. 

What is the Aspect Ratio? 

The term aspect ratio was initially used in motion pictures, indicating how wide the picture was in relation to its height. Movies were initially in 
4:3 aspect ratio, and this carried over into television and early computer displays. Motion picture aspect ratio changed much more quickly to a 
wider screen, which meant that, when movies were shown on TV, they had to be cropped or the image had to be manipulated in other ways to 
fit the TV screen. 



 

 

As display technology improved, TV and monitor manufacturers began to move toward widescreen displays as well. Originally "widescreen" 
referred to anything wider than the typical 4:3 display, but it quickly came to mean a 16:10 ratio and later 16:9. Nowadays, nearly all computer 
monitors and TVs are only available in widescreen, and TV broadcasts and web pages have adapted to match. 

Until 2010, 16:10 was the most popular aspect ratio for widescreen computer displays. However, with the rise in popularity of high definition 
televisions, which were using high definition resolutions such as 720p and 1080p and made these terms synonyms with high-definition, 16:9 
has become the high-definition standard aspect ratio. 

Depending on the aspect ratio of your display, you can use only resolutions that are specific to its width and height. Some of the most common 
resolutions that can be used for each aspect ratio are the following: 

 4:3 aspect ratio resolutions: 640×480, 800×600, 960×720, 1024×768, 1280×960, 1400×1050, 1440×1080, 1600×1200, 1856×1392, 
1920×1440, and 2048×1536. 

 16:10 aspect ratio resolutions: 1280×800, 1440×900, 1680×1050, 1920×1200, and 2560×1600. 



 16:9 aspect ratio resolutions: 1024×576, 1152×648, 1280×720 (HD), 1366×768, 1600×900, 1920×1080 (FHD), 2560×1440 (QHD), 
3840×2160 (4K), and 7680 x 4320 (8K). 

Is there a relation between aspect ratio and display orientation? 

The display orientation refers to how you look at a screen: the most common screen orientations used are landscape and portrait. Landscape 
orientation means that the width of the screen is larger than its height, while portrait orientation means the opposite. Most large screens, such 
as the ones we use on our computers, laptops, or TVs, use landscape orientation. Smaller screens, such as the ones on our smartphones, are 
normally used in portrait mode, but, because their size allows you to easily rotate them, they can also be used in landscape mode. The aspect 
ratio of the screen defines the ratio of its longer side to its shorter side. Consequently, that means that the aspect ratio of the screen tells you 
the ratio of the width to height when you look at it in landscape mode. The aspect ratio is not used to describe screens (or any rectangular 
shapes) in portrait mode. 

 

In other words, you could say that an aspect ratio of 16x9 is the same as 9x16, but the latter is not an accepted form of referring to aspect ratio. 
However, you can refer to the screen resolution in both ways. For example, a resolution of 1920x1080 pixels is the same as 1080x1920 
pixels; it is just that the orientation differs. 

How does the size of the screen affect resolution? 

Although a 4:3 TV's display can be adjusted to show black bars at the top and bottom of the screen, while a widescreen movie or show is being 
displayed, this does not make sense with a monitor, so Windows does not even offer you the widescreen display as a choice. You can watch 
movies with black bars as if you were watching a TV screen, but this is done by your media player. 



 

A 4:3 aspect ratio movie on a 16:9 display 

The most important thing is not the monitor size, but its ability to display higher resolution images. The higher you set the resolution, the smaller 
the images on the screen are, and there comes a point at which the text on the screen becomes so small it is not readable. On a larger monitor 
it is possible to push the resolution very high indeed, but if that monitor's pixel density is not up to par, you won't get the maximum possible 
resolution before the image becomes unreadable. In many cases, the monitor does not display anything at all if you tell Windows to use a 
resolution that the monitor cannot handle. In other words, do not expect miracles out of a cheap monitor. When it comes to high-definition 
displays, you definitely get what you pay for. 

 

For more detailed information, please visit: https://helpx.adobe.com/after-effects/kb/supported-file-formats.html 

 

https://helpx.adobe.com/after-effects/kb/supported-file-formats.html


Import Files into After Effects 

After Affects offers tremendous support for different importing file types — 
virtually every common format of video, audio and still image is supported 
Note: Imported files are referred to as footage, whatever type of file they are. 

There are several ways to import files: 

From the main menu, select File > Import > File (keyboard 
shortcut Ctrl/Cmd+I). This opens the import dialogue box and allows you to 
select one or more files from a particular folder. To select multiple files, click 
while holding down the Shift key for contiguous files or the Ctrl/Cmd key for non-contiguous (separated) files. 

Select File > Import > Multiple Files (keyboard shortcut Ctrl/Cmd+Alt+I) to import multiple files located in different folders. The standard 
dialogue box appears, but after you click Open the box remains and you can navigate to another folder to select more files. Keep doing this 
until all files are selected, then click Done. 

You can also bring up the dialogue boxes from the project panel: 

 Right-click anywhere in the project panel and select either Import > File or Import > Multiple Files. 

 Double-click anywhere in the project panel to bring up the standard import dialogue box. 

Virtually every common format of video, audio and still image is supported (see the complete list). 
 
After Effects Supported File Types 

The following lists show the types of file you can import into Adobe After Effects. 

Video and animation formats 

 Animated GIF (GIF) 

 DV (in MOV or AVI container, or as containerless DV stream) 

 ElectricImage (IMG, EI) 

 Filmstrip (FLM) 

 Flash (SWF; rasterized) 

Note: The alpha channel is imported with SWF files but interactive content is not. 

https://www.mediacollege.com/adobe/after-effects/workflow/project/
https://www.mediacollege.com/adobe/after-effects/workflow/import/file-types.html


 MPEG formats (MPEG, MPE, MPG, M2V, MPA, MP2, M2A, MPV, M2P, M2T, VOB, MOD, AC3, MP4, M4V, M4A) 

 Open Media Framework (OMF; raw media [or essence] only; Windows only) 

 QuickTime (MOV; 16 bpc, requires QuickTime) 

 Adobe Photoshop with video layer (PSD; requires QuickTime) 

 Video for Windows (AVI, WAV; requires QuickTime on Mac OS) 

Note: You can import 10-bpc uncompressed YUV AVI files created in Adobe Premiere Pro into 16-bpc RGB After Effects projects. You can 

also render with 10-bpc YUV compression. (See Specify Video for Windows compression options.) 

 Windows Media File (WMV, WMA, ASF; Windows only) 
Audio formats 

 Advanced Audio Coding (AAC, M4A) 

 Audio Interchange File Format (AIF, AIFF) 

 MP3 (MP3, MPEG, MPG, MPA, MPE) 

 Video for Windows (AVI, WAV; requires QuickTime on Mac OS) 

 Waveform (WAV) 
Still-image formats 

 Adobe Illustrator (AI, AI4, AI5, EPS, PS; continuously rasterized) 

 Adobe PDF (PDF; first page only; continuously rasterized) 

 Adobe Photoshop (PSD) 

 Bitmap (BMP, RLE, DIB) 

 Camera raw (TIF, CRW, NEF, RAF, ORF, MRW, DCR, MOS, RAW, PEF, SRF, DNG, X3F, CR2, ERF; 16 bpc) 

 Cineon (CIN, DPX; converts to project‘s color bit depth: 8, 16, or 32 bpc) 

 Discreet RLA/RPF (RLA, RPF; 16 bpc, imports camera data) 

 EPS 

 JPEG (JPG, JPE) 

 Maya camera data (MA) 

 Maya IFF (IFF, TDI; 16 bpc) 

 OpenEXR (EXR; 32 bpc) 



 PBM (8, 16, and 32 bpc) 

 PCX 

 PICT (PCT) 

 Pixar (PXR) 

 Portable Network Graphics (PNG; 16 bpc) 

 Radiance (HDR, RGBE, XYZE; 32 bpc) 

 SGI (SGI, BW, RGB; 16 bpc) 

 Softimage (PIC) 

 Targa (TGA, VDA, ICB, VST) 

 TIFF (TIF) 

Note: Still-image formats can be imported individually or as a sequence. 

Project formats 

 Advanced Authoring Format (AAF; Windows only) 

 Adobe Premiere 6.0 and 6.5 (PPJ) 

 Adobe Premiere Pro 1.0, 1.5, 2.0, CS3 (PRPROJ; 1.0, 1.5, and 2.0 Windows only) 

 Adobe After Effects 4.0 and later (AEP, AET) 

 XML Forms Data Format (XFDF; for importing of Clip Notes comments) 

 

For more detailed information, please visit: https://www.mediacollege.com/adobe/after-effects/workflow/import/file-types.html 

 

 
 

 

Setting the Duration of a Composition 

Here are a few notes and tips for working with composition durations... 

https://www.mediacollege.com/adobe/after-effects/workflow/import/file-types.html


 The duration is displayed in the format 0:00:00:00, i.e. Hours: Minutes: Seconds: Frames 

 The default duration is 30 seconds (0:00:30:00). 

 The maximum duration is 3 hours (3:00:00:00). 

If you enter a number without colons, it is assumed to be the number of frames. In the example below, the number 250 has been entered. This 
is a PAL composition (25 frames per second), so the number will automatically be converted to 4 seconds (0:00:4:00). 

 

Another useful trick is to enter a number followed by a period (full stop). This converts the number to seconds instead of frames, saving you the 
annoyance of having to type all those zeros and colons. For example, the number 2 followed by a period converts to 2 seconds: 

 

Add two periods to convert to minutes, and add three periods to convert to hours. For example: 

 

Create a composition and manually set composition settings 

1. Choose Composition > New Composition, or press Ctrl+N (Windows) or Command+N (Mac OS). 

Create a composition from a single footage item 

1. Drag the footage item to the Create A New Composition button  at the bottom of the Project panel or choose File > New Comp From 
Selection. 
Composition settings, including frame size (width and height) and pixel aspect ratio, are automatically set to match the characteristics of the 
footage item. 



Create a single composition from multiple footage items 

1. Select footage items in the Project panel. 
2. Drag the selected footage items to the Create A New Composition button  at the bottom of the Project panel, or choose File > New Comp 

From Selection. 
3. Select Single Composition and other settings in the New Composition From Selection dialog box: 

Use Dimensions From 

Choose the footage item from which the new composition gets composition settings, including frame size (width and height) and pixel aspect 
ratio. 

Still Duration 

The duration for the still images being added. 

Add To Render Queue 

Add the new composition to the render queue. 

Sequence Layers, Overlap, Duration, and Transition 

Arrange the layers in a sequence, optionally overlap them in time, set the duration of the transitions, and choose a transition type. 

Create multiple compositions from multiple footage items 

1. Select footage items in the Project panel. 
2. Drag the selected footage items to the Create a New Composition button  at the bottom of the Project panel, or choose File > New Comp 

From Selection. 
3. Select Multiple Compositions and other settings in the New Composition From Selection dialog box: 

Still Duration 

The duration of the compositions created from still images. 

Add To Render Queue 

Add the new compositions to the render queue. 

 



 

 

 

 



After Effects Workspaces and Interface 

The After Effects interface is pictured below. This is what you will see each time that you open the After Effects program on your computer. 

 

 At the top of the After Effects application window, you will see the Menu Bar. It looks like this: 

 

                  

 

  



You will find the tools and commands that you need to successfully use After Effects in the Menu Bar.   However, much of the time, you will find 

that you can also access the same tools and commands in the panels. 

Below the Menu Bar, you will see the Toolbar. 

 

You will use the toolbar a lot in After Effects. 

The Adobe Effects interface is made up of panels.   Unlike a lot of other programs you have probably used in the past, Adobe After Effects 
contains several different workspaces, each featuring panels related to the workspace.  

Below is the Standard workspace. The panels displayed in the Standard workspace contain the tools and commands you will need when 
working in this workspace. 

 



The Project panel is pictured below. 

 

 

Want to learn more? Take an online course in Adobe After Effects. 

  

https://www.universalclass.com/i/course/learn-adobe-after-effects.htm


When you change the workspace, some of the panels will change as well. Again, this is so the tools and commands that you need are right 

there when you need them. 

To change the workspace, go to the Workspace menu to the far right of the Toolbar. We circled it in red in the following snapshot. 

 

 

 

 



Click the downward arrow to the right of Standard. 

 

 

  

You will then see the various workspaces that you have to choose from. You will choose the workspace by the task that you need to 

complete. If you wanted to work with text, for example, you would choose the Text workspace. 

The Text workspace is shown below. 



 

Note that with the Text workspace, we see the Character panel. 

 

 



  

You can add or remove panels from a workspace by going to Window in the Menu Bar. Panels with a checkmark beside them are already 

showing in the workspace. Click to remove the checkmark and remove it from the workspace. Place checkmarks beside panels that you want 

to appear. 

Adjusting the Brightness of the After Effects Screen 

If you want to brighten or dim the interface in After Effects, go to Edit>Preferences>Appearance. 

 



Drag the brightness slider to the right to increase the brightness. Drag it to the left to decrease it.  

The After Effects Workflow 

A workflow is a series of steps that you take to complete a project using a software program, such as Adobe After Effects.   Although following 

the workflow is not mandatory and ultimately will not affect the outcome of your project, it does make things quicker and easier.  

The After Effects workflow has six steps.   These steps are listed below. 

1.    Import and organize your footage.  

2.    Create your compositions and arrange layers.  

3.    Add Effects.  

4.    Animate Elements.  

5.    Preview your work.  

6.    Render and output the final composition. 



Creating a Project 

By definition, a project in After Effects is a file that stores all references to all footage that you use in the project. A project also contains 
compositions. Compositions are containers that are used to combine footage and add effects.  

When you first open After Effects, you will see this dialogue box: 

 

This is the Welcome Screen. From here, you can open a new composition, open a project, or find help and support.   

For the purpose of this article, click Close.   

To create a new project, go to File>New>New Project. 

If you do not have a project open or do not open a project on the Welcome Screen, After Effects automatically creates a new project for 
you.   The default name is Untitled Project. 

Importing Footage from Your Computer 

Once you have created a new project, go to File>Import>File.   In order to start a new project, you must import footage into it.   All projects 
contain footage.  

When you click File>Import>File, you will see the Import File dialogue box: 



 

Locate the footage that you want to import, then click the Import or Open button. 

You will see a thumbnail preview of your footage in the Project panel on the left. 



 

You can import all kinds of footage into After Effects. This includes audio files, layered files from Adobe Photoshop or Illustrator, images, video 
clips, other After Effects projects, and projects from Premiere Pro.  

A Word about Audio 

After Effects is not an audio editing program by any means. However, you can use some audio effects in After Effects to control the sound and 
quality. 

In addition, you can also loop audio clips in your compositions if the composition is longer than your audio track. 

There are two ways to loop audio. The first is to create a duplicate audio layer, then set the duplicate layer to start playing when the source 
layer ends.   This is a lot of work, and there is an easier way. 

If you need to loop audio, right click on the audio clip in the Project panel. Select Interpret Footage>Main. 



 

In the Other Options section, you can set the audio clip to loop as many times as you would like. 

Click OK when you are finished. 

Importing Photoshop or Other Layered Files 

Once you import your footage for a project, you will create a new composition. However, for now it is important to understand that a 
composition combines all the footage that you import. 

That said, if you want to import a Photoshop or Illustrator file that contains several layers (that have not been merged or flattened), you will 
need to import that file as a composition. 

To do this, go to File>Import>File.  



 

Navigate to the file, then click on it to select it. 

In the Import As field, select Composition. 

Click the Import or Open button. 

You will then see the following dialogue box: 



 

Make sure the Import Kind field is set to Composition. 

Also, make sure Editable Layer Styles is selected.  

Click OK. 

You will then see the footage in the Project panel. 

NOTE:  When you import footage into After Effects, After Effects creates a reference link to the source file. It does not actually import the 
footage. This allows project sizes to remain small. You can go to File>Dependencies>Find Missing Footage if After Effects notifies you that it 
cannot find a source file. If you have moved the file, you will need to relocate it for After Effects. 

Creating Compositions 

Once you have created a project and imported all the footage for that project, you are ready to create a composition. A composition contains all 
your footage, as well as the animation, layering, and effects.   It has both temporal – or time – dimensions and special dimensions. You will see 
what we mean in just a minute. 

To create a composition, go to the Project panel. Ctrl+Click on all your footage items. 



 

Next, drag the footage items to the Timeline panel, as illustrated below. 

You will then see the New Composition from Selection dialogue box. 



 

The dimensions used for the new composition will be based on the footage you selected. 

You can change the dimensions to match any of the footage that you have selected: 

 

Click OK when you are finished. 



The footage items that you selected to include in the composition are shown as layers in the Timeline panel. 

 

If you look at the snapshot of the Timeline panel above, you will see two layers, labeled 1 and 2.  

Our After Effects workspace is pictured below. 

 

Working with Composition Settings 

The lengths of the footage that you add to a composition may vary. For example, you may have footage that lasts 1:10 and another that lasts 
1:50.   If you want, you can change the length of the entire composition to match the length of one piece of footage. 

To do this, go to Composition>Composition Settings. 



You will then see the Composition Settings dialogue box. 

Go to the Duration field and enter the desired duration for the composition.  

 

Click OK when you are finished. 

Introducing Layers 

Layers are the elements that build a composition. As we discussed in the last section, any footage that you add to a composition becomes a 
new layer. Layers are stacked on top of each other. The order follows the stacking order in the Composition panel. 

Just as with Photoshop or other photo editing programs, you can work with one layer in a composition. The changes you make to that layer will 
not affect other layers in the composition.  

You can also use a composition as a layer in another composition. This is called nesting. 

Adding a Radial Blur Effect to a Layer 

Now that you have created a composition and, by doing so, created layers, you can now add animation and effects to those layers. 



Let's start out by learning how to add an effect to a layer by adding a Radial Blur effect to a layer.  

To do so, select a layer in your composition. We have selected a layer in the snapshot below. 

 

Next, go to the Effects & Presets panel. This is on the right side of the window. It is pictured below. 

 

In the search box within the panel, type Radial Blur, then hit Enter on your keyboard. 

You will then see the effect, as shown below. 



 

Click on the effect to select it, then drag it onto your layer in the Timeline panel. We have illustrated this below with a red line.  



 

The Effect is then applied, and the Effect Controls panel then opens on the left side of the window. 



 

Now you can customize your effect.  

Drag the number in the Amount field to increase or decrease the amount of the effect. 

If we look at the Composition panel, we can see our before and after when we increased the effect. 

Below is our before snapshot: 



 

This is after: 

 

In the Composition panel, we can also move the center point of the blur by dragging on the center crosshair. 

If we go back to the Effect Controls panel, we can also choose the type of radial blue: Spin or Zoom. We have chosen Zoom. 



 

Adding an Exposure Effect to a Layer 

Let's say we want to adjust the exposure of this layer to make it brighter. To do that, we will add an exposure effect.  

Go back to the Effects & Presets panel. This time type Exposure in the search box.  

 

Drag the exposure effect to the layer in the Timeline panel. 

Take a look at the Effect Controls panel. 



 

Once again, you can customize the effect.  

Take time to explore the different ways you can customize the effect to get a feel of what it can do. If you want to undo a change you made, 
simply go to Edit>Undo. 

Working with Layer Properties 

As you already know, layers are stacked one upon another.   The image or video that is "on top of the stack" is the one that you see when you 
look at your composition.  

For example, the composition in the snapshot below contains two layers. 



 

There is another layer beneath the layer that is displayed.   

That said, you can move, rotate, scale, and change the opacity for any layer in a composition by changing the layer's properties.   You can do 
this to change the way the layer appears with the other layers.   

We are going to reposition and rotate this layer, then change the opacity.   

To do this, go to the Timeline panel. Find the layer that you want to work with, then click the triangle beside the layer number, as shown below. 



 

When you click on the triangle, you will see Transform (as illustrated above).  

Next, click the triangle beside Transform. 

 

You can now change the anchor point, position, scale, rotation, or opacity by mousing over the values in yellow, then dragging to the right to 
increase the values – or to the left to decrease the values. 

You can see our adjusted values below. 



 

If you look at our composition in the Composition panel, you can now see the second layer, as well as the transformation we made by changing 
the layer's properties. 

 



Blending Modes 

The blending modes in After Effects are the same as they are in Adobe Photoshop. Blending modes determine how one layer reacts with 
another layer. 

The blending modes in After Effects are found by going to Layer>Blending Mode. 

 



To apply a blending mode, select a layer in the Timeline panel.   The blending mode you apply will affect how that layer reacts to the layers 
beneath it.  

Take the time to select a layer in your Timeline panel, then apply the different blending modes to see what affect they have on your 
composition. 

Below is our composition: 

 

We have a background layer, then a solid layer for which we've adjusted the Opacity property to 58%. 

To apply a blending mode, we are going to select the top layer, then select the blending mode. 

This is Color Dodge: 



 

This is Luminosity: 

 

TVET SSP does not secure copyright of these pictures



Previewing Your Project As You Go 

Being able to preview your work will be important to you as you use After Effects. You may want to see an animation played out – or make sure 
that effects you have added meet your expectations. There are several methods that you can use to preview your work in After Effects.  

The first is standard preview. To use standard preview, go to the Timeline panel and deselect all layers. 

The Video switch should be visible for all layers that you want to preview.   The Video switch looks like an eye. It appears with each layer and is 
found in the first column, as circled below. 

 

You can click to select or deselect the Video switch. 

Next, press the Home key on your keyboard. This takes you to the beginning.  

To play and preview your composition, press the spacebar. 

You can also press the spacebar to stop playback. 

Just keep in mind that standard preview playback can be slower than the actual frame rate. 



The other method that you can use to preview your work is RAM preview. RAM preview will use the RAM on your computer to play the preview 
– with audio. It will play it to match the frame rate of the composition.  

You can use RAM preview to play footage in the Timeline panel, as well as the Layer and Footage panels. 

To use RAM preview, go to the Timeline and select the layers you want to preview. Make sure the Video switch appears beside those layers. 

Next, drag the playhead in the Timeline to the beginning of the time ruler. The playhead is circled in red below.  

You can also press the Home key. 

 

Click the RAM Preview button in the Preview panel on the right side of the window.  



 

You can also go to Composition>Preview>RAM Preview. 

You will see a green bar that shows you which frames are cached to RAM. When all frames are cached to RAM, your preview will play. To stop 
playback, hit the spacebar. 

For more detailed information, please visit: https://www.universalclass.com/articles/computers/adobe/after-effects/adobe-after-effects-
getting-started.htm 

Also Visit: https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html 

And: https://www.pinterest.com/andhib85/after-effects-workspaces/ 

 

Videos: 

 

Review Project Brief 

https://www.youtube.com/watch?v=QHDhSidFhcQ 
https://www.youtube.com/watch?v=BHCP105AnWM 
https://www.youtube.com/watch?v=YyYjLmsks2Q 
https://www.youtube.com/watch?v=sXZiOk-1VRs 
https://www.youtube.com/watch?v=T8WG2bRa1rM 
 

https://www.universalclass.com/articles/computers/adobe/after-effects/adobe-after-effects-getting-started.htm
https://www.universalclass.com/articles/computers/adobe/after-effects/adobe-after-effects-getting-started.htm
https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html
https://www.pinterest.com/andhib85/after-effects-workspaces/
https://www.youtube.com/watch?v=QHDhSidFhcQ
https://www.youtube.com/watch?v=BHCP105AnWM
https://www.youtube.com/watch?v=YyYjLmsks2Q
https://www.youtube.com/watch?v=sXZiOk-1VRs
https://www.youtube.com/watch?v=T8WG2bRa1rM


 

Set Compositing Properties 

https://www.youtube.com/watch?v=1fB74Ukkyo4 
https://www.youtube.com/watch?v=H1ZsiQy764Q 
https://www.youtube.com/watch?v=LsQXKQQRJSU 
https://www.youtube.com/watch?v=mMe24Tj-4wA 
https://www.youtube.com/watch?v=7S3T5-vshS4 

 

 

Import Media 

https://www.youtube.com/watch?v=KVHnO5yv7g0 
https://www.youtube.com/watch?v=X5UPpMquRCY 
https://www.youtube.com/watch?v=pMz8MisCaDk 
https://www.youtube.com/watch?v=N0vLeOEcwWU 
https://www.youtube.com/watch?v=cAk82EcUi0o 
https://www.youtube.com/watch?v=dnEg4BsuqsY 

 

Set Compositing Duration 

https://www.youtube.com/watch?v=trVvSr8DLcs 
https://www.youtube.com/watch?v=h4E8ZxbK4ic 
https://www.youtube.com/watch?v=DA3Gg9nEdaI 
https://www.youtube.com/watch?v=Wmj3zXWQC2A 
https://www.youtube.com/watch?v=PRiqRxTMmu8 

https://www.youtube.com/watch?v=1fB74Ukkyo4
https://www.youtube.com/watch?v=H1ZsiQy764Q
https://www.youtube.com/watch?v=LsQXKQQRJSU
https://www.youtube.com/watch?v=mMe24Tj-4wA
https://www.youtube.com/watch?v=7S3T5-vshS4
https://www.youtube.com/watch?v=KVHnO5yv7g0
https://www.youtube.com/watch?v=X5UPpMquRCY
https://www.youtube.com/watch?v=pMz8MisCaDk
https://www.youtube.com/watch?v=N0vLeOEcwWU
https://www.youtube.com/watch?v=cAk82EcUi0o
https://www.youtube.com/watch?v=dnEg4BsuqsY
https://www.youtube.com/watch?v=trVvSr8DLcs
https://www.youtube.com/watch?v=h4E8ZxbK4ic
https://www.youtube.com/watch?v=DA3Gg9nEdaI
https://www.youtube.com/watch?v=Wmj3zXWQC2A
https://www.youtube.com/watch?v=PRiqRxTMmu8


 

Create Animation 

https://www.youtube.com/watch?v=u9bjCo9qoGU 
https://www.youtube.com/watch?v=vblZd4mvXag 
https://www.youtube.com/watch?v=502OGONj_A8 
https://www.youtube.com/watch?v=QHDhSidFhcQ&t=1s 
https://www.youtube.com/watch?v=X37S5qFH1cE 

 

Make Revisions 

https://www.youtube.com/watch?v=Tlkd4Bcqtuk 
https://www.youtube.com/watch?v=5Ql8VRBqyzE 
https://www.youtube.com/watch?v=MMEhLCMO9ts 
https://www.youtube.com/watch?v=8Ye_UDk872c 
 

 

 

 

 

https://www.youtube.com/watch?v=u9bjCo9qoGU
https://www.youtube.com/watch?v=vblZd4mvXag
https://www.youtube.com/watch?v=502OGONj_A8
https://www.youtube.com/watch?v=QHDhSidFhcQ&t=1s
https://www.youtube.com/watch?v=X37S5qFH1cE
https://www.youtube.com/watch?v=Tlkd4Bcqtuk
https://www.youtube.com/watch?v=5Ql8VRBqyzE
https://www.youtube.com/watch?v=MMEhLCMO9ts
https://www.youtube.com/watch?v=8Ye_UDk872c




Module 5: 021100997 Design Graphics 

 

Objective of the module: After successful completion of this module, the student is competent in Design Graphics according to professional 
standards 

Duration: 80 Hrs Theory: 24 Hrs Practical: 56 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU1: 

Review Design 
Brief 

The trainee will be able 
to: 

Identify instructions & 

specification for graphic 

design 

Identify objective of 

designing graphics 

Collect information for 

designing graphics 

Prepare notes for 

designing graphics 

Explain graphic designing 

Explain graphics & its types 

Explain design brief 

Explain Color Concept 

Explain Logo and logo types 

Explain Theme Design 

 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

LU2: Select 
Tools for 
Designing 
Graphics 

 

The trainee will be able 
to: 

Identify tools as per 

requirement on graphic 

designing software 

Select tools as per 

requirement on graphic 

Explain toolbox in graphic designing software 

Explain functionality of tool in graphic software 

Explain software tool techniques for designing graphics 

 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 



designing software 

LU3: Prepare a 
Design Layout 

 

The trainee will be able 

to: 

Set Size, & Resolution 

as per design 

requirement 

Draw Thumbnail 

Sketches as per graphic 

requirement 

Create object as per 

graphic requirement 

Write text as per graphic 

requirement 

Create layout as per 

graphic requirement 

Save final layout as per 

requirement 

Define title, break bumpers etc 

Explain image dimensions & resolutions  

Explain layout in designing software 

Explain importance of layout in designing software 

Explain thumbnail sketches & its importance 

Explain techniques to create object in software 

Explain techniques of creating layout in designing software 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 

LU4: Use 
Techniques for 
Designing 
Graphic 

 

The trainee will be able 

to: 

Use masking techniques 

Use blending modes 

techniques 

Use Layer Styles 

Explain masking techniques & its purpose 

Explain blending modes techniques & its purpose 

Explain Layer Styles techniques & its purpose 

Explain typography techniques & its purpose 

Explain filter techniques & its purpose 

 

Computer with Graphic 
Card 

Multimedia 

Adobe Creative Suit 



techniques 

Use typography 

techniques 

Use filter techniques 

Examples and illustrations 

 

What is Graphic Design? 

Graphic design is the craft of creating visual content to communicate messages. Applying visual hierarchy and page layout techniques, graphic 
designers use typography and pictures to meet users‘ specific needs and focus on the logic of displaying elements in interactive designs to 
optimize the user experience. 

 

 

 

 



What is a raster image? 

Raster images, also known as bitmaps, are comprised of individual pixels of color. Each color pixel contributes to the overall image. 

Raster images might be compared to pointillist paintings, which are composed with a series of individually-colored dots of paint. Each paint dot 
in a pointillist painting might represent a single pixel in a raster image. When viewed as an individual dot, it‘s just a color; but when viewed as a 
whole, the colored dots make up a vivid and detailed painting. The pixels in a raster image work in the same manner, which provides for rich 
details and pixel-by-pixel editing. 

 
Raster images are capable of rendering complex, multi-colored visuals, including soft color gradients. Digital cameras create raster images, 
and all the photographs you see in print and online are raster images. 

There are different types of raster files: JPG, GIF, and PNG are examples, and each file type has its own nuances. 

Raster images are ideal for photo editing and creating digital paintings in programs such as Photoshop and GIMP , and they can be 
compressed for storage and web optimized images. 

How you can use a given raster image depends on its size and quality. Quality is often dictated by how many pixels are contained in an inch, 
expressed as pixels-per-inch or ppi; as well as the overall dimensions of the image, also expressed as pixels (for example, 5,000 pixels wide by 
2,500 pixels high). 

https://www.printcnx.com/resources-and-support/addiational-resources/raster-images-vs-vector-graphics/
https://www.gimp.org/
https://en.wikipedia.org/wiki/GIF
https://en.wikipedia.org/wiki/Portable_Network_Graphics
https://gizmodo.com/5656669/whats-the-difference-between-jpg-png-and-gif
http://www.adobe.com/products/photoshop.html
https://www.gimp.org/


 
The greater the ppi and dimensional measurements, the higher the quality. Most printing projects require images to be at least 300ppi, for 
example. 

Let‘s say you‘re printing a brochure, and you need a background image to span the entire unfolded interior: 8.5‖x11‖. Your background image 
should be at least 2,550 pixels wide (8.5 inches) by 3,300 pixels tall (11 inches) with a resolution of 300ppi. 

Anything less, and quality will be sacrificed, as raster images cannot be scaled to larger sizes. When they are scaled, quality is lost and they 
become blurry, as each pixel becomes larger or photo editing software attempts to compromise by adding in colored pixels. 

 

 

https://www.psprint.com/brochures


What is a vector image? 

Unlike raster graphics, which are comprised of colored pixels arranged to display an image, vector graphics are made up of paths, each with a 
mathematical formula (vector) that tells the path how it is shaped and what color it is bordered with or filled by. 

Since mathematical formulas dictate how the image is rendered, vector images retain their appearance regardless of size. They can be scaled 
infinitely. Vector images can be created and edited in programs such as Illustrator, CorelDraw, and InkScape (don‘t worry, these visual editors 
do the math for you). 

 

Though vectors can be used to imitate photographs, they‘re best-suited for designs that use simple, solid colors. Vector images are comprised 
of shapes, and each shape has its own color; thus, vectors cannot achieve the color gradients, shadows, and shading that raster images can (it 
is possible to mimic them, but it requires rasterizing part of the image – which means it would not be a true vector). True vector graphics are 
comprised of line art, sometimes called wireframes, that are filled with color. 

Because vectors can be infinitely scaled without loss of quality, they‘re excellent for logos, illustrations, engravings, etchings, product artwork, 
signage, and embroidery. Vectors should not be used for digital paintings or photo editing; however, they‘re perfect for projects such as printing 
stickers that do not include photos. 

It‘s important to note that, with the exception of the SVG format, vectors must be rasterized before they can be used on the web. 

 

 

 

 

http://www.adobe.com/products/illustrator.html
https://www.coreldraw.com/en/
https://inkscape.org/en/
https://vector-conversions.com/vectorizing/raster_vs_vector.html
https://vector-conversions.com/vectorizing/raster_vs_vector.html
https://designshack.net/articles/layouts/vector-vs-raster-what-do-i-use/
https://www.psprint.com/stickers-labels/category
https://www.psprint.com/stickers-labels/category
https://www.sitepoint.com/svg-scalable-vector-graphics-overview/


The Fundamental Color Wheel: 
 
Color theory may sound easy on the surface, but it becomes more complex as you delve deeper. Over the centuries, artists, theorist, 
philosophers and many others have tried to explain colors in different theories and systems. Today, there are areas exist where some color 
theories remain controversial. 
 
It's natural to think of primary, secondary and tertiary colors when it comes to color theory. 
Without further ado, let's start with the photography color wheel chart! 
 
Primary Colors: 
 

 
 
A true primary color is a color that is not made up of any other colors than its own. 
Most of us probably learned the primary colors as red, green and blue in school. RGB is also known as digital primaries, which are used for 
displaying images in electronic devices. 
 
When we work for print output, we use cyan, magenta and yellow as the ink primaries. To make things even more 
confusing: yellow, red and blue are known as the art school primaries. This is also know as the YRB color system. 
Each system is used in different industries and has its own merit. For the purpose of this tutorial, I'm going to use the YRB color wheel: the 
paint color wheel or art school color wheel (color wheel shown on the left, above) to illustrate my point.  
This may totally contradict with the color model that you're about to see below. However, the YRB is an established system adopted by 
artists since the 19th centuries. 
 



Secondary Colors:  

 
The secondary colors in the YRB system is created by mixing two primaries. 

Orange = yellow + red 

Violet = red + blue 

Green = blue + yellow 

 

Tertiary Colors:  

 

The tertiary colors in the YRB system is created by mixing primary and secondary colors. The colors are called by naming the primary first, 
followed by the secondary. 



 

Yellow-Orange, Red-Orange, Red-Violet, Blue-Violet, Blue-Green and Yellow-Green. 

 

 

Color Model:  

Color model is a system of creating a full range of colors using a set of primary colors. There are two color models: additive and subtractive. 
These are based on how colors are created. 

Colors that contain physical pigment, such as in the case of paint, are called subtractive color. This is because pigmented objects absorb light 
or subtract color wavelength from the visible light spectrum. The unabsorbed wavelength is reflected off the object and seen by the human eye 
as color. 

Conversely, colors of direct light are called additive color. Colors in this case are created by adding color wavelengths together to create a 
different color. 



 



 

Color space is more relevant to us as photographers. It's a mathematically defined range of colors (also known as gamut) a device can display 
or print. 

We use it day in and day out in our cameras, in post-processing and publishing images on the internet or printed material. 

There are many color spaces exist. For example: sRGB for web display, CMYK for printing, Rec. 709 for HDTV, etc. Only a few are relevant to 
us. 

When comparing color spaces, we use the CIELAB color space (CIE = International Committee of Illumination; LAB is explained below) as the 
standard reference. CIELAB color space (the chromaticity diagram on the left) is specifically designed to encompass all colors the average 
human can see. 

For the purpose of photography, you should know the color spaces listed below. The black triangle represents the gamut of each color space 
within CIELAB 

 

What Is Color Space? 



 
 

 

 

 

 

 

 

 

 



 

 



 

 

 

 

 



 



What is a logo? 

A Logo is a design symbolizing ones organization. It is a design that is used by an organization for its letterhead, 
advertising material, and signs as an emblem by which the organization can easily be recognized, also called logotype. 
Logotype is a graphic representation or symbol of a company name, trademark, abbreviation, etc., often uniquely 
designed for ready recognition.  

You may also think of a Logo as a simple visual mark to identify your company product or service. There are different 
types of signs and emblems easily recognized and associated with purposes. For example, crests are used to identify a 
country or family. There was a time when only big enough organizations could afford to make their own crest. They were 
in some cases very detailed drawing with many objects to enrich the crest. Cost was not an issue and more was 
considered better. Then flags were used due to their larger format. They were visible from the cra ft f ields from long 
distances. Road signs were designed for informational purposes. They use such techniques as contrasting colors, 
simplif ied and yet stylish formats to identify and attract more attention and convey information.  

Now days, the most popular and successful companies continue to say that "simpler is better", especially today when 
everything is moving so fast you have less and less time to impress your customers. So it has to be done in a very 
stylish manner yet remaining conservative so that i t`s easier for the eye to catch and the brain to memorize your logo 
design. 

These days you also have to consider the reproduction cost. More detailed and colorful logo designs are harder to 
reproduce and they of course cost more. You also have to consider the size that your logo is going to be used at. The 
perfect logo design will look great on a sign board as well as on a business card or on a pen for example.  

We have talked about the general use of a logo. Now we are going to get into a more detail look a t the logo. There are 
some general types of logos: Iconic Logo - Some kind of graphical element related to the business field or just an 
abstract image, for example: Nike, AOL, Micheline. Logotype - Logo based only on the company name. A unique font, or 
unique layout style can make a great logo, for example: Sony, Coca-Cola , IBM. 

Let's talk about each kind separately. Iconic Logos can be very different. The classic variation is to make the symbol f it 
any of the basic geometrical shapes. For example:  

The best shapes to use are symmetrical geometrical shapes They can be placed almost anywhere and still maintain the 
balance; they are very easy to handle.  

  

  



 

 

 

It is still good to make the logo fit any kind of geometrical shape, it looks more fit and balanc ed: 

  

  

And at last there is no obligation in what kind of shape to use , you can use any free form shape you want, but you have 
to be very careful with the placement, so the logo doesn't look like it is falling apart or going to fall:  

  

By selecting the shape, you should consider how conservative and stable your company wants to appear .  

 

 

For more detailed information, please visit: https://www.psprint.com/resources/difference-between-raster-vector/ 

Also visit: https://www.geeksforgeeks.org/vector-vs-raster-graphics/ 

And: https://www.logobee.com/feature3.htm 

 

 

 

 

https://www.psprint.com/resources/difference-between-raster-vector/
https://www.geeksforgeeks.org/vector-vs-raster-graphics/
https://www.logobee.com/feature3.htm


A first look at the Photoshop working area 

A: Tools panel | B: History panel | C: Color panel | D: Creative Cloud Libraries panel | E: Layers panel 

 

 

 

 

 

 

 

 

 



Workspace overview 

 The Application bar across the top contains a workspace switcher, menus (Windows only), and other application controls. On the Mac for 
certain products, you can show or hide it using the Window menu. 

 The Tools panel contains tools for creating and editing images, artwork, page elements, and so on. Related tools are grouped. 
 The Options bar Control panel displays options for the currently selected tool.  
 The Document window displays the file you‘re working on. Document windows can be tabbed and, in certain cases, grouped and docked. 
 Panels help you monitor and modify your work. Panels can be grouped, stacked, or docked. 
 The Application frame groups all the workspace elements in a single, integrated window that lets you treat the application as a single unit. 

When you move or resize the Application frame or any of its elements, all the elements within it respond to each other so none overlap. Panels 
don‘t disappear when you switch applications or when you accidentally click out of the application. If you work with two or more applications, 
you can position each application side by side on the screen or on multiple monitors. 

If you are using a Mac and prefer the traditional, free-form user interface, you can turn off the Application frame. 

  

1. Choose Edit > Preferences > Interface. 

2. Choose the desired color theme. 

Hide or show all panels 

 To hide or show all panels, including the Tools panel and Control panel, press Tab. 

 To hide or show all panels except the Tools panel and Control panel, press Shift+Tab. 

Display panel options 

 Click the panel menu icon  in the upper-right corner of the panel. 

 

 



Dock and undock panels 

A dock is a collection of panels or panel groups displayed together, generally in a vertical orientation. You dock and undock panels by moving 
them into and out of a dock. 

 To dock a panel, drag it by its tab into the dock, at the top, bottom, or in between other panels. 

 To dock a panel group, drag it by its title bar (the solid empty bar above the tabs) into the dock. 

 To remove a panel or panel group, drag it out of the dock by its tab or title bar. You can drag it into another dock or make it free-floating.  

                       

Move panels 

As you move panels, you see blue highlighted drop zones, areas where you can move the panel. For example, you can move a panel up or 
down in a dock by dragging it to the narrow blue drop zone above or below another panel. If you drag to an area that is not a drop zone, the 
panel floats freely in the workspace. 

 To move a panel, drag it by its tab. 

 To move a panel group, drag the title bar. 

TVET SSP does not secure copyright of these pictures



 

 

Stack floating panels 

When you drag a panel out of its dock but not into a drop zone, the panel floats freely. The floating panel allows you to position it anywhere in 
the workspace. You can stack floating panels or panel groups so that they move as a unit when you drag the topmost title bar. 

 

Collapse and expand panel icons 

You can collapse panels to icons to reduce clutter on the workspace. In some cases, panels are collapsed to icons in the default workspace. 



                                                

 

Select tools and filters: 

Where is the Photoshop CC Toolbar? 

By default, the Photoshop CC Toolbar is the part of Photoshop that‘s 

anchored to the left of the application window. However, you can move it around and change its size, depending on your needs. 



 

 

 

 



How to customize the Toolbar in Photoshop 

You can customize the Toolbar part of Photoshop a few different ways. 

 Moving the Toolbar: To move the Photoshop CC Toolbar to another location on your screen, click on the series of vertical lines (located at 
the top of the Toolbar) and drag the toolbar to another part of the screen. This action un-anchors the Toolbar from its default location. 

 

 Using columns: If you prefer the Photoshop CC Toolbar to be two columns instead of one, click on the two triangles at the very top of the 
Toolbar. Clicking on the triangles again will toggle the Toolbar back to a single column. 



 



 Add/remove tools: If there are CC 2018 Photoshop tools that are missing from the Toolbar, or if you want to customize the tools visible in 
the Toolbar, click on the three little dots located at the bottom of the Toolbar, just above the squares showing the foreground and 
background colors.

 

If tools have been removed from the Photoshop CC Toolbar, they will show in a dropdown once you click on these dots. 

If your Toolbar is at its default setting, the only option will be Edit Toolbar. Click on Edit Toolbar to open the Customize Toolbar window. 

 

 



 



Within this window, you can customize which tools appear on the Toolbar. Tools you rarely use can be moved into Extra Tools so they won‘t 
appear in the Toolbar. Click on the tool you wish to move in the Toolbar column and drag it to the Extra Tools column. You can also drag tools 
from Extra Tools back into the Toolbar column. 

Foreground and background colors in the Toolbar 

Immediately below the three dots in the Photoshop CC Toolbar, you‘ll see two color squares (the colors you see in the squares will vary). 

 

Note that one square rests on top of the other. If you click on the arrows to the top and right of the squares, the colors in each square switch 
places. 

The color on top is the foreground color, and the color under it is the background color. You can change either of these colors by double-
clicking on the color square and adjusting the color in the Color Picker window that pops up. 

 

 

 

 



Single Or Double Column Toolbar 

By default, the Toolbar appears as a long, single column. It can be expanded into a shorter, double column by clicking 
the double arrows icon at the top. Click the same icon again to return the Toolbar to a single column: 

 

 

 

 

 

The Tools Layout 

Let's look at how the Toolbar in Photoshop is organized. While it may seem like the tools are listed randomly, there's actually a logical order to 
it, with related tools grouped together. At the top, we have Photoshop's Move and Selection tools. Directly below them are the Crop and 
Slice tools. Below that are the Measurement tools, followed by Photoshop's many Retouching and Painting tools. Next are the Drawing and 
Type tools. And finally, near the bottom of the Toolbar, we find Photoshop's Navigation tools: 



 



The Hidden Tools 

Each tool in the Toolbar is represented by an icon, and there are many more tools available than what we see. A small arrow in the bottom 
right corner of a tool's icon means that there are additional tools hiding behind it in that same spot: 

 

Most of the spots in the Toolbar contain more than one tool. 

To view and access the additional tools, click and hold on the icon. Or, right-click (Win) / Control-click (Mac) on the icon. Either way 
displays a fly-out menu showing the other tools that are available. For example, if I click and hold on the Rectangular Marquee Tool's icon, the 
fly-out menu tells me that along with that tool, the Elliptical Marquee Tool, the Single Row Marquee Tool and the Single Column Marquee 
Tool are also nested in with it. To choose one of the additional tools, select it from the list. I'll choose the Elliptical Marquee Tool. We'll see why 
in a moment: 

 

https://www.photoshopessentials.com/basics/selections/rectangular-marquee-tool/
https://www.photoshopessentials.com/basics/selections/elliptical-marquee-tool/


Choosing a hidden tool from the fly-out menu. 

The Default Tool 

The tool that's initially displayed in each spot in the Toolbar is known as the default tool. The Rectangular Marquee Tool is the default tool for 
the spot we're looking at here (second from the top). However, Photoshop won't always display the default tool. Instead, it will display the last 
tool that was selected. Notice that, after choosing the Elliptical Marquee Tool from the fly-out menu, the Rectangular Marquee Tool is no longer 
displayed in the Toolbar. The Elliptical Marquee Tool has taken its place: 

 

Each spot in the Toolbar displays either the default tool or the last tool selected. 

To select the Rectangular Marquee Tool at this point, I would need to either click and hold, or right-click (Win) / Control-click (Mac), on the 
Elliptical Marquee Tool's icon. Then, I could select the Rectangular Marquee Tool from the menu: 

 



Selecting the Rectangular Marquee Tool from behind the Elliptical Marquee Tool. 

Photoshop Tools Summary 

Now that we've learned how Photoshop's Toolbar is organized and how to access all of the tools within it, let's look at the tools themselves. 
Here's a quick summary of each tool you'll find in the Toolbar, along with a brief description of what each tool is used for. Specific tools will be 
covered in more detail in other lessons. I've listed the tools in the order they're displayed in the Toolbar, beginning with the Move and Selection 
tools at the top. 

An asterisk (*) after a tool's name indicates a default tool. The letter in parenthesis is the tool's keyboard shortcut. To cycle through tools with 
the same keyboard shortcut, press and hold Shift as you press the letter. Note that if you're using Photoshop CS6, some tools are only 
available in the CS6 Extended version. All tools are available in Photoshop CC. 

Move And Selection Tools 

 

Move Tool * ( V ) 

The Move Tool is used to move layers, selections and guides within a Photoshop document. Enable "Auto-Select" to automatically select the 
layer or group you click on. 

 

Artboard Tool ( V ) 

The Artboard Tool (new in Photoshop CC) allows you to easily design multiple web or UX (user experience) layouts for different devices or 
screen sizes. 



 

Rectangular Marquee Tool * ( M ) 

The Rectangular Marquee Tool draws rectangular selection outlines. Press and hold Shift as you drag to draw a square selection. 

 

Elliptical Marquee Tool ( M ) 

The Elliptical Marquee Tool draws elliptical selection outlines. Press and hold Shift to draw a selection in a perfect circle. 

 

Single Row Marquee Tool 

The Single Row Marquee Tool in Photoshop selects a single row of pixels in the image from left to right. 

 

Single Column Marquee Tool 

Use the Single Column Marquee Tool to select a single column of pixels from top to bottom. 

https://www.photoshopessentials.com/basics/selections/rectangular-marquee-tool/
https://www.photoshopessentials.com/basics/selections/elliptical-marquee-tool/


 

Lasso Tool * ( L ) 

With the Lasso Tool, you can draw a freeform selection outline around an object. 

 

Polygonal Lasso Tool ( L ) 

Click around an object with the Polygonal Lasso Tool to surround it with a polygonal, straight-edged selection outline. 

 

Magnetic Lasso Tool ( L ) 

The Magnetic Lasso Tool snaps the selection outline to the edges of the object as you move your mouse cursor around it. 

 

Quick Selection Tool * ( W ) 

The Quick Selection Tool lets you easily select an object simply by painting over it with a brush. Enable "Auto-Enhance" in the Options Bar for 
better quality selections. 

https://www.photoshopessentials.com/basics/selections/lasso-tool/
https://www.photoshopessentials.com/basics/selections/polygonal-lasso-tool/
https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/Learn%20more%20about%20the%20Magnetic%20Lasso%20Tool%20in%20Photoshop/basics/selections/magnetic-lasso-tool/
https://www.photoshopessentials.com/basics/selections/quick-selection-tool/


 

Magic Wand Tool ( W ) 

Photoshop's Magic Wand Tool selects areas of similar color with a single click. The "Tolerance" value in the Options Bar sets the range of 
colors that will be selected. 

Crop and Slice Tools 

           

Crop Tool * ( C ) 

Use the Crop Tool in Photoshop to crop an image and remove unwanted areas. Uncheck "Delete Cropped Pixels" in the Options Bar to crop an 
image non-destructively. 

           

Perspective Crop Tool ( C ) 

Use the Perspective Crop Tool to both crop an image and fix common distortion or perspective problems. 

           

https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/Learn%20more%20about%20the%20Magnetic%20Lasso%20Tool%20in%20Photoshop/basics/selections/magic-wand-tool/
https://www.photoshopessentials.com/photo-editing/how-to-crop-images-photoshop-cc/
https://www.photoshopessentials.com/photo-editing/crop-images-non-destructively-photoshop-cc/
https://www.photoshopessentials.com/photo-editing/crop-images-non-destructively-photoshop-cc/
https://www.photoshopessentials.com/photo-editing/how-to-crop-images-photoshop-cc/photo-editing/perspective-crop-tool-cs6/


Slice Tool ( C ) 

The Slice Tool divides an image or layout into smaller sections (slices) which can be exported and optimized separately. 

          

Slice Select Tool ( C ) 

Use the Slice Select Tool to select individual slices created with the Slice Tool. 

Measurement Tools 

Eyedropper Tool * ( I ) 

Photoshop's Eyedropper Tool samples colors in an image. Increase "Sample Size" in the Options Bar for a better representation of the sampled area's color. 

 

3D Material Eyedropper Tool ( I ) 

Use the 3D Material Eyedropper Tool to sample material from a 3D model in Photoshop. 

 

Color Sampler Tool ( I ) 



The Color Sampler Tool displays color values for the selected (sampled) area in an image. Up to four areas can be sampled at a time. View the color information 
in Photoshop's Info panel. 

 

Ruler Tool ( I ) 

The Ruler Tool measures distances, locations and angles. Great for positioning images and elements exactly where you want them. 

 

Note Tool ( I ) 

The Note Tool allows you to attach text-based notes to your Photoshop document, either for yourself or for others working on the same project. Notes are saved 
as part of the .PSD file. 

 

Count Tool ( I ) 

Use the Count Tool to manually count the number of objects in an image, or to have Photoshop automatically count multiple selected areas in the image. 

 

 

 



Retouching and Painting Tools 

 

Spot Healing Brush Tool * ( J ) 

The Spot Healing Brush in Photoshop quickly removes blemishes and other minor problem areas in an image. Use a brush size slightly larger than the blemish 
for best results. 

 

Healing Brush Tool ( J ) 

The Healing Brush lets you repair larger problem areas in an image by painting over them. Hold Alt (Win) / Option (Mac) and click to sample good texture, then 
paint over the problem area to repair it. 

 

Patch Tool ( J ) 

With the Patch Tool, draw a freeform selection outline around a problem area. Then repair it by dragging the selection outline over an area of good texture. 

 

https://www.photoshopessentials.com/photo-editing/spot-healing-brush/
https://www.photoshopessentials.com/photo-editing/spot-healing-brush/photo-editing/healing-brush/


Content-Aware Move Tool ( J ) 

Use the Content-Aware Move Tool to select and move part of an image to a different area. Photoshop automatically fills in the hole in the original spot using 
elements from the surrounding areas. 

 

Red Eye Tool ( J ) 

The Red Eye Tool removes common red eye problems in a photo resulting from camera flash. 

 

Brush Tool * ( B ) 

The Brush Tool is Photoshop's primary painting tool. Use it to paint brush strokes on a layer or on a layer mask. 

 

Pencil Tool ( B ) 

The Pencil Tool is another of Photoshop's painting tools. But while the Brush Tool can paint soft-edge brush strokes, the Pencil Tool always paints with hard 
edges. 

https://www.photoshopessentials.com/basics/photoshop-brushes/brush-dynamics/brush-dynamics-intro/
https://www.photoshopessentials.com/photoshop-layers-learning-guide/
https://www.photoshopessentials.com/basics/understanding-photoshop-layer-masks/


 

Color Replacement Tool ( B ) 

Use the Color Replacement Tool in Photoshop to easily replace the color of an object with a different color. 

 

Mixer Brush Tool ( B ) 

Unlike the standard Brush Tool, the Mixer Brush in Photoshop can simulate elements of real painting such as mixing and combining colors, and paint wetness. 

 

Clone Stamp Tool * ( S ) 

The Clone Stamp Tool is the most basic of Photoshop's retouching tools. It samples pixels from one area of the image and paints them over pixels in another 
area. 

 

Pattern Stamp Tool ( S ) 

Use the Pattern Stamp Tool to paint a pattern over the image. 

https://www.photoshopessentials.com/photo-editing/color-replacement-tool/


 

History Brush Tool * ( Y ) 

The History Brush Tool paints a snapshot from an earlier step (history state) into the current version of the image. Choose the previous state from the History 
panel. 

 

Art History Brush Tool ( Y ) 

The Art History Brush also paints a snapshot from an earlier history state into the image, but does so using stylized brush strokes. 

 

Eraser Tool * ( E ) 

The Eraser Tool in Photoshop permanently erases pixels on a layer. It can also be used to paint in a previous history state. 

 

Background Eraser Tool ( E ) 

The Background Eraser Tool erases areas of similar color in an image by painting over them. 

https://www.photoshopessentials.com/photo-editing/background-eraser/


 

Magic Eraser Tool ( E ) 

The Magic Eraser Tool is similar to the Magic Wand Tool in that it selects areas of similar color with a single click. But the Magic Eraser Tool then permanently 
deletes those areas. 

 

Gradient Tool * ( G ) 

Photoshop's Gradient Tool draws gradual blends between multiple colors. The Gradient Editor lets you create and customize your own gradients. 

 

Paint Bucket Tool ( G ) 

The Paint Bucket Tool fills an area of similar color with your Foreground color or a pattern. The "Tolerance" value determines the range of colors that will be 
affected around the area where you clicked. 

 

3D Material Drop Tool ( G ) 

https://www.photoshopessentials.com/basics/how-to-draw-gradients-with-the-gradient-tool-in-photoshop/
https://www.photoshopessentials.com/basics/how-to-use-the-gradient-editor-in-photoshop/


Used in 3D modeling, the 3D Material Drop Tool lets you sample a material from one area and then drop it into another area of your model, mesh or 3D layer. 

 

Blur Tool * 

The Blur Tool blurs and softens areas you paint over with the tool. 

 

Sharpen Tool 

The Sharpen Tool sharpens areas you paint over. 

 

Smudge Tool 

The Smudge Tool in Photoshop smudges and smears the areas you paint over. It can also be used to create a finger painting effect. 

 

Dodge Tool * ( O ) 



Paint over areas in the image with the Dodge Tool to lighten them. 

 

Burn Tool ( O ) 

The Burn Tool will darken the areas you paint over. 

 

Sponge Tool ( O ) 

Paint over areas with the Sponge Tool to increase or decrease color saturation. 

Drawing and Type Tools 

 

Pen Tool * ( P ) 

Photoshop's Pen Tool allows you to draw extremely precise paths, vector shapes or selections. 

 

https://www.photoshopessentials.com/photo-editing/spot-healing-brush/basics/selections/pen-tool-selections/


Freeform Pen Tool ( P ) 

The Freeform Pen Tool allows you to draw freehand paths or shapes. Anchor points are automatically added to the path as you draw. 

 

Add Anchor Point Tool 

Use the Add Anchor Point Tool to add additional anchor points along a path. 

 

Delete Anchor Point Tool 

Click on an existing anchor point along a path with the Delete Anchor Point Tool to remove the point. 

 

Convert Point Tool 

On a path, click on a smooth anchor point with the Convert Point Tool to convert it to a corner point. Click a corner point to convert it to a smooth point. 

 



Horizontal Type Tool * ( T ) 

Known simply as the Type Tool in Photoshop, use the Horizontal Type Tool to add standard type to your document. 

 

Vertical Type Tool ( T ) 

The Vertical Type Tool adds type vertically from top to bottom. 

 

Vertical Type Mask Tool ( T ) 

Rather than adding editable text to your document, the Vertical Type Mask Tool creates a selection outline in the shape of vertical type. 

 

Horizontal Type Mask Tool ( T ) 

Like the Vertical Mask Type Tool, the Horizontal Type Mask Tool creates a selection outline in the shape of type. However, the type is added horizontally rather 
than vertically. 

 



Path Selection Tool * ( A ) 

Use the Path Selection Tool (the black arrow) in Photoshop to select and move an entire path at once. 

 

Direct Selection Tool ( A ) 

Use the Direct Selection Tool (the white arrow) to select and move an individual path segment, anchor point or direction handle. 

 

Rectangle Tool * ( U ) 

The Rectangle Tool draws rectangular vector shapes, paths or pixel shapes. Press and hold Shift as you drag to force the shape into a perfect square. 

 

Rounded Rectangle Tool ( U ) 

The Rounded Rectangle Tool is similar to the standard Rectangle Tool but draws the shapes with rounded corners. Press and hold Shift to draw a square with 
rounded corners. 

 

https://www.photoshopessentials.com/basics/how-to-draw-vector-shapes-in-photoshop-cs6/
https://www.photoshopessentials.com/basics/how-to-draw-vector-shapes-in-photoshop-cs6/


Ellipse Tool ( U ) 

The Ellipse Tool draws elliptical vector shapes, paths or pixel shapes. Press and hold Shift as you drag to draw a perfect circle. 

 

Polygon Tool ( U ) 

The Polygon Tool draws polygonal, straight-edged vector shapes, paths or pixel shapes. Use the "Sides" option in the Options Bar to set the number of sides. 

 

Line Tool ( U ) 

The Line Tool draws straight lines, either as shapes or paths. The "Weight" option in the Options Bar controls the width of the line. 

 

Custom Shape Tool ( U ) 

Photoshop's Custom Shape Tool lets you select and draw custom shapes. Choose from Photoshop's built-in custom shapes or create your own. 

 

 

https://www.photoshopessentials.com/basics/how-to-draw-vector-shapes-in-photoshop-cs6/
https://www.photoshopessentials.com/basics/how-to-draw-vector-shapes-in-photoshop-cs6/
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Navigation Tools 

 

Hand Tool * ( H ) 

The Hand Tool lets us click and drag an image around on the screen to view different areas when zoomed in. 

 

Rotate View Tool ( R ) 

Use the Rotate View Tool in Photoshop to rotate the canvas so you can view and edit the image from different angles. 

 

Zoom Tool * (Z ) 

Click on the image with the Zoom Tool to zoom in on a specific area. Press and hold Alt (Win) / Option (Mac) and click with the Zoom Tool to zoom out. 

 

For more detailed information, please visit: https://clippingpathindia.com/blogs/tips/beginners-guide-photoshop-cs6-tools-part-1 

Also Visit https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/ 

And https://helpx.adobe.com/photoshop-elements/using/tools.html 

https://www.photoshopessentials.com/basics/image-navigation-essentials-zooming-panning-photoshop/
https://www.photoshopessentials.com/basics/image-navigation-essentials-zooming-panning-photoshop/
https://clippingpathindia.com/blogs/tips/beginners-guide-photoshop-cs6-tools-part-1
https://www.photoshopessentials.com/basics/photoshop-tools-toolbar-overview/
https://helpx.adobe.com/photoshop-elements/using/tools.html


Layout in graphic design 

Layout in graphic design deals with the arrangement of visual elements so as to achieve specific communication objectives. 
When designing, the graphic designers should rely on the required information to present the layout properly, such as rotating and resizing the 
images, which requires time and efforts. In order to be able to design quickly, it is necessary to plan the layout in advance to save time and 
create a consistent look for your design. 

 

How important is the layout to graphic designers 

Layout plays an important role in graphic designs. It refers to the arrangement of elements on the design that related to brand‘s image and 
style. If the layout is not suitable, your message will not be conveyed effectively, especially in the advertising field. 



In design, especially graphic designs for advertising, layout is considered as a standard or default solution. It always follow the requirements 
and aims to achieve the best results in attracting the customers. 
The success of a graphic design depends on the arrangement of the pieces in the correct position and sequence through their relationship with 
each other. Therefore, graphic designers always have to understand the layout when designing ads, media publications or company 
documents, etc. 
 

 

The advantages of layout in graphic designs 

Layout is important in graphic designs therefore it must meet some requirements about proportion, sequence, emphasis, consistency of 
elements, etc on the purposes below: 

 Helping the layout of the page become harmonious from fonts, colors, backgrounds, etc. 
 Helping to streamline the site‘s overall rationale, making it easy for readers to receive information. 

https://www.designbold.com/academy/en/how-to-choose-the-right-fonts/?utm_source=academydesignbold&utm_medium=article&utm_campaign=the-importance-of-layout-to-graphic-designers
https://www.designbold.com/academy/en/what-color-palette-should-you-pick-for-your-branding/?utm_source=academydesignbold&utm_medium=article&utm_campaign=the-importance-of-layout-to-graphic-designers
https://www.designbold.com/academy/en/using-images-to-attract-your-customers/?utm_source=academydesignbold&utm_medium=article&utm_campaign=the-importance-of-layout-to-graphic-designers


 Helping the reader to grasp the essence of the article and focus on the main content. 
 Making the unification of the elements on your page to convey information accurately without breaking the segment. 

 
For more detailed information, please visit: https://www.designbold.com/academy/en/the-importance-of-layout-in-graphic-designs/ 
Also Visit: http://www.designzbyjamz.com/importance-of-layout-in-graphic-design-materials/ 

 

 

WHAT IS A LAYER? 

A layer is simply one image stacked on top of another. Imagine I have a piece of paper and I paint it red. Then I take a peic e of clear 
celophaine and paint a yellow circle, and lay it over the paper. Now I take another peice of cellophane and paint some blue type and 
laythat on top of the yellow circle. I now have a background (red) and 2 layers (yellow and blue.) Just like in the picture b elow. 

A background with 2 layers. 

 

 

This is how your image with would look on the screen or when printed. 

Broken apart so you can see how the layers work 
Each layer stacks on top of the previous one. 

https://www.designbold.com/academy/en/the-importance-of-layout-in-graphic-designs/
http://www.designzbyjamz.com/importance-of-layout-in-graphic-design-materials/


 

That is it! The concept of layers is that simple. Photoshop uses the Layers Pallete to allow you to do this with your images.  More 
than one layer is called a composition. 

LAYERS PANEL 

Photoshop‘s layers Panel is a powerful tool that allows you do many special things to your layed compositions. Next we will l ook at 
the Photoshop layers pallete. 



 

 

Have you ever wondered what all the parts of a layers panel do? Here is a screen grab of the layers Panel. I‘ll explian what all the 
parts are here. 

Layer Filter: This enables you to hide layers based on different things. Makes it easier to find the layers that you want to work with.  



Opacity: 0= transparant 100 = fully opaque. press number keys on keyboard to instantly set to multiples of 10, or adjust the slider 
for an exact amount of transparency on each layer. 
 
Blend Modes: Change these to change the way that the selected layer blends with the layers underneath it. Great for compositing 
and special effects. (With the move tool selected, press Shift+ or Shift- to cycle through blending modes. 
 
Fill opacity: Adjusts the amount of opacity of the pixels only, but any layer styles are uneffected and remain 100% opaque. 
 
visibility: If the eye is showing that layer is visible. Click on the eye and the layer will still be there but invisible until you click  on the 
eye again. 
 
Locked: The padlock means that something is locked in the layer. (Also click in the 4 icons in the ―lock‖ next to fill opacity to make 
certain things editable of locked). Here are the different things that can be locked/unlocked.  
 
Lock all: If the box is checked the layer is totally protected from any editing.  
 
Lock Position: You can make any changes except for moving the image. 
Lock Image pixels: You cannot draw on this layer if checked. 
 
Lock transparent: You can paint on this layer but not where it is transparent.  
Useful tools at the bottom of the panel 
 
Link: Enabled you to link layers. These will all move together unless unlinked 
. 
Layer Effects (Styles): Special effects applied to your image layer. Noted by the little f. Each effect will be listed. multiple effects 
may be used at once. 
 
Add Layer Mask: This is the button to press to add a layer mask to the currently selected layer. Allows you to paint away parts of 
your layer without damaging your original image. 
 
Add Adjustment Layer: The best way to apply image adjustments. There can change the color or tone of an image. All laye rs are 
affected underneath an adjustment layer (Unless clipped). This is a good option to using Image>Adjustments because adjustment  
layers are non-destructive and re editable. 
 



Layer Groups: A good organizational tool. This puts layers into a folder. You can choose multiple layers and press Cmd/Ctrl+G to 
put them in a group, or create a group by clicking this icon. Layers can be dragged in or out of groups in the Layers panel.  
 
Create New Layer: Press this icon to create a new layer. Drag an existing layer into this icon to create a duplicate of that layer, 
 
Delete Layer: Drag a layer into this icon to remove it. Or select the layer and then press this icon to get the same result.  
 
Panel Options: This will open a drop down menu that provides a number of opt ions, many that aren‘t listed anywhere else.  

TYPES OF LAYERS 

In Photoshop there are a number of different types of layers. They are usually indicated by icons, here is what they all do.  

Thumbnail: A small picture of the layers contents. 

 

 



Layer Group: This puts layers into a folder. Layers can be dragged in or out of groups in the Layers panel.  
 
Type Layer: The same as an image layer, except this layer contains type that can be edited; (Change character, color, font or size)  
 
Adjustment Layer: An adjustment layer is changing the color or tone of all the layers underneath it. To only affect th layer directly 
underneath it (an ignore the other underlying layers): Move your pointer on the line between the adjustment layer and the lay er 
directly beneath it, hold down Alt/Option. You will see a symbol appear. Click to limit the adjustment. (clip to layer) do the same thing 
again to toggle this option off. 
 
Layer Style: An effect has been applied. Click the eye to turn it on or off. Double click ―effects‖ to open the Layer Styles options. 
 
Layer Mask: Allows you to paint on the mask to show and reveal portions of the image.  
 
Smart Object: A special type of layer that is actually a container that can hold; multiple (or 1) layers, vectors for illustrator, raw fil es, 
video, 3D or many other types of objects. To learn about Smart Objects in depth, check out this video,  
 
SPECIAL TYPES OF LAYERS 
There are two different types of layers that have appeared in newer version of Photoshop. These used to only be in Photoshop  
Extended. With Photoshop CC, there is no longer a seperate Extended version, all the features are now inluded with every copy  of 
photoshop. 

 

 



Video Layer: This indicates that there is video on this layer. Photoshop is now able to be used as a video editor, to worki with video, 
animated slideshows and motion graphics. See Video in Photoshop if you want to learn about video editing in Photoshop.  
 
3D Layer: Photoshop is capable of importing and working with 3D objects. It also has the ability to do 3D p rinting. 

LAYER TIPS: 

Here are some useful tips for working with Photoshop Layers:  

Click to select a layer 

Cmd/Ctrl+click to select multiple layers 

Drag your curser through the eye incons to turn the visibility on or off on multiple layers  

Cmd/Ctrl+ J to copy a layer 

Cmd/Ctrl+ J to copy a selection to a new layer 

Cmd/Ctrl+Shift + J to Move a selection to a new layer 

Click the padlock icon on the background to convert it to a regular layer  

Press Cmd/Ctrl+G to Move all the selected layers into a new group 

Cmd+Option+Shift+E (Ctrl+Alt+Shift+E windows) to create a new merged layer above all the other layers  

Hold Option/Alt while adding a mask to create an inverted layer mask 

You can drag elements from the layers panel into other documents 

Hold down Option/Alt and click the pane between two layers to clip the contents of the top layer into the transparencey of the layer 
underneath it 

Choose the move tool ―V key‖ Press Shift + ―+‖ to cycle through all the blending modes. Shift + ― -‖ to cycle in reverse. 

For more detailed information, please visit https://www.canva.com/learn/image-enhancement/ 

Also Visit https://photoshopcafe.com/tutorials/layers/intro.htm 

And https://helpx.adobe.com/photoshop/using/layer-basics.html 

https://www.photoshopessentials.com/basics/understanding-photoshop-layers/ 
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Videos: 

 

Review Design Brief  

https://www.youtube.com/watch?v=EMG6qJp_sPY 

https://www.youtube.com/watch?v=sY_lpwdDuRI 

https://www.youtube.com/watch?v=hgwUbElZuuI 

https://www.youtube.com/watch?v=dFSia1LZI4Y 

https://www.youtube.com/watch?v=ssC8O2kWWWA 

 

Select Tools for Designing Graphics  

https://www.youtube.com/watch?v=oMV7PQf3D_E 

https://www.youtube.com/watch?v=zqm0nI1rVRQ&t=7s 

https://www.youtube.com/watch?v=ZByhs9mDtDg 

 

Prepare a Design Layout  

https://www.youtube.com/watch?v=jp2Q2g0A5wc&t=12s 

https://www.youtube.com/watch?v=cbvqfIdEMCo&t=5s 

https://www.youtube.com/watch?v=NEQtSr_M4Yw 

https://www.youtube.com/watch?v=5CZbBugw7Dg 

 

 

Use Techniques for Designing Graphics  

https://www.youtube.com/watch?v=-JFC5cM05sk 

https://www.youtube.com/watch?v=czXUp7_JQxI 

https://www.youtube.com/watch?v=V4ftMJkZ9-c 

https://www.youtube.com/watch?v=i1D9ijh3_-I 

https://www.youtube.com/watch?v=uhHTUs2dyVo 

https://www.youtube.com/watch?v=EMG6qJp_sPY
https://www.youtube.com/watch?v=sY_lpwdDuRI
https://www.youtube.com/watch?v=hgwUbElZuuI
https://www.youtube.com/watch?v=dFSia1LZI4Y
https://www.youtube.com/watch?v=ssC8O2kWWWA
https://www.youtube.com/watch?v=oMV7PQf3D_E
https://www.youtube.com/watch?v=zqm0nI1rVRQ&t=7s
https://www.youtube.com/watch?v=ZByhs9mDtDg
https://www.youtube.com/watch?v=jp2Q2g0A5wc&t=12s
https://www.youtube.com/watch?v=cbvqfIdEMCo&t=5s
https://www.youtube.com/watch?v=NEQtSr_M4Yw
https://www.youtube.com/watch?v=5CZbBugw7Dg
https://www.youtube.com/watch?v=-JFC5cM05sk
https://www.youtube.com/watch?v=czXUp7_JQxI
https://www.youtube.com/watch?v=V4ftMJkZ9-c
https://www.youtube.com/watch?v=i1D9ijh3_-I
https://www.youtube.com/watch?v=uhHTUs2dyVo




Module 6: 021100998 Mix Sound 

 

Objective of the module: After successful completion of this module, the student is competent in Mix Sound according to professional 
standards 

Duration: 80 Hrs Theory: 20 Hrs Practical: 60 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU1: Prepare 
sound 
equipment 

 

The trainee will be able 
to: 

Arrange equipment as 

per project requirement 

Set equipment as per 

project requirement 

Check channel levels 

Explain sound equipment & its functions 

Explain audio interfacing & its purpose 

Explain signals and leads male female connectors 

Explain sound proofing 

Explain waves and sound layers  

Explain Audio recording software 

Explain sound its frequencies in detail  

 

Computer with M 
Audio/Sound Forge 
Sound Card 

Multimedia 

Adobe Creative Suit 

Sound Forge 

Mic with accessories 

5.1 Channel Audio 
Speaker 

Headphones 

LU2: Record 
sound 

 

The trainee will be able 
to: 

Connect Audio Interface 

as per project 

requirement 

Record vocals as per 

project requirement 

Record Instrument as 

per project requirement 

Record tracks as per 

Explain audio interfacing techniques 

Explain vocals & its recording techniques 

Explain instruments recording & its techniques  

Explain track recording & its techniques 

Explain sound recording software like sound forge, adobe creative 

suit 

Explain channel leveling 

 

Computer with M 
Audio/Sound Forge 
Sound Card 

Multimedia 

Adobe Creative Suit 

Sound Forge 

Mic with accessories 

5.1 Channel Audio 
Speaker 

Headphones 



project requirement 

LU3: Mix sound 

 

The trainee will be able 
to: 

Set project format as per 

project requirement 

Load audio layers on 

sequence 

Perform audio treatment 

Perform audio editing 

Apply audio filter as per 

project requirement 

Perform audio mixing 

Select output format as 

project requirement 

Render final project 

 

Explain audio treatment & its purpose 

Explain audio treatment techniques and tools 

Explain using effects and transition  

Explain audio editing & its techniques 

Explain audio filters & its purposes 

Explain techniques of using filters in audio 

Explain audio mixing & its techniques 

 

Computer with M 
Audio/Sound Forge 
Sound Card 

Multimedia 

Adobe Creative Suit 

Sound Forge 

Mic with accessories 

5.1 Channel Audio 
Speaker 

Headphones 

 

 

 

 

 

 

 

 



Examples and illustrations 

 
 
ntroduction to Audio 

 

This beginner-level tutorial covers the basics of audio production. It is suitable for anyone wanting to learn more about working with sound, in 
either amateur or professional situations. The tutorial is five pages and takes about 20 minutes to complete. 

What is "Audio"? 

Audio means "of sound" or "of the reproduction of sound". Specifically, it refers to the range of frequencies detectable by the human ear — 
approximately 20Hz to 20kHz. It's not a bad idea to memorise those numbers — 20Hz is the lowest-pitched (bassiest) sound we can hear, 
20kHz is the highest pitch we can hear. 

Audio work involves the production, recording, manipulation and reproduction of sound waves. To understand audio you must have a grasp of 
two things: 



1. Sound Waves: What they are, how they are produced and how we hear them. 

2. Sound Equipment: What the different components are, what they do, how to choose the correct equipment and use it properly. 

Fortunately it's not particularly difficult. Audio theory is simpler than video theory and once you understand the basic path from the sound 
source through the sound equipment to the ear, it all starts to make sense. 

Technical note: In physics, sound is a form of energy known as acoustical energy. 

The Field of Audio Work 

The field of audio is vast, with many areas of specialty. Hobbyists use audio for all sorts of things, and audio professionals can be found in a 
huge range of vocations. Some common areas of audio work include: 

 Studio Sound Engineer 

 Live Sound Engineer 

 Musician 

 Music Producer 

 DJ 

 Radio technician 

 Film/Television Sound Recordist 

 Field Sound Engineer 

 Audio Editor 

 Post-Production Audio Creator 



 

Sound 

In physics, sound is a vibration that typically propagates as an audible wave of pressure, through a transmission medium such as a gas, liquid 
or solid. 

In human physiology and psychology, sound is the reception of such waves and their perception by the brain.[1] Humans can only hear sound 
waves as distinct pitches when the frequency lies between about 20 Hz and 20 kHz. Sound waves above 20 kHz are known as ultrasound and 
is not perceptible by humans. Sound waves below 20 Hz are known as infrasound. Different animal species have varying hearing ranges. 

 

In most video programs it's the audio portion that organizes and makes the visual intelligible. For some types of programs the absence of 
sound would make the production completely useless even with the best visuals. Ideally, though, if attention is given to high values in both 
audio and video, each serves to compliment the other. The result is a program that communicates powerfully and effectively.  
 
In some ways, the general lack of good audio values in video might be attributed to the design of the video recorder. With most small, portable 
video units, a microphone is built into the camera, and sound synchronized to the action in the scene is automatically recorded along with the 
video. It's so easy that people tend to forget about the limitations in this setup and alternative techniques that are available.  
 
Connections for composite video are pretty straightforward. If it says "video" then it's one volt peak to peak with an impedance of 75 ohms. 
Period. Audio connections are not so simple. To make connections from one piece of equipment to another with confidence, you need to know 
some basic audio terminology, and a little theory.  
 
Audio is a more technical term, referring to sound coming from a recording, transmission or electronic device. Sound is a more generic word 

https://en.wikipedia.org/wiki/Physics
https://en.wikipedia.org/wiki/Vibration
https://en.wikipedia.org/wiki/Hearing
https://en.wikipedia.org/wiki/Transmission_medium
https://en.wikipedia.org/wiki/Physiology
https://en.wikipedia.org/wiki/Psychology
https://en.wikipedia.org/wiki/Brain
https://en.wikipedia.org/wiki/Sound#cite_note-1
https://en.wikipedia.org/wiki/Frequency
https://en.wikipedia.org/wiki/Ultrasound
https://en.wikipedia.org/wiki/Infrasound
https://en.wikipedia.org/wiki/Hearing_range


and can be caused by any source. So, if the beeping noise is coming from an electronic device, it could be considered audio, but usage is 
important 

 
How Sound Waves Work 

Before you learn how sound equipment works it's very important to understand how sound waves work. This knowledge will form the 
foundation of everything you do in the field of audio. 

 
 

Sound waves exist as variations of pressure in a medium such as air. They are created by the vibration of an object, which causes the air 
surrounding it to vibrate. The vibrating air then causes the human eardrum to vibrate, which the brain interprets as sound. 

The illustration on the left shows a speaker creating sound waves (click the button to show animation). 

  

Sound waves travel through air in much the same way as water waves travel through water. In fact, since water waves are easy to see and 
understand, they are often used as an analogy to illustrate how sound waves behave. 
  
  
  



 

Sound waves can also be shown in a standard x vs y graph, as shown here. This allows us to visualise and work with waves from a 
mathematical point of view. The resulting curves are known as the "waveform" (i.e. the form of the wave.) 

The wave shown here represents a constant tone at a set frequency. You will have heard this noise being used as a test or identification signal. 
This "test tone" creates a nice smooth wave which is ideal for technical purposes. Other sounds create far more erratic waves. 

Click here to listen to this tone (22KB wav file) 

Note that a waveform graph is two-dimensional but in the real world sound waves are three-dimensional. The graph indicates a wave traveling 
along a path from left to right, but real sound waves travel in an expanding sphere from the source. However the 2-dimensional model works 
fairly well when thinking about how sound travels from one place to another. 

The next thing to consider is what the graph represents; that is, what it means when the wave hits a high or low point. The following explanation 
is a simplified way of looking at how sound waves work and how they are represented as a waveform. Don't take it too literally — treat it as a 
useful way to visualise what's going on. 

In an electronic signal, high values represent high positive voltage. When this signal is converted to a sound wave, you can think of high values 
as representing areas of increased air pressure. When the waveform hits a high point, this corresponds to molecules of air being packed 
together densely. When the wave hits a low point the air molecules are spread more thinly. 

In the diagram below, the black dots represent air molecules. As the loudspeaker vibrates, it causes the surrounding molecules to vibrate in a 
particular pattern represented by the waveform. The vibrating air then causes the listener's eardrum to vibrate in the same pattern. Voilà — 
Sound! 

https://www.mediacollege.com/media/audio/tone1k-22-8.wav


Variations in Air Pressure and Corresponding Waveform 

 

Note that air molecules do not actually travel from the loudspeaker to the ear (that would be wind). Each individual molecule only moves a small 
distance as it vibrates, but it causes the adjacent molecules to vibrate in a rippling effect all the way to the ear. 

Now here's the thing: All audio work is about manipulating sound waves. The end result of your work is this series of high and low pressure 
zones. That's why it's so important to understand how they work - they are the "material" of your art. 

 

 

 

Audio Signal  

An audio signal is a representation of sound, typically using a level of electrical voltage for analog signals, and a series of binary 
numbers for digital signals. Audio signals have frequencies in the audio frequency range of roughly 20 to 20,000 Hz, which corresponds to the 
lower and upper limits of human hearing. Audio signals may be synthesized directly, or may originate at a transducer such as 
a microphone, musical instrument pickup, phonograph cartridge, or tape head. Loudspeakers or headphones convert an electrical audio signal 
back into sound. 

https://en.wikipedia.org/wiki/Sound
https://en.wikipedia.org/wiki/Voltage
https://en.wikipedia.org/wiki/Analog_signal
https://en.wikipedia.org/wiki/Binary_numbers
https://en.wikipedia.org/wiki/Binary_numbers
https://en.wikipedia.org/wiki/Digital_signal_(signal_processing)
https://en.wikipedia.org/wiki/Audio_frequency
https://en.wikipedia.org/wiki/Human_hearing_range
https://en.wikipedia.org/wiki/Synthesizer
https://en.wikipedia.org/wiki/Transducer
https://en.wikipedia.org/wiki/Microphone
https://en.wikipedia.org/wiki/Pickup_(music_technology)
https://en.wikipedia.org/wiki/Phonograph_cartridge
https://en.wikipedia.org/wiki/Tape_head
https://en.wikipedia.org/wiki/Loudspeaker
https://en.wikipedia.org/wiki/Headphones


Stereophonic Sounds 

What we know as stereo is technically described as stereophonic sounds. In stereo, several channels are used to transport audio signals to a 
speaker and thus to a listener‘s ears. Typically, stereo uses two channels, but it can use more. In the most common set up, one channel is 
transported to one speaker and the other channel to another speaker. 

Consider the following graphic: 

 

Here you can see the aforementioned usual set up for stereo sounds. There are two different sources that send their individual signal to one 
speaker each. 

Thus, sounds that are transported entirely to the right speaker will appear to come from a listener‘s right side. The signal does‘t have to be 
transported to one speaker in it‘s entirety though. Sound can be transported proportionally as well. Meaning that a small proportion of the sound 
can be transported to the right speaker while the rest is sent to the left one, creating a more 3-dimensional hearing experiences. Sounds that 
are equally transported to both speakers appear to come from the center. 

This is all based on the typical set up of two sources of sound that are transported to two speakers. Instances like surround sound, for example, 
use even more speakers to further design where particular sounds are coming from. 

Thus, stereo is used to create an impression of sounds coming from different directions, setting sounds in perspective to one another and the 
listener. This is especially useful in movies and audio plays to emerge the listener/viewer into the story. It is also used in music. For example, in 



some songs it might be that the guitar part is send to one speaker, while the bass is send to the other. When listening to music or plays out 
loud, this is often not very apparent. Headphone-users, however, are often very aware of stereophonic sounds. Removing one ear piece can 
reveal that a particular instrument or sound is only transported to your left or right ear. 

  

Monaural Sounds 

In mono, also known as monaural sounds, there is only one source for the audio. While mono sounds can also be transported to different 
speakers, the signal that is played will still be the same. 

This is visualized in the following graphic: 

 

Here, the sound comes from only one sound and even though it is transported to two different speakers, the content of the signal is always the 
same. When listening to music or other auditory pieces using headphones, you will thus not hear any difference when you remove one of the 
ear pieces. The whole play with localization of sound thus gets lost in monaural sounds. 

Analog vs Digital 

What‘s the difference between analog and digital audio cables? Analog cables work by transmitting information through a stream of electricity, 
and digital cables work by transmitting information through a long string of 1‘s and 0‘s (aka binary code). 



In a home recording studio situation, you are mostly concerned with how to transmit the analog sound from your mics and instruments so that 
you can eventually capture the sound in your DAW or other recording app or software. So, that is the key focus of this post. 

What is the difference between Mic, Line, and Instrument level? 

Mic Level is the lowest signal level which travels through an XLR connection. The mic level signal requires a preamp to raise the mic level up 
to line level. You use an XLR cable whenever you connect a microphone to your audio interface or mixer. Interfaces and mixers with built-in mic 
inputs usually have a built-in mic preamp too, so you shouldn‘t need additional kit other than the cable. 

Line Level is the highest signal level which travels through a TRS connection. This is the standard type of signal and you should use TRS 
when connecting any non-instrument pieces of hardware to your interface (i.e. an outboard preamp or processor) or instruments that output a 
balanced line level (synths, keyboards, drum machines etc). Note that a lot of consumer audio equipment and semi-pro keyboards etc may 
have unbalanced line outputs so you will use a TS cable instead. Check the manual of your gear to be sure. 

Instrument Level is the most variable level signal which will travel through a TS connection. You  will also require a preamp to be raise the 
level to Line Level. (Built in on most audio interfaces). Choose this cable whenever you connect an instrument such as a guitar or bass guitar 
directly to your interface. 

Understanding Analog Connections 

Your goal is to record a clean and loud enough signal from your microphone, guitar, keyboard, synth, or drum machine in your recording 
software or DAW. Recording success has a lot to do with the audio cable types you choose. Get the audio connections right, and your audio 
recordings will sound good. So, how do you decide which is the right audio cable? 
As a general rule, you read what it says on your gear, or refer to the manual. Sounds simple? Well, let‘s start with an in-depth look at the most 
common audio cable types. Then we‘ll examine the inputs and outputs on some popular home recording studio gear to see how it all fits 
together. You‘ll soon get the hang of it. 

The 1/4-inch (6.35mm) Analog Plug Connector 

The 1/4-inch (or 6.35mm) jack plug is the most common audio connector, and the most versatile. An audio lead with a 1/4 inch plug is also 
known as a jack lead. But not all jack leads are the same! Here‘s a bit more detail on what you really need to know. 



 

his the audio cable or cord you use for your guitar, or for the left and right outputs of a synth or keyboard (assuming outputs are not balanced). 
It is mono because you only have one channel through which to send the signal. Either left or right. You cannot send a stereo signal through 
this audio cable. 

The most common TS cords are instrument cables. The instrument cable contains one wire and a shield. The wire is connected to the tip, the 
shield is connected to the sleeve. You need the shield to minimise noise. 

Instrument cords, or jack cables, are unbalanced because of the way they are wired. The signal is sent through one wire. The shield is used for 
the ground. (ie it keeps the noise down). More on balanced vs unbalanced later … 

Meanwhile, here is one more thing you need to know. If you are connecting instruments, for instance, a guitar, a keyboard or a synth, then 
make sure you purchase an instrument cable. NEVER use a speaker cable to connect instruments. 



 

he stereo TRS cable looks almost identical to the TS cable, but this 1/4″ jack plug has 3 contact points (the Tip, Ring and Sleeve) separated by 
2 plastic dividers. Spot the difference? 
The TRS cable can be used in 2 different ways: 

1. As a stereo cord, where the signal is split into the right channel and the left channel. Generally the left-channel signal is attached to the 
tip, the right-channel signal is connected to the ring. Finally the shield is wired to the sleeve. 

2. As a balanced mono cable to connect professional audio gear. For example, to connect a synth with balanced outputs to an audio 
interface with balanced TRS inputs. The benefit of a balanced cable is you can have a long cable run without creating noise. How will you 
know whether the outputs on your gear are balance or unbalanced? Your outputs will almost certainly be labelled if they are balanced … 
or refer to the manual for your equipment to be sure. 

Balanced vs Unbalanced Cables 

1. Unbalanced cables have a bigger chance of picking up radio interference and noise. If you were to cut open an unbalanced cable you‘d 
see two wires: a conductor wire and a ground wire. Therefore, use the shortest cables you can get away with. 

2. Balanced cables on the other hand are designed to cancel out those interferences and electrical hums. They do it with the help of an 
added wire inside, so they have two conductor wires and a ground wire (three in all). With the help of that second wire, both wires cancel 
out the noise. How? The balanced cable has two wires and a shield, when it is used as a balanced mono cable then the same signal is run 
throug both the wires. One signal is 180 degrees out of phase with the other. When the signals get to the interface or mixer input, the 
signals are flipped and added to eachother. Thus, any noise built up in the signal is canceled out. 



3. For a connection to be balanced, all points in your cable circuit must be balanced. Therefore: your gear must have a balanced output; 
your cables must be balanced (TRS or XLR); your input on your interface or mixer must be balanced. If just one of these is unbalanced, it‘ll 
make your entire signal chain unbalanced. 

4. It is most likely that the 1/4″ connections are unbalanced, unless they are labelled as balanced. Check the manual, or the label on the 
input to find out. If the output is balanced mono, or stereo, use TRS. If unbalanced, and mono, use TS. 

5. It is wise to keep unbalanced cable lengths under 6 feet (1.8m) to prevent noise and interference 

6. If you need/want to use longer cables, or you want to connect an unbalanced signal into a balanced signal, then you can use a DI (direct 
injection) box. This is a device used in recording and live audio to convert signals and match audio levels. It allows you to plug unbalanced 
gear (such as your guitar, synth, or bass) to balanced inputs on mixers and PA systems. Because the DI box converts the signal to a 
balanced connection. The benefit? You get noise reduction, no interference and the ability to run long cables 

XLR Mic Cables 

 

he XLR connector is used for microphones and also some line connections between professional gear. This cable has a female and a male 
end. The XLR cable is wired much like a TRS connector and is balanced to minimize noise. The XLR mic cable is also sometimes called a low 
Z cable because it carries a low-impedance signal. 
XLR cables can be very long without noise interference, because again they are balanced. 

https://amzn.to/2E4zvVi
https://amzn.to/2E4zvVi


RCA Phono Cables 

 

RCA cables, sometimes referred to as phono plugs, or phone cables, are common on home stereos and a lot of semi-pro audio gear. They 
function very much like TS cables, with one connector and one ground. The RCA cable is an unbalanced cable. RCA connectors usually come 
in pairs to achieve stereo. Most of the time the red is used for the right channel (easy to remember: red-right) and white is used for the left 
channel. 
Keep your RCA cables is short as possible, else you might pick up noise and electrical hums. 



Stereo/TRS Cable (Tip-Ring-Sleeve) 3.5mm (1/8″) 

 

The 1/8″ mini jack plug is a tip-ring-sleeve (TRS) plug, like its larger 1/4″ brother.You will find the 1/8-inch (or 3.5mm) TRS plug on many, if not 
most, consumer headphones. In fact if you purchase pro-audio headphones you will often find they have a 3.5mm jack with a 1/4″ (6.35mm) 
adaptor as shown below. For example, the Sony MDR7506 Professional Heaphones have this arrangement. 

 

https://amzn.to/2BvZYta


You may also find some of your audio equipment has a 3.5mm aux output or input. In that case, you will need an audio cable with a 3.5mm 
TRS jack plug. 
The aux out will usually be a stereo output. The aux output is unbalanced. 

To connect your aux output to twin mono 6.35mm inputs on an interface you will need a Y-Cable (aka breakout cable) like the Hosa CMP-
159 below. This takes the stereo signal picked up through the 3.5mm plug and splits it into left and right dual mono 1/4″ TS. 

 

https://amzn.to/2GEjdUN
https://amzn.to/2GEjdUN


TRRS (Tip-Ring-Ring-Sleeve) 3.5mm (1/8″) Headphone and Mic Plug 

 

Digital Cables 

Our will find more and more digital cables in a modern home recording studio. In some ways, digital cables are more straightforward. This is 
because unlike analog cables, with digital cables you don‘t really need to understand much about how they work, in order to use them. You 
simply purchase the correct cable according to the protocol: ADAT; S/PDIF (also known as TOSLINK); BNC; and AES/EBU. 
To keep this post simple, we are concentrating on analog cables and only 3 most common digital cables found in a home recording studio 
situation. If you have an audio interface or pro audio gear with digital connections, then refer to the manuals of the devices so you purchase the 
correct interconnect. You will also find useful information in our post on recording digital audio. 

https://www.musicrepo.com/recording-digital-audio/


MIDI Cables 

 

MIDI cables are used to sync and communicate instructions between MIDI compatible gear. So, your digital piano or electronic drum kit will 
almost certainly have MIDI i/o. Many modern MIDI devices now use USB to connect. However, you may find it more efficient, even if USB is an 
option, to use the traditional MIDI ports on your equipment, and connect them with a MIDI cable. You can find out more about this protocol in 
our detailed post on what is MIDI. 
The MIDI cable has 5 pins. You may see the MIDI cable referred to as a 5-pin DIN cable. 

 

https://www.musicrepo.com/what-is-midi/


USB Cable 

 

USB (Universal Serial Bus) is a common way to connect devices in a home recording studio. The majority of audio interfaces connect via USB. 
As do many MIDI keyboard controllers. Digital pianos and music keyboards often have a ‗USB to Host‘ connection for MIDI. 

Most interfaces and keyboards connect via the USB B to A as shown above. (It‘s a standard USB printer cable). However, many USB mics and 
some interfaces have a mini USB port. Often you will get a USB cable in with the audio device, but if not it is a simple matter of checking the 
connections and ordering the correct cable. 

USB has different standards, as follows: 

 USB 1.1: this original standard can handle a data rate of up to 12 Mbps (megabits per second) 

 USB 2.0: Also called High-Speed USB. This can handle 40 times the data flow of the older standard. 480 Mbps 

 USB 3.0: Also referred to as SuperSpeed USB. This connection transfers data at 5 Gbps, ten times faster than USB 2.0 

As there is more than one standard, do check the ports on your computer and your interface or device, so that you purchase the correct speed 
of cable. 



The Inputs and Outputs of a Typical Audio Interface 

Now that you have covered all the main audio cable types found in a typical home recording studio, let‘s look at two popular products to see 
which cables you might require. First, take a close look at the Focusrite 2i4 USB Audio Interface. 

This interface can accomodate nearly all the audio cable types referred to in the above post! Here is an annotated picture of the front and rear 
panel. It shows you all the different input and output ports. 

 

Front panel: As you can see, the interface has balanced inputs on the front. You can connect microphones via XLR cables (a balanced signal). 
You can connect balanced line level signals using TRS 6.35mm jacks cables. Or, you can record guitars or other unbalanced line or instrument 
level devices via 1/4″ TS cords. 

https://amzn.to/2WYECxK


The headphone output requires a 1/4-inch TRS stereo jack. 

Rear panel: This audio interface has MIDI ports for MIDI in and MIDI out. There are two sets of unbalanced outputs, left and right. These are of 
the RCA phono type. 

There are also two balanced line outputs. These require TRS 6.35mm cables to connect to either an amplifier or powered monitors. (See 
below). Finally, as you can see, this is a USB interface, so there is a USB output to connect the device to a computer. 

The Inputs of a Typical Home Recording Studio Powered Monitor 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Among the most popular home recording studio monitors are the KRK Rokit 5 Powered Speakers. Here is a view of the rear of one of these 
monitors. Again, annotated so you can see the choice of inputs. 

 

 

https://www.musicrepo.com/best-headphones-for-home-recording-studio/
https://www.musicrepo.com/best-studio-monitors/
https://www.musicrepo.com/best-studio-monitors/
https://amzn.to/2XBX1nb


Technical Terminology 
 

 

 
Unbalanced Audio Cable  

Unbalanced lines are cables with only a single conductor and a grounded shield. They're used for "mic in" jacks rated at 600 ohms impedance 
and "line" or "auxiliary" in jacks rated at 10,000 ohms or higher. Unbalanced lines are subject to interference, especially in runs of twenty feet or 
longer. Unbalanced lines can usually be identified if they end in "RCA" jacks, mini-plugs or phone jacks.  
 

 

 

 Balanced Audio Cable  

 
Balanced lines are those with two conductors and a grounded shield. The two conductors are used to carry signals which are identical except 
that one is inverted and is opposite in polarity from the other. Any interference picked up on the two conductors will have the same polarity on 
both. When the two signals are recombined in a transformer, the interference cancels itself out. This makes balanced lines the best choice for 
long cable runs. Balanced lines are generally used for 600 ohm "line" or 50-250 ohm microphone inputs. Generally, if the cable ends in a 
cannon (XL) connector it's balanced.  
 
NOTE: Coupling a balanced line to an unbalanced line directly without using a transformer unbalances the entire length of the balanced line 



and defeats the purpose of using it.  
 

 

 

Transformer  

 
Impedance is a technical term that refers to the apparent resistance a circuit presents to an alternating current. This apparent resistance is 
measured in units called ohms. The maximum signal transmission between devices with the lowest distortion occurs when the input and output 
impedances are the same. Most audio devices fall into one of three categories; microphones generally have low impedance (50 to 250 ohms), 
balanced lines are rated at a nominal 600 ohms, and unbalanced lines (used in consumer stereo equipment) have high impedance (10,000 
ohms and higher). Don't worry about an exact match. Simply connecting outputs to inputs in the same impedance range is sufficient.  
 
Cables connecting high impedance devices are more susceptible to losses and interference as the length of cable increases. Cables 
connecting low impedance devices are less likely to have problems. Low impedance balanced cables can be run hundreds of feet with minimal 
problems.  
Level - The sensitivity of audio inputs is another important variable. The standard line level is one volt peak-to-peak (.775 volts RMS) at 600 
ohms. Microphone outputs and inputs vary. Specifications are given either in millivolts or in decibels. Using established convention, two typical 
microphone outputs are 1 millivolt (-60dB) and 100 millivolts (-20dB).  
 
Signal to Noise Ratio is the difference in amplitude between unintelligible noise generated within the device and the maximum signal output of 
the device, again expressed in decibels. Most video recorders should be capable of an audio signal to noise ratio of forty to fifty dB. (Digital 



audio devices are capable of more than 100dB.) You may have noticed that the range of output signal levels exceeds the signal to noise ratio 
of video recorders. If you put a mic level signal into a line level input, the signal is so low that it falls in the range of noise. You won't even hear 
it.  
 
Microphones  
 
Microphones capture sound and transform it into electrical impulses that are sent to the video recorder. Although there are a number of 
different microphone designs, only two are used with most video equipment. From the user's point of view, the main difference is that 
condenser microphones need a power source (battery or external) and dynamic microphones don't. 
 
Dynamic microphones are generally less expensive than condenser mics. Both are fine for general use. It's hard to find a quality microphone 
for less than a hundred dollars. Audio purists will spend hundreds of dollars on a microphone.  
Microphones are a type of transducer - a device which converts energy from one form to another. Microphones convert acoustical energy 
(sound waves) into electrical energy (the audio signal). 

Different types of microphone have different ways of converting energy but they all share one thing in common: The diaphragm. This is a thin 
piece of material (such as paper, plastic or aluminium) which vibrates when it is struck by sound waves. In a typical hand-held mic like the one 
below, the diaphragm is located in the head of the microphone. 

Location of Microphone Diaphragm 

 

When the diaphragm vibrates, it causes other components in the microphone to vibrate. These vibrations are converted into an electrical 
current which becomes the audio signal. 

Note: At the other end of the audio chain, the loudspeaker is also a transducer - it converts the electrical energy back into acoustical energy. 



Types of Microphone 

There are a number of different types of microphone in common use. The differences can be divided into two areas: 

(1) The type of conversion technology they use 

This refers to the technical method the mic uses to convert sound into electricity. The most common technologies are dynamic, condenser, 
ribbon and crystal. Each has advantages and disadvantages, and each is generally more suited to certain types of application. The following 
pages will provide details. 

(2) The type of application they are designed for 

Some mics are designed for general use and can be used effectively in many different situations. Others are very specialised and are only 
really useful for their intended purpose. Characteristics to look for include directional properties, frequency response and impedance (more on 
these later). 

 
 
Boom  
 
A boom is a long pole to which a microphone is attached. Usually there's a special rubber or foam shock absorber between the pole and the 
microphone so vibrations in the pole can't be picked up by the mic.  

 

  
 

 

 

 

 

 

 

 

 



 

Windscreen  
 
A windscreen is a small cover, usually of foam rubber, that fits over the top of the microphone. The wind screen is used outside and reduces 
(but doesn't eliminate) the sound of the wind. The windscreen doesn't cut down on the sensitivity of the mic very much. There's no need to 
remove it if you're working where it isn't needed.  

 

  
 

 

 

 

 

 

Transmitter Mics  
 
Where you can't have microphone cables lying around, but you still need to mic specific sound sources, many people are using radio or 
transmitter mics. Actually, this involves a microphone plugged into a radio transmitter that sends the signal to a receiver, which is attached to 
the recorder. While it's a good idea, problems with interference, reflections, and obstacles can turn a good idea into a nightmare. The better 
systems operate in the VHF band, from 150 to 170 MHz.  
 
Receivers for wireless microphones come in two basic types.  Non diversity receivers have a single antenna and single receiver for each 
microphone.  There is no protection against reflection or obstacles.  Diversity receivers use multiple (2) antennas and may use one or two 
receivers for each microphone.  The received signals are compared hundreds of times each second and the better signal is used.  While 
diversity systems will help with reflections and obstacles, radio frequency interference will still cause problems. 

 



                                                                                 

Sound Mixers: Overview 

 

A sound mixer is a device which takes two or more audio signals, mixes them together and provides one or more output signals. The diagram 
on the right shows a simple mixer with six inputs and two outputs. 

As well as combining signals, mixers allow you to adjust levels, enhance sound with equalization and effects, create monitor feeds, record 
various mixes, etc. 



Mixers come in a wide variety of sizes and designs, from small portable units to massive studio consoles. The term mixer can refer to any type 
of sound mixer; the terms sound desk and sound console refer to mixers which sit on a desk surface as in a studio setting. 

Sound mixers can look very intimidating to the newbie because they have so many buttons and other controls. However, once you understand 
how they work you realise that many of these controls are duplicated and it's not as difficult as it first seems. 

Applications 

Some of the most common uses for sound mixers include: 

 Music studios and live performances: Combining different instruments into a stereo master mix and additional monitoring mixes. 

 Television studios: Combining sound from microphones, tape machines and other sources. 

 Field shoots: Combining multiple microphones into 2 or 4 channels for easier recording. 
Channels 

Mixers are frequently described by the number of channels they have. For example, a "12-channel mixer" has 12 input channels, i.e. you can 
plug in 12 separate input sources. You might also see a specification such as "24x4x2" which means 24 input channels, 4 subgroup channels 
and two output channels. 

More channels means more flexibility, so more channels is generally better. See mixer channels for more information. 

Advanced Mixing 

The diagram below shows how a mixer can provide additional outputs for monitoring, recording, etc. Even this is just scratching the surface of 
what advanced mixers are capable of. 

https://www.mediacollege.com/audio/mixer/channel.html


 

 

 

 

  
  
 

 

 

 

 

 

Equalization  

 
Generally speaking, equalization is a tool which is used to correct deficiencies in sound. It involves changing the amplitude of narrow bands 
within the audio spectrum. It is (and this is important) a form of audio distortion. In other words, if something sounds all right to you, don't waste 
your time trying to improve it through equalization.   To put it another way, any change you make in the audio system is by definition distortion. 



 
The simplest equalizers are the bass, treble, and loudness controls on consumer receivers. Graphic equalizers slice the audio spectrum into a 
series of narrow bands, while parametric equalizers let you set the target frequency, the width of spectrum, and the amount of boost or 
attenuation you want. While graphic equalizers have a wide variety of uses, from matching sounds recorded with different microphones or 
under varying conditions, Parametric equalizers are better at isolating and reducing the impact of undesirable background sounds.  
 
Sound is a more important part of most television programs than the viewers ever realize. Unless you do an adequate job of treating the 
acoustical and aesthetic problems involved, the entire meaning of your program can be distorted or obscured. As in any other area of television 
production, experience and common sense prove to be your most valuable tools. 

 

 

 

 

Audio Software  

(formerly known as Sonic Foundry Sound Forge, and later as Sony Sound Forge is a digital audio editing suite by Magix Software GmbH, 
which is aimed at the professional and semi-professional markets. There are two versions of Sound Forge and Sound Forge Pro.Both are well 
known digital audio editor and offer recording, audio editing, audio mastering and processing audio. 

 

https://en.wikipedia.org/wiki/Sonic_Foundry
https://en.wikipedia.org/wiki/Sony_Creative_Software
https://en.wikipedia.org/wiki/Audio_engineering
https://en.wikipedia.org/wiki/Magix_Software_GmbH
https://en.wikipedia.org/wiki/Digital_audio_editor
https://en.wikipedia.org/wiki/Audio_editing
https://en.wikipedia.org/wiki/Audio_mastering


 

For more detailed information, please visit: https://www.musicrepo.com/audio-cable-types/ 

Also Visit https://www.mediacollege.com/audio/connection/connectors.html 

 

Audio interface  

An audio interface is a piece of hardware that expands and improves the sonic capabilities of a computer. Some audio interfaces give you the 
ability to connect professional microphones, instruments and other kinds of signals to a computer, and output a variety of signals as well. 

 

 

Vocal:  

Vocal means made by the voice, or relating to the voice, or being outspoken. An example of something vocal is a song. An example of 
a vocal person is someone who always debates her point. 

 

https://www.musicrepo.com/audio-cable-types/
https://www.mediacollege.com/audio/connection/connectors.html


 

 

 

Sound recording  

Sound recording is the storage of sound so that a person can hear the same sound more than once. It is a process wherein 
sound waves are captured by a machine. The machine converts the waves into electrical signals or digital data, that are then stored 
on recording media (such as gramophone records, cassette tapes, compact discs or computer hard drives). The sound can then be played 
back by reversing the process. 

Most recordings are of music, people speaking or singing, and sound effects. They are usually used for entertainment (fun), or for scientific and 
historical reasons. 

Sound is recorded onto a medium by different methods. The ways that recordings are made have changed a lot since sound was first recorded. 

 

Tack Recording 

Tracking is essentially the process of recording songs. The name comes from the fact that each instrument is recorded individually and given 
its own ―track‖ in the mix, so that the balance and sound of each can be controlled later. ... Record in a great space – often a recording studio 

https://simple.wikipedia.org/wiki/Recording
https://simple.wikipedia.org/wiki/Sound
https://simple.wikipedia.org/wiki/Process
https://simple.wikipedia.org/wiki/Wave_(physics)
https://simple.wiktionary.org/wiki/capture
https://simple.wikipedia.org/wiki/Machine
https://simple.wikipedia.org/wiki/Analog_signal
https://simple.wikipedia.org/wiki/Digital_signal
https://simple.wikipedia.org/wiki/Storage_medium
https://simple.wikipedia.org/wiki/Gramophone_record
https://simple.wikipedia.org/wiki/Cassette_tape
https://simple.wikipedia.org/wiki/Compact_disc
https://simple.wikipedia.org/wiki/Hard_drive
https://simple.wikipedia.org/wiki/Music
https://simple.wikipedia.org/wiki/Speech
https://simple.wikipedia.org/wiki/Singing
https://simple.wikipedia.org/wiki/Sound_effect


 
Balanced Audio 

This tutorial explains how balanced audio systems work. It is suitable for people who have a basic understanding of audio cables and 
connectors, as well as simple wave interactions (such as how waves from different sources interfere with each other). If you don't understand 
these things, take our introduction to audio tutorial first. 

What is Balanced Audio? 

Balanced audio is a method of minimizing unwanted noise from interference in audio cables. The idea is that any interference picked up in a 
balanced cable is eliminated at the point where the cable plugs into a sound mixer or other equipment. 

Balanced audio works on the principle that two identical signals which are opposite polarities (often erroneously called "out of phase") will 
cancel each other out. The cables used in such systems are designed to carry two versions of the signal and manipulate the polarities of these 
signals to eliminate noise. 

This will make more sense when we look at how balanced cables work, but first we need to take a step backwards and look at unbalanced 
audio cables. 

Noise Colours & Types 

Certain noises are described by their colour, for example, the term "white noise" is common in audio production and other situations. Some of 
these names are official and technical, others have more loose definitions. These terms generally refer to random noise which may contain a 
bias towards a certain range of frequencies. 

Black Noise A term with numerous conflicting definitions, but most commonly refers to silence with occasional spikes. 

Blue Noise Contains more energy as the frequency increases. 

Brown Noise Mimics the signal noise produced by brownian motion. 

Gray Noise Similar to white noise, but has been filtered to make the sound level appear constant at all frequencies to the human ear. 

Green Noise An unofficial term which can mean the mid-frequencies of white noise, or the "background noise of the world". 

Orange Noise An unofficial term describing noise which has been stripped of harmonious frequencies. 

Pink Noise Contains an equal sound pressure level in each octave band. Energy decreases as frequency increases. 

Purple Noise Contains more energy as the frequency increases. 

https://www.mediacollege.com/audio/01/
https://www.mediacollege.com/audio/mixer/
https://www.mediacollege.com/audio/noise/black-noise.html
https://www.mediacollege.com/audio/noise/blue-noise.html
https://www.mediacollege.com/audio/noise/brown-noise.html
https://www.mediacollege.com/audio/noise/gray-noise.html
https://www.mediacollege.com/audio/noise/green-noise.html
https://www.mediacollege.com/audio/noise/orange-noise.html
https://www.mediacollege.com/audio/noise/pink-noise.html
https://www.mediacollege.com/audio/noise/purple-noise.html


Red Noise An oceanographic term which describes ambient underwater noise from distant sources. Also another name for brown noise. 

White Noise Contains an equal amount of energy in all frequency bands. 

 
For more detailed information, please visit https://www.mediacollege.com/audio/noise/ 
Also Visit: https://www.musicrepo.com/what-is-an-audio-interface/ 
And: https://www.magix.com/us/support/know-how/tutorial-videos/sound-forge-audio-studio/ 

 

Audio Sequencing  

A sequencer is a virtual multitracker where you can record, edit and mix your material. The most used sequencers are: 

 Sound Forge  

 Steinberg Cubase (VST, LE, SX, 4) 

 Apple Logic 

 Digidesign Pro Tools 

Other applications include: SonicFoundry Acid, Steinberg Nuendo, Reason, Cakewalk Sonar and others. Another useful program is Steinberg 
Wavelab, which is actually not really a sequencer but a really useful editing and mastering tool. There are several professional mastering 
programs which will be described in the next workshops. 

Recording 

In my Cubase SX3 I create a new project, give it a name (like "song1") and save to the hard disc. Now we need several tracks. But first we 
should check the preferences. Let's use a sampling rate of 44,1kHz and a bitrate of 24 bit. The 24 bit gives us more dynamic while recording. 
The 44,1kHz is a standard. This should work properly with every soundcard. 

Now let's create 10 mono audio-channels. 

https://www.mediacollege.com/audio/noise/red-noise.html
https://www.mediacollege.com/audio/noise/white-noise.html
https://www.mediacollege.com/audio/noise/
https://www.musicrepo.com/what-is-an-audio-interface/
https://www.magix.com/us/support/know-how/tutorial-videos/sound-forge-audio-studio/


 

The band we're recording has a bongo, bass, guitar and vocals. If you don‘t have a separate audio-interface you can use your onboard-
soundcard. For the vocals, guitar and bongo-recordings connect a microphone to a preamplifier, via the gain/trim you can choose the 
amplification (a drum-set or electric-guitar can be much louder than a triangle, so the triangle needs more gain). 

Let's start with the guitar. Place the microphone in front of your guitar-amp, crank it up and gain your preamp, so it is not distorting. 

> For more information about soundcards and preamps please check this website or ask your local music store < 

Now open the edit-channel-window and set up the input correctly, so you get the signal. Click on the small loudspeaker-symbol to hear your 
signal. Adjust the output of your preamp so your soundcard-input is not distorting. To do this turn the output of your preamp (if there's no 
output-volume, use the gain/trim to control the volume). The maximum should be around -10dB at your sequencer. 



Now we can add a metronome/click to play on a beat. To do this open the transport-window and switch the "click off/on". Press Tempo to "Fix" 
and adjust the speed to your song's. Now get on play — you should hear your guitar plus the metronome. 

So now we're ready to record. In the track-list activate the small "record enable" button. It should be red now. Now name the track for example 
"guitar1". 

If you click the record button on the transport-window you can wait some beats and start recording. There you go. If you want to record a 
different guitar-take now just adjust your setting on the next tracks and there you go. That‘s how we do it for all the instruments. You can also 
drop the recorded take to the next track below and go on recording on the same track. In this case don‘t forget to name the tracks correctly. 

 

The bongos are recorded in the same way, just without the guitar-amplifier of course. Place the mic in front of the Bongos and gain/trim on your 
preamp. The vocals the same. The bass can directly be plugged into the preamp and recorded. 



If you listen to your recorded tracks and it is crackling there are many possibilities. Try to record again with less preamplification. Or check the 
cables and connectors. This may solve the problem. If your song is still crackling check your soundcard- and cubase-manuals for more 
information. 

Now let's colour the tracks so we can work easier. 

 

The pink and purple tracks are guitar tracks (L and R), the blue track is a bass-track, orange is bongos and green vocals. This is my favourite 
colouration. You might have your own. Now let's arrange them so we have a good overview. If not done yet, name the tracks. 



 

I arrange the tracks by putting the percussive instruments above, then the bass, then guitars and then the vocals. It's kinda standard, though 
every engineer has their own system. 

Editing 

What is editing? Editing is cutting and re-arranging parts so they fit properly into the song arrangement. We will also have to cut out 
unnecessary parts to get a cleaner sound. We should work non-destructively: this means everything we are doing can be undone. This is 
necessary if changes are unwanted later on. 

The most important tool in the edit process is cutting and fading. We need this to put two regions in a line or to fade in/out a part smoothly. Here 
are 3 ways to do this. 



Cutting At Zero Crossing 

How you do it wrong: 

 

The 2 parts were put together in no zero crossing-case. Your loudspeaker will try to make an infinite huge move which will result in a crackle. 

The right way: 



 

The cut was proceed on the zero crossing of the curve. If we put together 2 parts, which were cut at the zero crossing the transition will sound 
good. 

Fade In/Out 

If you want to fade-in/out a track you can either use the region-fades or the volume-fades. 
The longer the fade the smoother it sounds. 

The region-fade: 



 

The volume-fade: 



 

The main-difference between the region-fade and the volume-fade is that the volume-fade is post-insert, which means that the volume is being 
controlled after the inserts. If you chose region-fades the more the volume is being decreased, the less signal comes to the insert, which can 
colour the sound. Therefore an easy to understanding rule: 
"Dynamic in the insert of the audio-track – Use the volume fade!". 
The volume fade is found in the Automation submenu. 

Crossfades 

The fastest way to put together two parts is using the crossfade (do this by overlapping two regions and mark, then audio>crossfade.) Here it's 
automatically created a fade out and a fade in which are overlapping on the region you marked. 

We have to be careful, though. If the crossfades are too long it will sound whammy and imprecise. When the crossfade is too short the change 
from one part to another can sound untight or wrong. 



 

Removing Silence And Mute Regions 

Parts of audiotracks with no useful information can be deleted. No one wants to hear sneezing a singer in a break, he/shes waiting to sing 
again. Or guitar crackling etc is not needed. 

Make a cut, then mark the region and delete or mute it. This is really important if you have a drumset. The parts where the toms aren't played 
can be muted, so we get a cleaner sound. It's the same effect like a noise-gate, but handmade we can control the parameters (hold, attack etc.) 
much better. 

Muting and cutting clean: 



 

Cleaned Tom track: 



 

(Don't forget the fade-ins and fade-outs!) 

Our arrangement should now, after the editing, look like this: 



 

Actually we cleaned the tracks. Even now it should sound better because we removed all unnecessary information. We can also cut the single 
vocals parts and rearrange them. For creating remix-version it's also really important to know how to edit properly. 

Mixing 

When you now think "Now comes the most important part!" you're wrong. When the recording and editing is well done, the song will sound 
good, even without mixing, just by adjusting the volume-fader. 

Let's open the Mixer in Cubase and see what we can do. 



 

1. Input / Output 

Chose the input and output channels you want to use. 

2. Trim and Phase Reverse 

Trim to gain or damp the signal. 

3. Inserts 1-6 

Insertpoints where you can load in eqs, dynamics etc. Those are prefader wich means it doesn‘t matter what youre doing on the channel 

fader, the input volume to the inserts stays the same and is just controlled by the trim above. 

4. Inserts 6-8 

The same as #3 but the inserts are postfader, so you can control the input to the inserts via the fader. Only use this as an advanced user. 

5. Pan/Balance 

6. Mute and Solo 

7. Channelfader 

Controls the volume of your audiotrack. 



8. Automation Read/Write 

If you created a volume-fade or a pan-automation, the green "R" will light. This means the track reads your Automation. If its turned off the 

Automation wont be read. 

If you want to have a unique handmade fade you can turn on the "W", start the song playing, doing the fade with the channelfader, press 

stop and then turn to "Read". When you play this part again your fade will be replayed as you did it with the fader. 

Attention: Adjusting the normal channelvolume with the channelfader is not possible anymore when you've written a volume-automation. So 

only for experienced users. 

9. Edit channel window 

Separate window for channel-settings plus equalizer details. 

10. Insert / Eq / Send-Bypass 

11. Listen Input 

Click to listen to the incoming signal from the soundcard and mute the recorded. 

12. Record activation 

13. Show Inserts / EQs / Sends 

14. Mixer view setting 

Sends 1, 3, 5, 7 are prefader which means the channelfader has no influence on the send-volume. Sends 2, 4, 6 and 8 are postfader. Usually 
the posfader-sends are used for sending to channels with reverb, delay effects etc. = less signal, less effect. 

This should be enough of the mixer-tools. If you want to learn more about the details open the manual of the sequencer or wait for the next 
workshop. 

Now let's see what we can do with the inserts. Those are for replacing signals. Example: If you have vocals which are not loud enough you 
want to have them replaced with the loud signal through a dynamic. 

There are two components nearly used in every channelstrip: equalizer and dynamic. 
If you don't like the standard Cubase eq you can also add a different into the insert of the audio tracks. 



Equalizer 

We only have a bandwidth of 20Hz to 20kHz for our audio signals. If two instruments are overlapping in a frequency the two signals will be 
added and the audible signal will be the one which was louder. That would be wasted energy so we will give every instrument each a 
frequency-area. 

There are different types of Equalizers: 

 Lo Cut/Hi Pass 

Cuts a lot (about 24db/Octave) under the cutoff-frequency. 

Example: Cleaning tracks of low rumble and unnecessary information. 

 Lo Shelve / Hi Shelve 

Cuts/adds in the basses or highs 

 Shelving/Peaktype 

Cutts/adds around the cutoff-frequency. 

 High Cut/Lo Pass 

To cut high frequencies. 

Little trick: 
If you want to get a fat rock-guitar, you will probably turn in the bass frequencies and the highs. But try it like this: Put a high pass filter on 
200Hz. (The bass-guitar will give it the blast in those frequencies.) Now put a peaktype filter around 500Hz and lower those area with kind -5 to 
-10dB. Now turn in the highs from 5 to 8KHz. Mostly good results with that. Try it. 

What I wanted to show is there are easy solutions for a good sound, just learning by doing. Cutting rumble of vocals, snare and bass-guitar 
under 50Hz and guitars under 150-200Hz gives more space for a clean precise sound in the lows by bass and kickdrum. 
Cymbals/overheadtracks can also be cut under 1kHz. If you don‘t want a big natural drum-room, try this. 

With a high Q-factor boost/cut you should sweep through the whole frequency-band and check which frequencies are disturbing and remove 
them. 

Enough of equalizer, let's get to the... 



Dynamics 

Why dynamics? Dynamics control the volume of your audio-signal. We want a loud song, so we have to control the volume of each audio track. 
The louder parts should be adjusted to the quiet ones. 
There are different ways to do this. Here a list of different types: 

 Noise gate 

Closes the signalflow of the audio if the signal is under the Threshold. 

Example: Everything between 2 kickdrum-hits is being muted. 

 Compressor 

Reduces the audio signal above the Threshold with a ratio. 

Example: Loud vocals are being reduced so the quiet signals are more even. 

 Limiter 

Compressor with an endless high ratio. There is no signal over the Threshold. 

Example: A limiter in the Insert of the Masterfader so in the bounce there is no distorting signal above 0dB. 

 Multiband-Compressor: 

3 or more bands are compressed seperatly. 

Example: A static fat bass of a kickdrum, but the highs are kept dynamic. 

The compressor is the most used. 
What about the parameters? The most important are the Threshold, Attack, Release, Ratio and MakeUp-Gain. 

 Threshold: controls the point at which input gain the compressor starts working. 

 Attack: How fast the compressor works. Low frequencies can start crackling at really fast attack times. So use attack times above 5 ms for 

bass or similar. Kickdrum should have an attack time of over 15ms to remain the "kick". 

 Release: The time the gain reduction is being released. For pad-sounds (bass/synth) try slow releases (long time 100ms – 1s), for subtle 

gain reduction a faster release (20-100ms). 



 Ratio: The factor of the gain reduction. 

(Example: signal -10dB, threshold -20dB, Ratio 5:1 a fifth the signal over the threshold will be let through = -18dB). The higher the ratio the 

more the signal will be reduced. A Compressor with a ratio of (infinity):1 is a limiter (No signal over the threshold is been let through). 

 MakeUp-Gain: The volume on the output of the compressor. 

So the dynamics are usually making undynamic. 
If a signal is too compressed, there is a tool called Expander or De-Compressor which is doing the opposite. 

Panorama / Balance 

Panorama / balance is used to place an audiosignal in the stereo mix, from the very left, the mid to the very right. 
What is the difference between panorama and balance? Panorama knobs are for mono signals. When we have a stereo track and just one 
knob, it is a balance-adjuster. When we turn the balance to the very left, the right channel will be muted (we lose this information!) and just the 
left channel will be audible. But when we have two panorama buttons in a stereo track and turn both to the left, both channel (l and r) will be 
placed to the very left and mixed (no lost information!). 

Some basics for placing audio in the mix: 
Kick, snare, bass and vocals always pan to the mid. Toms, overheadtracks, guitars in the pan from left to right. 

So now we have our project, in every channelstrip an eq and a dynamic and a stereopanorama.. Now we can control the colouration of each 
instrument (by eqing and the dynamic). 

Reverb 

Using reverberation as an aftereffect gives you the possibility to control the room in the mix. 

Let's work with two room simulations. I will create two stereo fx-channel and as inserts chose reverb-plugins. Name the first fx-channel "short 
reverb" the second "long reverb". 

For signals which shall appear as in a small room we have the "short reverb". Set here the size to about 20 to 40 and the timeparameter to 
about 1-1,5 seconds. For the long reverb set the room size to about 70-100 and the time between 2 and 3 seconds. Set the mix-parameter to 
"100% wet". Why to a hundred percent? Well, we will send signals from our original tracks to those fx-tracks (also called "aux-tracks") and want 
a pure reverberation sound in those tracks. Unlike to the dynamics in each audiotrack we don‘t want to replace the original tracks, but add 
some new signal into the stereo-mix. Our project should look like this now: 



 

But we have to "feed" the fx-tracks. For this we will create aux-sends. Let's do this for the vocals. We will send signals to the short reverb. If we 
fade out the vocal-track, the reverb shall decrease too so we will use one of the postfader-sends (2, 4, 6 or 8): 



 

The Bongos shall have a little bit short reverb and lots of the long reverb, there we go: 

 

If you can't hear your reverb make sure... 



1. the audiotrack and the fx-track is not muted and 

2. the send is switched on (in Cubase you have to turn on every send manually!). 

Make sure your reverberations sound subtle and natural. 

We have an edited song, know how to equalize and control the dynamic and have two room-simulations. So far, so good. Now let's check 
some... 

Special Effects and Automation 

Try effects like Chorus, Flanger, Modulation, Delay, Distortion, Rotary or Tremolo for unique sounds in your songs. But beware: less is more. 
Don‘t use too much special effects, this could appear disturbing. 

Okay, let's try some effects. Here just two examples: 

Want a telephone-voice? 
First let's distort the additional vocals tracks. To do this add a distortion plugin ("Distortion", "Overdrive" or similar) into the insert of the vocal-
track. Now use an eq, a lo-cut at about 500Hz and a hi-cut at about 5kHz. Now boost the area between (at about 1-2Khz centre-frequency) with 
a few dB. Et voila, a telephone voice. 

 



Another nice effect can be a delay. Let's try it on the bongo-tracks. But just in one part, not on the whole track. First let's create a stereo fx-
channel, insert a delay-plugin. (Adjust the parameters as you like it after creating the send). The most important parameters are the delay time 
and the feedback. With the feedback-parameter you can chose how often the delay shall reappear. 

Now create a send. But how to activate the send for just one part in the bongo track? 
Well for this we need a send-automation. To open the submenu for this press the little plus-symbol in the audiotrack left in the corner. Now click 
on "volume" (the standard-parameter which can be automated), "more…" and chose the sendvolume you want to automate. Then click the 
"Read / (R)" button in the audiotrack to activate the automation and here we are. Now you can draw an automation-curve for the send-level. 
The higher the curve the more will be sent to the fx-channel: 

 

The automation is a really useful tool. As we learned in the beginning we can automate volume curves for post fader fade outs too. Nowadays 
sequencer can automate nearly everything like fx-parameters, volume, pan etc. 



Another way to automate is just to click the "Write / (W)" button and click play. Now turn the knobs which you want to automate. When you're 
done click stop, de-activate the Write-mode and activate the Read-mode. 

We have learnt the basics about editing and mixing. Now go on yourself, adjust your tracks with the inserts, add some room and special effects. 
Fade ins and fade outs in the beginning and the end of the song should be done in the end of the production-process. (If you don‘t want to 
master your song do it now.) 
When you want to master your song, skip the final fade in and fade out. 
When you're ready we're going to finish the song. Let's go 

Bouncing 

Bouncing is the same like "Mixdown", "Rendering" or similar. When a signal is above 0dB, the signal will distort. Therefore we will use a limiter 
in the insert of the main-output. 

When the limiter works all the time you're mix is too loud and it won't sound adequate, so you should reduce the volume of your tracks. (Note: If 
you're using volume-automations, you can't use the channelfader anymore, so you have the control on the automation-points). If the limiter is 
just working rarely you've done everything good. Now let's do the mixdown as Wave, 44,1Khz, 16Bit, stereo-interleaved. If you want to try 
mastering, save the song with the same settings of the project (Wave, 44,1kHz, 24 Bit). Save the track as a stereo-interleaved-file. 

Now we have a finished audiotrack. Put it into your audio-player and put some other, professionally mixed songs into it (for example of your 
favourite bands). I'm sure your song will be really quiet compared to the professional songs. 

Without professional equipment it's closely impossible to make your song that loud that the listener doesn‘t have to crank up the volume. But 
there are some easy ways to improve the final sound level. If we have more than one track we will also have to adjust one to another song so 
they sound similar. For this we need mastering. 

Mastering 

For more songs the process looks a little bit different. In our case we have just one song to master. 

First we need to create a new project, name it something like "song1Mastering". Import the bounced stereo-file to a new stereo track. There are 
countless ways to master but this shall show the most comfortable and easiest way in my eyes. 

Insert a stereo eq and a stereo compressor into the audio track. Put a limiter into the main output. 



Open the eq, set a lo-cut at about 20Hz. There is no useful information in this area. Now add some highs with a high shelve (about +3dBfrom 
10kHz to 20kHz). This gives more "air" and freshness to the song. Now try cutting some of the frequencies between 250Hz and 600Hz with 
about –1dB to -4dB. The cut of mids and boost of highs is what makes songs sound "fat". 

Now use the compressor gently. The attack should be above 15ms with a long release. The gain reduction should be less than 3dB, so the 
sound is not distorting too much. Now adjust the output of the compressor so the limiter is working but not audible. Just try with the eq and 
compressor until you get the desired result. 

Make the final fade in and fade out, bounce your song in 44,1kHz and 16 Bit (because this is the format usual audio CDs are working with) to 
the hard disc. 

That‘s it: your final version of your own recorded, edited, mixed and mastered song. 

For more detailed information, please visit: https://www.mediacollege.com/audio/sequencing/workshop/editing.html 
Also Visit: https://www.magix.com/us/music/sound-forge/sound-forge-pro/tutorials/ 
And: https://www.wikihow.com/Use-Sound-Forge 

 

 

Videos: 

 

Prepare Sound Equipment  

https://www.youtube.com/watch?v=xVc-lSxfPnY 

https://www.youtube.com/watch?v=AH6tl1c6z1I 

https://www.youtube.com/watch?v=sAg5YJFcof0 

https://www.youtube.com/watch?v=BNVVq-iVPy8 

https://www.youtube.com/watch?v=WIIKXOrt3bk 

https://www.youtube.com/watch?v=ezSpB73EoEA 

https://www.youtube.com/watch?v=Ultp3tofA6Q 

https://www.mediacollege.com/audio/sequencing/workshop/editing.html
https://www.magix.com/us/music/sound-forge/sound-forge-pro/tutorials/
https://www.wikihow.com/Use-Sound-Forge
https://www.youtube.com/watch?v=xVc-lSxfPnY
https://www.youtube.com/watch?v=AH6tl1c6z1I
https://www.youtube.com/watch?v=sAg5YJFcof0
https://www.youtube.com/watch?v=BNVVq-iVPy8
https://www.youtube.com/watch?v=WIIKXOrt3bk
https://www.youtube.com/watch?v=ezSpB73EoEA
https://www.youtube.com/watch?v=Ultp3tofA6Q


 

Record Sound  

https://www.youtube.com/watch?v=1UK5_XUoaSE 

https://www.youtube.com/watch?v=D18DiypgYuo 

https://www.youtube.com/watch?v=osCGSRdOMQ8 

https://www.youtube.com/watch?v=vpykcekWjmI 

https://www.youtube.com/watch?v=2MekmbtJaC4 

 

Mix Sound  

https://www.youtube.com/watch?v=bkgMtUUol8s 

https://www.youtube.com/watch?v=0g0HkT7glKM 

https://www.youtube.com/watch?v=BlZHTvHWq_g 

https://www.youtube.com/watch?v=i3xmHEUD4YQ 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=1UK5_XUoaSE
https://www.youtube.com/watch?v=D18DiypgYuo
https://www.youtube.com/watch?v=osCGSRdOMQ8
https://www.youtube.com/watch?v=vpykcekWjmI
https://www.youtube.com/watch?v=2MekmbtJaC4
https://www.youtube.com/watch?v=bkgMtUUol8s
https://www.youtube.com/watch?v=0g0HkT7glKM
https://www.youtube.com/watch?v=BlZHTvHWq_g
https://www.youtube.com/watch?v=i3xmHEUD4YQ




Module 7: 021100999 Carryout Non-Linear Editing 

 

Objective of the module: After successful completion of this module, the student is competent in carryout non-liner editing according to 
professional standards 

Duration: 100 Hrs Theory: 30 Hrs Practical: 70 Hrs 

Learning Unit Learning Outcomes Learning Elements Materials Required 

LU1: 

Set project 
properties 

The trainee will be able 
to: 

Select preset/mode of 

project 

Set video format rate as 

per project requirement 

Set aspect ratio as per 

project requirement 

Set field as per project 

requirement 

Set video format as per 

project requirement 

Set audio bit rate  as per 

project requirement 

Set audio channels as 

per project requirement 

Explain project properties & their functions, its importance 

Explain preset/mode in project properties  

Explain video format rate & its types  

Explain video format rate purpose 

Explain aspect ratios & its purpose 

Explain audio bit rate & its purpose 

Explain audio channels & its function 

 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU2: 

Import Data 

The trainee will be able 
to: 

Import videos as per 

Describe handling different types of data 

Explain Image and image sequencing 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 



project requirement 

Import graphics as per 

project requirement 

Import Animation as per 

project requirement 

Define Importing Alpha Files Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU3: 

Set Sequence 

The trainee will be able 
to: 

Set video sequence on 

timeline as per project 

requirement 

Set audio sequence on 

timeline as per project 

requirement 

Set graphic sequence on 

timeline as per project 

requirement 

Explain sequence 

Explain sequencing in editing & its importance 

Explain sequence in sequencing in editing 

Explain techniques of sequencing graphic, audio, & video in 

editing software 

 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU4: 

Balance Audio 

The trainee will be able 

to: 

Set audio channel levels 

as per project 

requirement 

Adjust audio gain as per 

project requirement 

Sync audio as per 

Explain about tracks 

Explain audio balancing 

Describe audio Channels 

Explain audio gain 

Define Stereo and Mono  

Describe db 

Explain about audio balancing and its purpose 

Explain tools & techniques for audio balancing 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 



project requirement  

Link/unlink audio as per 

project requirement 

Perform audio treatment 

as per requirement 

Apply audio filter/effects 

as per requirement 

Define functionality of audio balancing tools  

Explain about applying audio effects 

 

LU5: 

Perform Color 
Balancing/ 
Grading 

The trainee will be able 
to: 

Perform color treatment 

as per project 

requirement 

Apply video effects as 

per project requirement 

Apply video filter as per 

project requirement 

Define color balancing & its purpose 

Define color balancing/grading techniques & its tools 

Define Video Effects in detail 

 

 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU6: 

Prepare 
Roughcut 

The trainee will be able 
to: 

Cut video into segment 

as per project 

requirement 

Set and Adjust length of 

clip/scene as per project 

requirement  

Explain rough cut & its importance 

Explain techniques of creating rough cut videos 

Define Adjusting deferent sequences in a sequence 

Explain About adding text in editing software. 

Explain removing jitters and jerks & its techniques 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 



Adjust sequence of clips 

& tracks as per project 

requirement 

LU7: 

Make Revisions 

The trainee will be able 
to: 

Review Timeline as per 

project requirement 

Make corrections as per 

project requirement 

Define Importance of Review Timeline 

Explain ways to make corrections in project  

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU8: 

Prepare Final 
Cut 

The trainee will be able 
to: 

Add video & audio 

transitions on timeline as 

per project requirement 

Perform sharp cut on 

timeline as per project 

requirement 

Perform timeline 

rendering 

Define final cut & its importance 

Explain sharp cut & its techniques. 

Explain about applying video & audio transactions 

Explain timeline rendering 

 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

LU9: 

Generate 
Output 

The trainee will be able 
to: 

Select output format as 

per project requirement 

Describe different file formats 

Explain tools & techniques of generating output 

 

Computer with, Graphic 
Card & Sound Card 

Apple Mac Pro 

Multimedia 



Export timeline as per 

select output format 

Headphone 

5.1 Channel Speaker 

Preview Monitor 

Adobe Creative Suit 

Final Cut Pro 

Examples and illustrations 

 
What is Video Editing? 

Video editing is the process of manipulating and rearranging video shots to create a new work. Editing is usually considered to be one part of 
the post production process — other post-production tasks include titling, colour correction, sound mixing, etc. 

 

 

 

 

Many people use the term editing to describe all their post-production work, especially in non-professional situations. Whether or not you 
choose to be picky about terminology is up to you. In this tutorial we are reasonably liberal with our terminology and we use the word editing to 
mean any of the following: 

 Rearranging, adding and/or removing sections of video clips and/or audio clips. 

 Applying colour correction, filters and other enhancements. 

 Creating transitions between clips. 

 

 



The Goals of Editing 

There are many reasons to edit a video and your editing approach will depend on the desired outcome. Before you begin you must clearly 
define your editing goals, which could include any of the following: 

Remove unwanted footage 

This is the simplest and most common task in editing. Many videos can be dramatically improved by simply getting rid of the flawed or 
unwanted bits. 

Choose the best footage 

It is common to shoot far more footage than you actually need and choose only the best material for the final edit. Often you will shoot several 
versions (takes) of a shot and choose the best one when editing. 

Create a flow 

Most videos serve a purpose such as telling a story or providing information. Editing is a crucial step in making sure the video flows in a way 
which achieves this goal. 

Add effects, graphics, music, etc 

This is often the "wow" part of editing. You can improve most videos (and have a lot of fun) by adding extra elements. 

Alter the style, pace or mood of the video 

A good editor will be able to create subtle mood prompts in a video. Techniques such as mood music and visual effects can influence how the 
audience will react. 

Give the video a particular "angle" 

Video can be tailored to support a particular viewpoint, impart a message or serve an agenda. 

Different Types of Video Editing 

There are several different ways to edit video and each method has its pros and cons. Although most editors opt for digital non-linear editing for 
most projects, it makes sense to have an understanding of how each method works. 



This page provides a very brief overview of each method — we will cover them in more detail in other tutorials. 

Film Splicing 

 

Technically this isn't video editing, it's film editing. But it is worth a mention as it was the first way to edit moving pictures and conceptually it 
forms the basis of all video editing. 

Traditionally, film is edited by cutting sections of the film and rearranging or discarding them. The process is very straightforward and 
mechanical. In theory a film could be edited with a pair of scissors and some splicing tape, although in reality a splicing machine is the only 
practical solution. A splicing machine allows film footage to be lined up and held in place while it is cut or spliced together. 

Tape to Tape (Linear) 

Linear editing was the original method of editing electronic video tapes, before editing computers became available in the 1990s. Although it is 
no longer the preferred option, it is still used in some situations. 

 

https://www.mediacollege.com/video/editing/linear/


In linear editing, video is selectively copied from one tape to another. It requires at least two video machines connected together — one acts as 
the source and the other is the recorder. The basic procedure is quite simple: 

1. Place the video to be edited in the source machine and a blank tape in the recorder. 

2. Press play on the source machine and record on the recorder. 

The idea is to record only those parts of the source tape you want to keep. In this way desired footage is copied in the correct order from the 
original tape to a new tape. The new tape becomes the edited version. 

This method of editing is called "linear" because it must be done in a linear fashion; that is, starting with the first shot and working through to the 
last shot. If the editor changes their mind or notices a mistake, it is almost impossible to go back and re-edit an earlier part of the video. 
However, with a little practice, linear editing is relatively simple and trouble-free. 

Digital/Computer (Non-linear) 

 

In this method, video footage is recorded (captured) onto a computer hard drive and then edited using specialized software. Once the editing is 
complete, the finished product is recorded back to tape or optical disk. 

Non-linear editing has many significant advantages over linear editing. Most notably, it is a very flexible method which allows you to make 
changes to any part of the video at any time. This is why it's called "non-linear" — because you don't have to edit in a linear fashion. 

One of the most difficult aspects of non-linear digital video is the array of hardware and software options available. There are also several 
common video standards which are incompatible with each other, and setting up a robust editing system can be a challenge. 

https://www.mediacollege.com/video/editing/non-linear/


The effort is worth it. Although non-linear editing is more difficult to learn than linear, once you have mastered the basics you will be able to do 
much more, much faster. 

Live Editing 

In some situations multiple cameras and other video sources are routed through a central mixing console and edited in real time. Live television 
coverage is an example of live editing. 

Live editing is a fairly specialist topic and won't concern most people. 

Video Editing Terminology 

 

Capture Device: A hardware or firmware device used to convert analogue video into digital video. 

Compressors & Codecs: Software or firmware used to compress and decompress digital video. Compression makes the file size smaller. 

Editing: The process of rearranging, adding and/or removing sections of video clips. Also, creating transitions between clips. Editing is part of 
post-production. 

Encoding: The process of converting digital video into a particular format, for example, saving a video project in MGEG-2 format for DVD 
distribution. 

Layering: Adding multiple layers of superimposed video. 

Linear Editing: Also known as tape to tape editing. A method of editing in which footage is copied from one tape to another in the required 
order  

Non Linear Editing: An editing method which uses computer software to edit the footage  

Transition: The way one shot changes to the next  

Post Production: Everything that happens to the video and audio after production, i.e. after the footage has been shot. Post production 
includes video editing, audio editing, titling, colour correction, effects, etc. 



Premiere Pro Workspace: Overview 

The screenshot below shows the default workspace. This workspace can be customized in many ways — you can rearrange the panels and 
use specialist panels for different tasks (audio mixing, titles, etc). For now we will stick to the default workspace. 

 

https://www.mediacollege.com/adobe/premiere/pro/workspace/customize.html


 

 

 

The Project Panel 

 

 

Location of the Project Panel in the default editing workspace. 

The project panel is where you store all the elements needed to create your finished video. It can contain individual video clips, audio clips, 
titles, photos and graphical images. When you import new items they appear automatically in the project panel. 

The project panel also contains sequences, which include all the data in a particular timeline. When you create a new project, the project panel 
contains a single sequence called Sequence 01. 

 

Items in the Project Panel 

 A : Thumbnail viewer 

 B : Set poster frame 

 C : Play/Stop thumbnail 

 D : Bin (folder) 

 E : Media Items (video clips etc) 

 F : List view 

 G : Icon view 

 H : Automate to sequence 

 I : Find 



 J : New Bin 

 K : New Item 

 L : Delete Selected Items 

 M : Scrollbar (for media information) 

 N : Information about the selected item 

 

The Monitor Panels 

 

The monitor panels are where you view video clips and edited video sequences. 

The left screen is the source monitor, which allows you to preview clips and make adjustments before adding them to the timeline. 

The right screen is the program monitor, which shows you the active timeline. 

Controls under each monitor allow you to scroll through the video and set edit points. 

In the top right corner of the monitor panel is a fly-out menu containing numerous additional viewing options, including technical monitors. 

TVET SSP does not secure copyright of these pictures



 

 

 

 

 

TVET SSP does not secure copyright of these pictures



The Timeline Panel 

 

The timeline panel is where your video takes shape. By dragging items from the project panel or source monitor and placing them in the 
desired order, you create a sequence of clips and events which play in the timeline from left to right. 

With items in the timeline, you can: 

1. Adjust edit points, making clips shorter or longer, or stretch them over time. 

2. Create multiple layers of video, e.g. titles, superimposed images, etc. 

3. Create multiple layers of audio, e.g. voiceovers, music, etc. 

4. Add transitions, filters, special effects, etc. 

You can also create "nested" sequences to help keep the timeline manageable. 

When you have finished editing the timeline, you can play it back in real time or export it in a variety of formats. 

https://www.mediacollege.com/adobe/premiere/pro/workspace/project/
https://www.mediacollege.com/adobe/premiere/pro/workspace/monitor/


 

 

 

The Current Time Indicator 

The Current Time Indicator (CTI) is a blue triangular indicator which shows you where you are in the timeline. CTIs are used in several different 
panels. 

In the main timeline panel the CTI appears with a vertical red line overlaid on the sequence tracks, as illustrated below. This CTI is linked to 
the program monitor panel — the monitor shows the same frame as the CTI. When you play the sequence you'll see the CTI moving from left to 
right across the timeline. 

https://www.mediacollege.com/adobe/premiere/pro/workspace/timeline/
https://www.mediacollege.com/adobe/premiere/pro/workspace/monitor/


 

CTIs also appear in other panels including the Preview Monitor, Program Monitor and Effect Controls panel. 



 

Many tasks depend on the position of the CTI, for example: 

 Pasting clips into the sequence. 

 Adding markers to a clip or sequence. 

 Razor at Current Time Indicator (CTRL-K): This splits any unlocked clips at the point where the CTI is positioned. 

 

 



Other Common Panels in Premiere 

There are many more panels available in Premiere. Some of them are accessible by clicking tabs in the default panels, others can be found in 
the Window menu. Here are a few examples... 

 

Info Panel 

Provides information about the currently selected object. 



 

History Panel 

Displays a list of recently performed actions. Allows you to move back through multiple undo levels to 
previous versions. 

 

Audio Mixer 

Gives you control over the audio levels for individual tracks. Includes automation options. 



 

Effects Panel 

Drag video and audio effects and transitions from this panel to the timeline. Effects and transitions can 
then be modified with the effect control panel. 

 

Effect Controls 

Controls various parameters for each effect which has been applied to a clip. 



 

Reference Monitor 

A handy technical monitor for advanced users, giving you precise information about video clips. 

 

 

Adobe Premiere Tools Panel (Toolbox) 

The toolbox contains common tools used for editing clips in the timeline. Click on any of the buttons (or use the keyboard shortcuts) to 
select each tool. The default tool is the selection tool. 

When you select a tool the mouse pointer will usually change to a new icon to represent the tool when held over the timeline panel. In 
some cases you can change the behaviour of a tool by holding down a modifier key such as the Shift key. 

The tools are described below with links to more information. 

Button Keyboard 
Shortcut 

Description 

 

V Selection tool 
The default tool, used to select clips in the timeline. 

https://www.mediacollege.com/adobe/premiere/pro/workspace/timeline/
https://www.mediacollege.com/adobe/premiere/pro/tool/selection.html


 

M Track Select tool 
Select all clips on a track from a given point, or select multiple tracks. 

 

B Ripple Edit tool 
Adjust an edit point and move other clips in the timeline to compensate. 

 

N Rolling Edit tool 
Adjust an edit point between two clips without affecting the rest of the timeline. 

 

X Rate Stretch tool 
Change the duration of a clip while simultaneously changing the speed to compensate. 

 

C Razor tool 
Cut a clip (or multiple clips) into two clips. 

 

Y Slip tool 
Move a clip's in and out points by the same amount simultaneously, so the rest of the timeline is not affected. 

 

U Slide tool 
Move a clip back and forth in the timeline, while simultaneously adjusting adjacent clips to compensate. 

 

P Pen tool 
Create control (anchor) points. 

 

H Hand tool 
Drag the timeline view left and right. 

 

Z Zoom tool 
Click in the timeline to magnify the view, or drag and select a rectangular area to zoom into. 

Note: If you ever wonder why your mouse clicks are resulting in unusual behaviour, check the tools panel to see which tool is selected. 
Sometimes you can accidentally select the wrong tool, especially by inadvertently using a keyboard shortcut. 

Set project preset 

By default, Adobe Premiere Elements uses an AVCHD preset for the television standard you specify when you install the program. Select a 
new preset to create projects in a different format, television standard, or frame aspect ratio. 

The preset you select becomes the default, which is used for all new projects, until you select another preset. If you choose a preset 
temporarily, change it when you‘ve finished using it. 

https://www.mediacollege.com/adobe/premiere/pro/tool/track-select.html
https://www.mediacollege.com/adobe/premiere/pro/edit/ripple.html
https://www.mediacollege.com/adobe/premiere/pro/edit/rolling.html
https://www.mediacollege.com/adobe/premiere/pro/tool/rate-stretch.html
https://www.mediacollege.com/adobe/premiere/pro/tool/razor.html
https://www.mediacollege.com/adobe/premiere/pro/edit/slip.html
https://www.mediacollege.com/adobe/premiere/pro/edit/slide.html
https://www.mediacollege.com/adobe/premiere/pro/tool/hand.html
https://www.mediacollege.com/adobe/premiere/pro/tool/zoom.html


1. Start Adobe Premiere Elements. 

2. In the Welcome screen, click Video Editor, and then click New Project. (Or, choose File > New > Project.) 
3. In the New Project dialog box, click Change Settings. 
4. Select the preset that matches the format and standard of the footage you want to edit. 

5. Click OK. 
6. Provide a name and location for your project, and click OK. 

 

Change settings for an existing project 

After you create a project, you can only make minor display-related changes to the project settings. 

1. Choose Edit > Project Settings > General. 

2. In the Project Settings dialog box, specify project settings for General, Capture, and Video Rendering. 
3. Click OK. 

Check your project settings 

Project presets include project settings under three categories: General, Capture, and Video Rendering. After you start a project, you can‘t 
change most of the settings, such as frame rate, size, and aspect ratio. However, you can review the settings to ensure that the media you 
want to add to the project is compatible. 

1. Open the project in Premiere Elements, and choose Edit > Project Settings > [category]. 

NTSC vs PAL presets 

NTSC presets conform to the NTSC standard, where each video frame includes 525 horizontal lines displayed at 29.97 frames per second. The 
Standard NTSC preset applies to footage that has a 4:3 aspect ratio. The Widescreen NTSC preset applies to footage that has a 16:9 aspect 
ratio. 

PAL presets conform to the PAL standard, where each video frame includes 625 lines displayed at 25 frames per second. 



General settings 

General settings (Edit > Project Settings > General) control the fundamental characteristics of a project. They include the editing mode used to 
process video, frame size, aspect ratios, count time (Display Format), and playback settings (Timebase). These settings match the most 
common source media in your project. For example, if most of your footage is DV, use the DV Playback editing mode. The quality of your video 
can deteriorate if you change these settings arbitrarily. 

General settings include the following options. 

Editing Mode 

Identifies the television standard and format for the project. You cannot change the Timebase, Frame Size, Pixel Aspect Ratio, Fields, and 
Sample Rate preview settings. The editing mode determines these settings. 

  

Note: The Editing Mode setting represents the specifications of the source media, not the final output settings. Specify output settings when 
you export a project. 
Timebase 

Specifies the time divisions used to calculate the time position of each edit (PAL: 25, NTSC: 29.97). 

Playback Settings 

This button is available if you use a DV preset, a DV editing mode, or install a plug-in that provides additional playback functions. For a DV 
editing mode, this option indicates where you want your previews to play. For information on the playback settings for third-party plug-ins, see 
the developer documentation. 

Frame Size 

Specifies the frame pixels for your project playback. In most cases, the frame size for your project matches the frame size of your source 
media. You can‘t change the frame size to compensate for slow playback. However, you can adjust the playback settings: Right-click/ctrl-click 
the monitor and choose Playback Settings. Adjust the frame size of the output by changing the Export settings. 

Pixel Aspect Ratio 

Sets the aspect ratio for pixels. The video format (PAL or NTSC) determines this ratio. If you use a pixel aspect ratio that is different from your 
video, the video can appear distorted when you render it and play. 

Fields 



Specifies the field dominance, or the order in which the two interlaced fields of each frame are drawn. 

Display Format (video) 

Specifies the way time appears throughout the project. The time display options correspond to standards for editing video and motion-picture 
film. For DV NTSC video, choose 30-fps Drop-Frame Timecode. For DV PAL video, choose 25-fps Timecode. 

Title Safe Area 

Specifies the frame edge area to mark as a safe zone for titles, so that titles aren‘t cut off by TVs that zoom the picture. A rectangle with 
crosshairs marks the title-safe zone when you click the Safe Zones button in the monitor. Titles require a wider safe zone than action. 

Action Safe Area 

Specifies the frame edge area to mark as a safe zone for action so that TVs that zoom the picture do not exclude the action. A rectangle marks 
the action-safe zone when you click the Safe Zones button in the monitor. 

Sample Rate 

Identifies the audio sample rate for the project preset. In general, higher rates provide better audio quality in projects, but they require more disk 
space and processing. Record audio at a high-quality sample rate, and capture audio at the rate at which it was recorded. 

Display Format (audio) 

Specifies whether audio time display is measured by using audio samples or milliseconds. By default, time is displayed in audio samples. 
However, you can display time in milliseconds for sample-level precision when you are editing audio. 

Capture settings 

Capture settings (Edit > Project Settings > Capture) control how video and audio are transferred directly from a deck. (Other Project 
Settingspanels do not affect capturing.) 

Video Rendering settings 

Video Rendering settings control the picture quality, compression settings, and color depth that Premiere Elements uses when you play video 
from the Expert view timeline. 

To access Video Rendering settings, choose Edit > Project Settings > Video Render. These settings include the following options: 



Maximum Bit Depth 

Allows Premiere Elements to use up to 32-bit processing, even if the project uses a lower bit depth. Selecting this option increases precision 
but decreases performance. 

File Format 

Specifies the format of the preview video. 

Compressor 
Identifies the codec (compressor/decompressor) that Premiere Elements applies to generate movie previews. The project preset defines the 
codec. You cannot change it because it must conform to the DV standard. 
Note: If you don’t apply effects to your clip or change its frame/time characteristics, Adobe Premiere Elements uses the clip’s original codec for 
playback. If your changes necessitate frame recalculation, Adobe Premiere Elements applies the codec identified here. 

  

  

Optimize Stills 

Select this option to use still images efficiently in projects. For example, you can use an image that has a duration of 2 seconds in a 30-fps 
project. Premiere Elements creates a 2-second frame instead of 60 frames, each with a duration of 1/30 second. Deselect this option if projects 
encounter playback problems when displaying still images. 

 

 

 

 

 

 

For more detailed information, please visit: https://www.mediacollege.com/adobe/premiere/pro/workspace/project/ 

Also Visit: https://helpx.adobe.com/premiere-elements/using/project-settings-presets.html 

 

Import 

https://www.mediacollege.com/adobe/premiere/pro/workspace/project/
https://helpx.adobe.com/premiere-elements/using/project-settings-presets.html


Premiere Pro allows you to import a single video clip, multiple clips, or an entire folder of clips. You can also import a 
variety of audio and still image files, including sequences of images and layered Photoshop files. 

To bring up the import window, use one of these methods: 

1. Select File > Import from the main menu. 

2. Keyboard shortcut Ctrl+I (Windows), Cmd+I (Mac). 

3. Double-click inside the Project Panel. 

Once the import window is open... 

 To import a single file: Locate and select the file, then click Open. 

 To import multiple files: Hold down the Control key to select multiple files, then click Open. 

 To import a folder of files: Locate and select the folder you want to import, then click Folder. A new bin is created in 

the Project window, containing the contents of the folder. 

Note: You can also import files by dragging them from Windows Explorer into the Premiere Pro Project Panel. 

 

Supported Formats (CS5) 

Video & animation formats 
3GP, 3G2; ASF (Netshow, Windows only); AVI (DV-AVI, Microsoft AVI Type 1 and Type 2); DLX (Sony VDU File Format Importer, Windows 
only); DPX; DV (raw DV stream, a QuickTime format); FLV and F4V (excluding video encoded with the Sorenson Spark video codec); GIF 
(Animated GIF); M1V (MPEG-1 Video File); M2T (Sony HDV); M2TS (Blu-ray BDAV MPEG-2 Transport Stream, AVCHD); M4V (MPEG-4 
Video File); MOV (QuickTime Movie; in Windows, requires QuickTime player); MP4 (QuickTime Movie, XDCAM EX); MPEG, MPE, MPG 
(MPEG-1, MPEG-2), M2V (DVD-compliant MPEG-2); MTS (AVCHD); MXF (Media eXchange Format; P2 Movie: Panasonic Op-Atom variant of 
MXF, with video in DV, DVCPRO, DVCPRO 50, DVCPRO HD, AVC-Intra; XDCAM HD Movie, Sony XDCAM HD 50 (4:2:2), Avid MXF Movie); 
R3D (RED camera); SWF; VOB; WMV (Windows Media, Windows only) 

Audio formats 
; AAC; AC3 (including 5.1 surround); AIFF, AIF; ASND (Adobe Sound Document); AVI (Video for Windows); M4A (MPEG-4 Audio); MP3 (MP3 
Audio); MPEG, MPG (MPEG Movie); MOV (QuickTime; requires QuickTime player); MXF (Media eXchange Format; P2 Movie: Panasonic Op-

https://www.mediacollege.com/adobe/premiere/pro/import/audio.html
https://www.mediacollege.com/adobe/premiere/pro/import/psd.html
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Atom variant of MXF, with video in DV, DVCPRO, DVCPRO 50, DVCPRO HD, AVC-Intra; XDCAM HD Movie, Sony XDCAM HD 50 (4:2:2), 
Avid MXF Movie); WMA (Windows Media Audio, Windows only); WAV (Windows WAVeform) 

Still-image formats 
AI, EPS; BMP, DIB, RLE; EPS; GIF; ICO (Icon File) (Windows only); JPEG (JPE, JPG, JFIF); PICT; PNG; PSD; PSQ (Adobe Premiere 6 
Storyboard); PTL, PRTL (Adobe Premiere title); TGA, ICB, VDA, VST; TIF 

Project/EDL formats 
AAF (Advanced Authoring Format); AEP, AEPX (After Effects project); CSV, PBL, TXT, TAB (batch lists); EDL (CMX3600 EDLs); PLB (Adobe 
Premiere 6.x bin) (Windows only); PPJ (Adobe Premiere 6.x project) (Windows only); PREL (Adobe Premiere Elements project) (Windows 
only); PRPROJ (Premiere Pro project); PSQ (Adobe Premiere 6.x storyboard) (Windows only); XML (FCP XML) 

Notes: 

 If an imported clip appears distorted or stretched, its pixel aspect ratio may be set incorrectly. 

 Support for some file formats relies on third-party plug-ins or other software, e.g. Apple QuickTime 

 

 

 

 
Import PSD Files into Adobe Premiere 

 

Select File > Import from the main menu. Locate and select the PSD file, then 
click Open. 

A window will appear like the one pictured. There are three choices to make: 

Import As 

 Footage: A single image repeated for the duration of the clip. 

 Sequence: The file's layers are converted to a sequence of frames. These 

appear as separate clips in a new bin. 



Layer Options 

 Merged Layers: All layers are merged into a single image. 

 Choose Layer: Select the name of a specific layer in the PSD file — only this layer will be imported. 

Footage Dimensions 

 Document Size: Resizes the PSD file to the size of the current project (as specified in Project > Project Settings). 

 Layer Size: Keeps the original size of the PSD file (or selected layer). 

 

Notes: 

 For information about how layers work, see Photoshop Layers. 

 Wherever possible, it's a good idea to create PSD files the same pixel size as the Premiere project. 

 The pixel size of the PSD file cannot exceed 4000 x 4000 pixels. 

 Most attributes applied in Photoshop will carry over to Premiere, e.g. position, opacity, visibility, transparency, etc. 

 
Import Audio Files into Adobe Premiere 

How to import digital audio files into Adobe Premiere Pro. Any of the following formats can be imported directly: AIFF, AVI, MOV, MP3, WAV, 
WMA. 

Select File > Import from the main menu. Locate and select the audio file, then click Open. The file will be immediately added to the Project 
window. 

Conforming Audio 

When you import an audio file, Adobe Premiere conforms (converts) the file to the project's audio sample rate at 32-bit quality. This provides 
maximum quality and editing flexibility, and ensures that all audio in the project is consistent. As the audio is being conformed a progress 
message appears in the status bar like so: 

 

https://www.mediacollege.com/adobe/photoshop/layers/


This can cause a slight delay when importing audio files, but once the conversion has been done, no more conforming is required during 
editing. 

Conformed files are stored in a folder called "Conformed Audio Files". To specify where this folder is located, see Edit > Preferences > 
Scratch Disks. We recommend using the same location as the project, to keep all the files together. 

If you happen to delete or lose the conformed files it doesn't matter — they will be automatically recreated when Premiere realises they are 
missing. 

For more detailed information, please visit: https://www.mediacollege.com/adobe/premiere/pro/import/ 

Also Visit: https://helpx.adobe.com/premiere-elements/using/superimposing-transparency.html 

 

 

 

 

 

Set Sequence  

 A Clip is either the entirety of the footage of or a selection of footage from a single video and/or audio file (stills, titles and special 
generated footage like Premiere's bars and tone also act like clips). To edit, you define, place and manipulate clips on a Sequence. 
 

 A Sequence is a workspace where you lay out clips, have multiple video and audio tracks, and generally do the bulk of your editing. 
You can have multiple Sequences in the same project. In some other editing programs, this is called a timeline, although that term 
can also refer to just the part of the interface that displays this workspace. 

 

Premiere Pro allows you to specify the settings for each sequence, trim clips, and assemble clips in sequences. 

Every Premiere Pro project can contain one or more sequences, and each sequence in a project can have different settings. You can assemble 
and rearrange sequences in one or more Timeline panels, where their clips, transitions, and effects are represented graphically. A sequence 
can consist of multiple video and audio tracks running parallel in a Timeline panel. Multiple tracks are used to superimpose or mix clips. 

https://www.mediacollege.com/adobe/premiere/pro/import/
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A sequence must contain at least one video track and one audio track. Sequences with audio tracks must also contain a master audio track, 
where the output of regular audio tracks is directed for mixing. Multiple audio tracks are used to mix audio 

Timeline panels  

A single Timeline panel appears in a frame in the lower central portion of the screen when you launch Premiere Pro. You can open any of its 
default workspaces, or create a project. You can remove all sequences from a Timeline panel, or add multiple sequences to it. Each sequence 
appears as a tab within that Timeline panel. You can also open multiple Timeline panels, each within its own frame, with each containing any 
number of sequences. 

You can show or hide items by selecting, or deselecting them in the Timeline panel menu. These items include: time ruler numbers, and the 
work area bar. 

Open a sequence in a Timeline panel 

To open a new sequence in a timeline panel, double click the sequence in the Project Panel. The sequence opens in a new tab in the Timeline 
panel. 

Creating Sequences 

The world revolves around sequences. At least, it does in Premiere Pro. It is where you are do your editing. It is where you put together your 
video 

What you cannot do is change a sequence's preset once it is created. For that reason, you are want to set it up right the first time. Otherwise, 

you are have to copy and paste edited clips into a correct sequence. Although it is not hard to do, it takes up time that you could spend doing 

other editing tasks. 



That said, you want to remember these three "rules" when you apply a preset to your sequence. Generally, in order to get things "just right," 

you should choose one of these rules to follow when choosing a preset. 

1.     The sequence preset should match the bulk of your source footage. This is the most commonly followed rule. 

2.     Your preset should match your target output.  

3.     Your sequence should match your project size. For example, for 640x360 videos, create a 640x360 preset. 

Now that we have covered the three rules, let's teach you how to create the presets for those rules. 

Matching Source Footage 

To create a preset that matches your source footage, drag the footage to the New Item button.  



 

Premiere Pro will create a sequence in the Timeline that has the same name as the footage. 

 

Click OK. 



Selecting a Sequence Preset 

To select a sequence preset, start out by creating the sequence.  

To do this, click the New Item button in the Project panel and select Sequence.  

 

You can also go to File>New>Sequence. 

You will then see the New Sequence dialogue box. 



 

 

About Sequence Settings 

To check the settings for your sequence, right click on the sequence in the Project panel. 

Select Sequence Settings. 

You will then see the Sequence Settings dialogue box. 



 

Some of the fields in the Audio and Video sections will not be active for you, so you cannot change them. However, you can change how the 

format is displayed in the sequence. 
For more detailed information, please visit: https://www.universalclass.com/articles/computers/adobe/premiere/how-to-create-
sequences.htm 

Also Visit: https://www.premiumbeat.com/blog/nesting-in-adobe-premiere-pro/ 

And: https://helpx.adobe.com/premiere-pro/using/creating-changing-sequences.html 
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Balance Audio 

Link/Unlink Sound and Video in Adobe Premiere 

Linking video and audio clips means that they become locked together and act as one. For example, when you move or trim one clip the other 
will be affected as well. Unlink the files to make them separate. 

Link Files 

Left-click the video track, hold down your Shift key and click the audio track so both are selected. Right-click either clip and select Link Audio 
and Video, like so: 

 

Note: If a video/audio pair is unlinked, moved out of synch and then re-linked, as number shows at the inpoint to show how far out of synch the 
files are (see the example below). 

Unlink Files 

Right-click either the video or audio track and select Unlink Audio and Video, like so: 



 

 

Synchronizing Sound and Video in Adobe Premiere 

Synchronizing sound and video clips is required to perform any of these tasks: 

 Add a new sound effect to an existing video clip. 

 Synchronize a music track with video. 

 Synchronize a sound recording which was recorded separately to the video. 

 Repair a clip in which the sound and video have drifted apart. 

In theory the process is fairly straightforward — you just need to move the audio track relative to the video track until synch is achieved. 

Note: If you have a single file containing both the audio and video, you will need to separate them first. See unlinking audio and video. 

Place the audio and video clips on the timeline roughly where they need to be in relation to each other like so: 

https://www.mediacollege.com/adobe/premiere/pro/audio/linking.html


 

From here all you need to do is drag the audio clip left or right until it matches the video. Start by getting it approximately right (preview the 
project to see how it's going), then zoom in closer on the timeline to get finer control. To get perfect synch you will want to zoom right in to 
single-frame view. 

Once the clips are correctly aligned, you might want to link them together to avoid accidentally losing synch. Left-click the video track, hold 
down your Shift key and click the audio track so both are selected. Right-click either clip and select Link Audio and Video, like so: 

 



 

Helpful Tips 

To make synchronization easier, try to find a part of the audio/video which has a sudden sharp noise with a corresponding image. This is what 
a clapper board is used for — it provides a clear visual reference with a sudden burst of sound. 

 

You may find markers useful to identify reference points in the clip. Marker points show up in the timeline as white makers (pictured right) which 
can help you to align elements of the video. 

If the sound and video were recorded separately, it's possible that they will drift apart over time. This can happen if the recording mechanisms 
have slightly different record/playback speeds. In this case you will need to adjust the speed of the audio or video slightly to compensate. 

Premiere Audio Mixer 

The audio mixer in Adobe Premiere is designed to be a visual representation of a real sound mixer. It features familiar sliders (faders) for each 
audio channel (track), sub-mixes and a master fader. The window width can expand to accommodate all the channels in the timeline. 

The mixer window does not appear in any of the default workspaces except Audio. For this reason many new Premiere users are not even 
aware of it's existence. 

To view the audio mixer select Window > Audio Mixer from the menu. 

 

https://www.mediacollege.com/adobe/premiere/pro/speed-duration/
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The audio mixer is basically another way to do the same things which can be done with audio keyframes and other tools. Whether or not you 
use the mixer depends on your preference. Because the mixer window takes up quite a bit of room, many users choose not to use it. 

However, even if you don't use the mixer for it's functionality, it is a very good visual metering tool and you will probably find it helpful to keep an 
eye on audio levels this way. If you don't have enough screen space for the mixer window, you can use the master meters only option. 

What Exactly Does the Mixer Do? 

The mixer window has a number of functions, including: 

 Adjust levels of individual tracks during playback (for monitoring only) 

 Adjust levels of individual tracks and save the new settings (known as automation) 

 Use effects/send channels 

 Pan tracks left and right 

 Set up submixes 

 Solo and mute individual tracks 

 Control playback of the timeline 

 Record input sources directly to audio tracks 

 

Adjusting Volume of the Music Bed 

Often you need to vary the volume level of your music track. For example, it's common to have the music playing at normal volume and then 
reduce the volume when someone is speaking. When the speaking finishes, the volume is returned to normal level. 

Let's begin with an audio timeline containing two tracks—a voiceover and a music track. Initially they are both at a constant volume as shown 
by the yellow lines: 

Do You Need the Audio Mixer?

https://www.mediacollege.com/adobe/premiere/pro/audio/mixer-master-meters.html


 

The next step is to create some keyframes so you can vary the volume over time. Ctrl-click on the yellow volume line to create keyframes. 
You'll need four keyframes, the first two will be where you want the volume to decrease (as the talking starts), the second two will be where the 
volume increases back to normal (as the talking ends). You don't need to get the keyframe positions exactly right yet but they should look 
similar to this: 

 

Finally, click and drag the middle section of the yellow line down. This creates an area with a lower volume level like so: 

 



So what we have is a music track at normal volume until it reaches the first keyframe. The volume drops until it reaches the second keyframe. 
The volume stays at the lower level until it reaches the third keyframe, where it increases until it reaches the last keyframe and the original 
audio level. Drag the middle section of the yellow line up and down until you have the desired volume. 

From here you will probably want to tweak the exact positions of the keyframes so that the music fades down and up nicely, just as the talking 
comes in and out. You can click and drag each keyframe marker left, right, up and down to do this. 

Adobe Premiere Balance Effect 

The balance effect allows you to adjust the balance between the left and right channels in stereo 
audio clips. The effect can be found in the effects window, under Audio Effects > Stereo > 
Balance. To apply this effect, select the appropriate clip in the timeline and drag the effect onto 
the clip (or drag the effect into the Effect Controls window). 

Once the effect has been applied, expand it in the Effect Controls window. Drag the slider left 
and right to increase the relative volume of the corresponding channel. 

 

Adobe Premiere DeNoiser Effect 

The denoiser effect provides an easy way to remove background tape noise commonly found in older 
analog tape formats. This noise takes the form of a slight hiss. 

The denoiser effect can be found in the effects window, under Audio Effects > Stereo > DeNoiser or 
the equivalent effect in the 5.1 and Mono folders. To apply this effect, select the appropriate clip in the 
timeline and drag the effect onto the clip (or drag the effect into the Effect Controls window). 

Once the effect has been applied, expand it in the Effect Controls window. There are two ways to adjust 
the settings: Custom Setup and Individual Parameters. The screenshot on the right shows the custom 
setup option. 

White line: Audio spectrum. 
Yellow line: Noise floor. 
Green line: Offset setting. 

https://www.mediacollege.com/adobe/premiere/pro/effects/
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Click and drag your mouse in this window to see precise units. 

Noise floor 
The level of the noise floor in decibels. As the clip plays, Premiere constantly re-estimates this value. 

Freeze 
At any time when the clip is playing, click this box to stop the noise floor estimation at the current value. This is useful if the unwanted noise 
varies greatly or is intermittent. 

Reduction 
The amount of noise reduction in decibels, from -20dB to 0 dB. 

Offset 
A value in decibels to add or subtract from the automatically estimated noise floor value. This allows you to be more precise if the automatic 
estimation is not accurate enough. The allowed range is -10dB to +10 dB. 

 

For more detailed information, please visit: https://www.mediacollege.com/adobe/premiere/pro/audio/balance.html 

Also Visit: https://www.mediacollege.com/adobe/premiere/pro/audio/synchronize.html 

 

Color Correction and Color Grading 

Before making any edits, it‘s important to clarify the difference between Color Correction and Color Grading. 

Color correction is the process of ―balancing‖ an image. This involves increasing or decreasing the exposure, contrast, and shadows, to 
reproduce what your eye expects to see, and what the scene actually looked like. While there can be some artistic choices made at this stage, 
it‘s about reproducing the scene as it looked in real life, and producing a nice image. 

https://www.mediacollege.com/adobe/premiere/pro/audio/balance.html
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Color grading is usually performed after color correction. This involves changing the colors to something different. Films like The Matrix have a 
green tint, and many Hollywood blockbusters use a teal and orange grade. Color grading is as much about artistic choices as technical 
accuracy. 

This tutorial will focus on the basics of color correction, although some of these tips will also apply to color grading. 

The Lumetri Color tool is one of the most common ways to color correct footage in Adobe Premiere Pro. While there are other methods, along 
with different tools available in other video-editing packages, the basic concepts are the same regardless of your choice of tool. 

Open the Lumetri Color panel by going to Window > Lumetri Color. Alternatively, you can go to Window > Workspaces > Color, to open 
the Color Workspace, which contains various different tools for analyzing and adjusting colors in video. 

 



On your timeline, select the clip you want to start color correcting. The Lumetri Color tool will change from grayed out to colored, indicating that 
it‘s ready to use. 

 

The Lumetri Color tool contains six tabs, each one containing tools for a specific color correction task. These are: 

1. Basic Correction: Tools for balancing the image, and correcting under or over-exposure, white balance, contrast, and saturation. 
2. Creative: Tools for working with LUTs, film grain effects, and color tint. 
3. Curves: Tools for adjusting hue, saturation, and contrast for specific colors or the whole image. 
4. Color Wheels & Match: Individual tools for adjusting shadows, midtones, and highlights. 
5. HSL Secondary: Tools for working with hue, saturation, and luminance. 
6. Vignette: Tools for adding a vignette. 
7.  

Here‘s the footage we‘ll be working with. It‘s a close-up shot of somebody playing the guitar at a live music event: 



 

Let‘s dig into the tools found in the Basic Correction tab. 



 

Handy Tip: when making any adjustments using the Lumetri Color panel, double-click a slider to reset it to its default value. 

The first tool is Input LUT. We‘ve discussed LUTs previously, and they are essentially the same as Instagram filters. You won‘t need to use 
any LUTs when learning the basics—they can sometimes cause more problems than they solve. 

Moving on to White Balance. Here you can adjust the temperature and tint of the white balance. You can ―cool things down‖ by adding more 
blue to the image (temperature slider to the left). You can ―warm things up‖ by moving the temperature slider to the right (which in turn adds 
more orange). 

By using the WB Selector, you can choose a point in your video which should be white, and Premiere Pro will attempt to guess the correct 
white balance settings. This isn‘t perfect, but it can be a good starting point. 

Here‘s the example image after correcting the white balance. It‘s not finished yet, but it already looks a lot better: 



 

Underneath white balance is the Tone section. This contains controls for contrast, exposure, highlights, shadows, and more. At the bottom right 
of these controls is a button labeled Auto. By pressing this button, Premiere Pro will attempt to color correct your footage for you. It doesn‘t 
always do a great job, but it can be a good starting point. 

Here‘s our example image after pressing the auto button: 



 

While this image has improved in some areas, the auto button has raised some new issues. Here‘s what the Lumetri sliders look like now: 



 

Premiere Pro has boosted the Exposure and Whites sliders, while making minor reductions to all the other sliders. 

With each slider, moving to the right will increase the effect of that particular area, and moving to the right will decrease the effect. Here‘s what 
they all do: 

1. Exposure: Brightens or darkens the whole image. 
2. Contrast: Add or remove contrast. 
3. Highlights: Brighten or darken only the highlights. 
4. Shadows: Brighten or darken only the shadows. 
5. Whites: Increase or decrease the intensity of any white pixels. 
6. Blacks: Increse or decrease the intensity of any black pixels. 
7. HDR Specular: Not available unless working with high dynamic range (HDR) footage. 

By reducing the white level, and increasing the contrast, the image looks much better: 



 

While each video is different, the best way to learn is by experimenting. Press the auto button, move the sliders to their maximum and minimum 
levels and take note of what happens. By increasing or decreasing the level of the shadows, for example, it‘s possible to brighten or darken 
your video. 

The final control under the Tone section is Saturation. Saturation alters the intensity of the colors in an image. By moving this all the way to the 
left, the image will become black and white. All the way to the right, and it will become saturated. Colors will look unrealistic and fake. 



Like many adjustments, small changes can make a big difference. There‘s no need to make big extreme changes. The colors in the example 
shot are quite bright and vivid, so a slight reduction of saturation by 10 percent is enough to improve the shot: 

 

For more detailed information, please visit: https://www.makeuseof.com/tag/best-podcast-microphone/ 
Also Visit: https://www.colorgradingcentral.com/color-correction-premiere-pro 
And: https://helpx.adobe.com/premiere-pro/using/color-correction-adjustment.html 
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Prepare Roughcut  

Keyframes in Adobe Premiere 

Keyframes are used to change the properties of a video or audio effect over time. Almost any effect can use keyframes; for example, volume, 
opacity, scale, position, colour balance, etc. 

The idea is to create more than one keyframe, then set the desired effect values at each keyframe. Premiere will create a gradual change in 
values between keyframes (this is known as interpolation). For example, you could create a keyframe where the volume is -20dB and another 
keyframe 5 seconds later where the volume is 0dB. Premiere will interpolate this to create a smooth five-second volume increase. 

There are two ways to view and work with keyframes: In the Timeline and in the Effect Controls window. 

The Timeline 

Keyframes can be displayed in the timeline when a video track is expanded. A line is shown with small diamonds marking the keyframes like 
so: 

 

This is a relatively easy, intuitive way to view and manipulate keyframes. On the downside, keyframes can only be shown for one effect at a 
time and control is not as precise as using the Effects Control window. 

For more information see Keyframes in the Timeline. 

The Effects Control Window 

For full control over keyframes, select the clip in the Timeline and open the Effects Control window (Window > Effect Controls). 

https://www.mediacollege.com/adobe/premiere/pro/effects/
https://www.mediacollege.com/adobe/premiere/pro/keyframes/timeline.html


 

The right-hand side of the window is a miniature timeline, just for the selected clip, which shows keyframes as diamond icons. Although it takes 
a little getting used to, this view allows you to see keyframes for all effects at once and provides excellent control. 

Types of Edit in Adobe Premiere 

Rolling Edit  

 

Adjust an edit point between two clips without affecting the rest of the timeline. 

Ripple Edit  

 

Adjust an edit point and move the rest of the timeline to compensate. 

Slip Edit  

 

Adjust a clip's in-point and out-point simultaneously, while keeping the clip in the same place on the timeline. 

Slide Edit  

 

Move a clip left or right along the timeline, causing other clips to be adjusted accordingly. 

 

https://www.mediacollege.com/adobe/premiere/pro/edit/rolling.html
https://www.mediacollege.com/adobe/premiere/pro/edit/ripple.html
https://www.mediacollege.com/adobe/premiere/pro/edit/slip.html
https://www.mediacollege.com/adobe/premiere/pro/edit/slide.html


Adobe Premiere Rolling Edit 

A rolling edit means moving an edit point without affecting the rest of the timeline. The first (outgoing) clip is made shorter while the second 
(incoming) clip is made longer by the same amount, or vice versa. The net effect is that the overall length of the program is not altered. 

To perform a rolling edit, select the rolling edit tool (pictured right) from the tool panel. Position the mouse at the edit point in the timeline 
and drag left or right. 

In the following example, the first timeline shows the original edit. In the second timeline, the edit point between clip 2 and clip 3 has been 
moved further down the timeline. In other words, the out-point of clip 2 and the in-point of clip 3 have both been advanced the same amount. 

 

 

 

Adobe Premiere Ripple Edit 

A ripple edit means moving an edit point and causing the rest of the timeline to move the same amount to compensate. 

To perform a ripple edit, select the ripple edit tool (pictured right) from the tool panel. Position the mouse at the edit point in the timeline 
and drag left or right. 

In the following example, the first timeline shows the original edit. In the second timeline, the edit point between clips 2 and 3 has been 
advanced with a ripple edit. The remaining clips are advanced the same amount, increasing the length of the timeline. 



 

 

Adobe Premiere Slip Edit 

A slip edit means adjusting the in and out points of a clip simultaneously by the same amount in the same direction. The duration of the clip 
stays the same. 

To perform a slip edit, select the slip edit tool (pictured right) from the tool panel. Position the mouse over the clip in the timeline, click and 
drag left or right. 

In the example below, the first timeline shows three clips in a sequence. In the second timeline, clip 2 has been adjusted with a slip edit. Note 
how the in-point and out-point have both been advanced by the same amount while the rest of the timeline remains unaffected. 



 

Adobe Premiere Slide Edit 

A slide edit means moving a clip left or right in the timeline while simultaneously adjusting other clips to compensate. The duration of the target 
clip stays the same, the durations of clips either side are automatically reduced or increased as required. 

To perform a slide edit, select the slide edit tool (pictured right) from the tool panel. Position the mouse over the clip in the timeline, click 
and drag left or right. 

In the example below, the first timeline shows three clips in a sequence. In the second timeline, clip 2 has been moved with a slide edit. Note 
how clips 2's in-point and out-point stay the same, clip 1's out-point is moved forward and clip 3's in-point is moved back. 



 

 

Opacity in Adobe Premiere Pro 

 

This page shows you how to adjust the video opacity settings in Adobe Premiere to create various transparency and overlay effects. 

Notes: 

 This page shows how to set the opacity uniformly for a whole clip. The next page will show how to change opacity over time. 

 If you want to create a simple fade between clips or to black, a Cross Dissolve transition is easier than adjusting the opacity. 

https://www.mediacollege.com/adobe/premiere/pro/opacity/animation.html


 
Setting the Opacity of a Clip 

Every video track in a Premiere project has an opacity setting. By default this is 100%, i.e. completely opaque (visible). As you reduce the 
opacity of a track, it becomes more transparent and the track below becomes more visible. If there is no underlying track, the black background 
becomes visible. 

The example below uses two video clips — a shot of a house and a shot of a person (Dave). The "House" clip is on Video Track 1 and the 
"Dave" clip is on Video Track 2: 

 

At this stage both tracks are 100% opaque, so you only see the top one (Dave). We need to reduce Dave's opacity to see the house 
underneath. There are two ways to do this: 

1. Use the Effects Controls panel in the monitor window. 

2. Use the opacity handles in the timeline window. 
(1) The Effects Control Window 

 Select the "Dave" clip in the Timeline window. 

 Select the Effects Controls tab in the Monitor window. 

 Click the triangle next to the Opacity property to expand it. 

 Either click the opacity value and enter a new value, or drag the slider. 

https://www.mediacollege.com/adobe/premiere/pro/workspace/monitor/
https://www.mediacollege.com/adobe/premiere/pro/workspace/timeline/


 

(2) Opacity Handles 

 In the timeline, expand the Video 2 track view if necessary (click the triangle next to the track name so it points down). 

 Click the Show Keyframes button , then choose Show Opacity Handles from the fly-out menu. A yellow line will appear on the clip 

indicating the opacity level. 

 Select the Pen tool  and drag the yellow line up or down to increase or reduce opacity. 

 

 



 

The example on the right shows the opacity set to 30%. 

Remember, at this stage the opacity is a constant 30% for the duration of the clip. If you want the opacity to change during the clip, proceed to 
the next page... 

Adobe Premiere Trim Monitor 

The trim monitor looks similar to the source and program monitors — the 
difference is that it includes a specialized set of controls to fine-tune the edit 
between two shots. It doesn't actually do anything that can't be done with the 
timeline, source and program monitors, but it can make this type of adjustment 
easier. 

The left image view shows the last frame of the first (outgoing) clip. The right view 
shows the first frame of the second (incoming) clip. The controls allow you to add or 
remove frames from each clip and preview the transition. 

To open the trim panel, move the CTI to the edit point in the timeline and use one of 
these options: 

 Click the trim button below the program monitor (pictured right) 

 Click the panel menu button on the program monitor, then select Trim 

 Keyboard shortcut: Ctrl-T 

https://www.mediacollege.com/adobe/premiere/pro/workspace/current-time-indicator.html


There are various ways to trim frames using different controls in the trim monitor... 

Image Views 

Hold your mouse over one of the image views. The cursor will change to the trim-in or trim-out icon. Click the view to make it active — a cyan 
bar will appear above and below the image. Drag left and right to add/remove frames in a ripple edit. 

If you click and drag in the middle of the two monitors the cursor changes to a rolling edit icon and both monitors become active. Drag to 
perform a rolling edit. 

Timecode Displays 

There are five timecode displays below the image views. The outer displays (in black) show the duration of each clip. The centre three displays 
(in blue) can be dragged to perform edits. 

The left display adjusts the outpoint of the first clip, the right display adjusts the in-point of the second clip (both as a ripple edit). The centre 
display adjusts both points in a rolling edit. 

Time Rulers 

Click and drag the ingoing/outgoing point handles in the time ruler below each monitor. 

Shift Displays 

Click and drag the Out Shift and In Shift displays to a perform ripple edit on the left or right view. 

Click the - and + buttons to a perform ripple edit on the active view. You can also enter a positive or negative number in the box. 

Jog Disks 

Use the jog controls at the bottom of the panel. The left and right disks perform ripple edits, the middle jog performs a rolling edit. 

Keyboard Shortcuts 

Ctrl + t Open trim panel 

Alt + 1 Focus on both Outgoing and Incoming sides 

Alt + 3 Focus on Incoming side 

https://www.mediacollege.com/adobe/premiere/pro/edit/ripple.html
https://www.mediacollege.com/adobe/premiere/pro/edit/rolling.html


Alt + 2 Focus on Outgoing side 

Alt + Shift + Left Arrow Trim backward by large trim offset 

Alt + Left Arrow Trim backward by one frame 

Alt + Shift + Right Arrow Trim forward by large trim offset 

Alt + Right Arrow Trim forward by one frame 

 

How to split a clip, then apply a transition 

In this tutorial we will take a single video clip consisting of two or more shots, split the clip into the individual shots and apply 
a transition between them. We'll use a cross dissolve but the same instructions apply to any transition. Our example begins with a single clip on 
the timeline consisting of two shots of city scenes: 

 

Step 1: Split the clip 

Make a cut in the clip at the first frame of the second shot. You can do this with the razor tool or by placing the current time indicator at the cut 
point and then pressing CTL-K (CMD-K on the Mac). This creates two separate clips like so: 

https://www.mediacollege.com/adobe/premiere/pro/transition
https://www.mediacollege.com/video/editing/transition/crossfade.html
https://www.mediacollege.com/adobe/premiere/pro/tool/razor.html
https://www.mediacollege.com/adobe/premiere/pro/workspace/current-time-indicator.html


 

You might think that you can now go ahead and apply the transition, but if you do you'll notice that it doesn't work. That's because there's 
another step to complete first... 

Step 2: Create Handles 

In order for the transition to work you'll need "handles" at the start and end of each clip. We'll explain this in more detail below but first here's 
how to do it: 

You will need to shorten each clip—for the first clip you'll take some frames off the end, for the second clip you'll take some frames off the 
beginning. You can do this by clicking and dragging the ends of the clips. (Note: Shortening clips is necessary to create a proper transition but 
there are some possible workarounds if you really don't want to shorten them—see below.) 

Decide how long you want the transition to be, then shorten the end of the first clip by half that amount. Shorten the start of the second clip by 
the same amount. In our example we want a 20-frame transition, so we take 10 frames off the end of the first clip and 10 frames off the start of 
the second clip, like so: 

 

Close the gap between the clips (drag the second clip to the left or click the empty space and hit the Delete key). 



Note: There are faster ways to do this whole process (e.g. the Ripple Delete tool) but this is the simplest way to show it visually. 

Step 3: Apply the transition 

Now you can add the transition and it will work. Done! 

 

 

For more detailed information, please visit: https://www.mediacollege.com/adobe/premiere/pro/transition/split-transition.html 
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What Does Rendering Do? 

Premiere Pro works by referencing your assets from the stored folders. While this helps keep project sizes small and manageable, it can lead 
to issues in the playback of your project. 

When you add video clips, effects, or transitions to your timeline, Premiere will automatically be able to playback your project for you to view. 
But keep in mind, it has not rehearsed doing so! Rendering a section of your project means that Premiere creates a preview clip that is hidden 
behind the scenes. Then, when you come to play that clip, Premiere refers to the preview version where all of the color, effects, and transitions 
are a part of the clip. 

If you make a change to a clip or effect, you will need to re-render that section so that Premiere can create a new preview file. If no changes 
are made the clip will continue referencing the preview file giving you full speed and quality playback. 

What Do the Rendering Colors Mean? 

Premiere Pro will indicate when the project needs rendering through a series of colored bars at the top of the timeline. 



 

Green 

If you have a green bar at the top of your timeline, it means the footage has been rendered, and there is an associated preview file attached to 
the section. You will be able to playback your project at full speed with no interruptions. 

Yellow 

A Yellow bar indicates that there is no rendered preview file associated with the clip. Instead, Premiere will render the clip, effect, or transition 
frame by frame just before it reaches that point during playback. A yellow bar will appear if the unrendered clip is quite simple, and should 
playback with little to no issues. 



Red 

A red render bar indicates that there is no preview file associated with the clip, but unlike the yellow render bar, the clip is likely to be heavily 
effected or complicated and will undoubtedly cause lagging during playback. 

No Color 

If there is no color on the timeline, this tells you that there is no rendered preview file associated with the clip, but the codec of the media you 
are using is simple enough to be used as a preview file. You will be able to playback with no issues. 

How to Render in Premiere Pro 

Before you begin the rendering process, you need to define the work area that you want to render. If you‘re going to render the entire timeline, 
you can skip to the next step, but it is essential that you become used to regularly rendering the sections as you go. 

Define the Work Area 

To define the area you want to render, place your player head at the beginning of the section and press I to mark the in point. Move the player 
head to the end of the section and press O to mark out. 

If you do this in both the timeline and the media viewer, and you will see the selection highlighted once you have added in and out points. You 
can then drag the ends of the area to change the selection to whatever you need. 



 

 



Render a Preview File by Selecting the Area 

nce you have selected the area you wish to render, you can find the render options in the Sequence Menu at the top. 

There are three different options to render: 

1. Render Effects In to Out 

Use this to render out any of the red bars in your timeline. This type of render is looking specifically for effects and transitions, which are the 
most likely cause of lagging in projects. You can also just press Return on your keyboard once you have defined the work area. 

2. Render In to Out 

Using this will render everything within your selected work area with a red or yellow bar. While this is great for general rendering, it can be time-
consuming for larger projects. 

3. Render Audio 

Fully living up to its name, this function will render just the audio within your selected work area. This option is great if you are working with of 
sound effects or music tracks, but very simple footage. By default, Adobe does not render audio automatically alongside the video and will need 
rendering separately. If you don‘t want this default, you can turn this off by changing the settings in the preferences window 



 

Pro Tips & Troubleshooting 

Why is My Project Taking So Long to Render? 

There are several reasons that your project might take a while to render; it could be your device is struggling or that it is just a big project. One 
of the most common complaints about rendering is, ―it started fast and then really slowed down.‖ This is most likely to do with the Render 
Progress bar. 



 

 

Effective Rendering 

 For the fastest rendering make sure you are using the correct graphics card, and that you have enough RAM. 
 Use an SSD (Solid State Drive) to store your more significant editing projects. This helps to increase the speed of both Premiere and 

your editing system. 
 You can cancel rendering at any time from the progress bar. Rendering is completed in blocks, so you will retain any preview files that 

were created before you canceled the render. 
 Rendering your project on a regular basis can save vast amounts of time in the exporting process. 
 When you export your project, Premiere renders then compresses it. If your project is rendered, you can save time in the export by 

selecting the Use Previews checkbox. Pro will then use the preview files in the compression rather than rendering from scratch. 



 
 

The process of Adobe Premiere Pro rendering can seem like an annoying inconvenience which cuts into your editing time. When done 
regularly and appropriately, it can save you a lot of time and frustration with playback and exporting videos. 

For more detailed information, please visit: https://motionarray.com/learn/premiere-pro/how-to-render-video-adobe-premiere-pro/ 
Also Visit: http://www.adobepress.com/articles/article.asp?p=2118683&seqNum=9 
And: https://helpx.adobe.com/premiere-pro/using/rendering-previewing-sequences.html 
 

https://motionarray.com/learn/premiere-pro/how-to-render-video-adobe-premiere-pro/
http://www.adobepress.com/articles/article.asp?p=2118683&seqNum=9
https://helpx.adobe.com/premiere-pro/using/rendering-previewing-sequences.html


Videos: 

 

Set project properties 
https://www.youtube.com/watch?v=0B2dFDOZK7I 
https://www.youtube.com/watch?v=HzJgeFxYLk4 
https://www.youtube.com/watch?v=13dHjG4z40w 
https://www.youtube.com/watch?v=kTav3xV1BRA 
https://www.youtube.com/watch?v=npc3jA741eI 
https://www.youtube.com/watch?v=cUcNbxiKPTk 

 

Import Data 
https://www.youtube.com/watch?v=8QW5rijWC-o 

https://www.youtube.com/watch?v=PzlJoR0pX00 

https://www.youtube.com/watch?v=ZH06VI0DyJY 

https://www.youtube.com/watch?v=6PmzBqMFwSI 

https://www.youtube.com/watch?v=d1PWEHRQyTs 

 

Set Sequence 
https://www.youtube.com/watch?v=tcNj1TR7Sug 
https://www.youtube.com/watch?v=siYCSSMaU3A 
https://www.youtube.com/watch?v=tja0_RKTLFE 
https://www.youtube.com/watch?v=uyrACNYJ9QM 
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Balance Audio 
https://www.youtube.com/watch?v=KHbuNWhiPVk 
https://www.youtube.com/watch?v=_esHZjmCLkE 
https://www.youtube.com/watch?v=yN4WNG-XYcw 
https://www.youtube.com/watch?v=Y9TL4tST5_A 
https://www.youtube.com/watch?v=fwIF2GI8ppE 

 

Perform Color Balancing/ Grading 
https://www.youtube.com/watch?v=0VDbf9VsZ88 
https://www.youtube.com/watch?v=cuEhGR0QJmE 
https://www.youtube.com/watch?v=c6tHhTxD8Zw 
https://www.youtube.com/watch?v=q0YAoyYopzE 
https://www.youtube.com/watch?v=ZpDvQq-Zcno 
https://www.youtube.com/watch?v=rpbkqyAhQyc 

 

Prepare Roughcut 
https://www.youtube.com/watch?v=eJf5Ti6TFqQ 
https://www.youtube.com/watch?v=AvbGcAvapdQ 
https://www.youtube.com/watch?v=JnW1_21o2FQ 
https://www.youtube.com/watch?v=O6ERELse_QY 
https://www.youtube.com/watch?v=5npGpqfPORM 

 

Make Revisions 
https://www.youtube.com/watch?v=XUbCinsh3E4 
https://www.youtube.com/watch?v=AwOX8_nKQh0 
https://www.youtube.com/watch?v=SoRtvYy9f4Q 
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Prepare Final Cut 
https://www.youtube.com/watch?v=wjJwaWUHdvU 
https://www.youtube.com/watch?v=00gJ-Y1fGlg 
https://www.youtube.com/watch?v=U4lZcThfmFo 
https://www.youtube.com/watch?v=eBCTN63VDDc 
https://www.youtube.com/watch?v=cK0C4ZVpiSU 

 

Generate Output 
https://www.youtube.com/watch?v=mtboIkD6QWc 
https://www.youtube.com/watch?v=BWjd0XNKQQ4 
https://www.youtube.com/watch?v=Tlkd4Bcqtuk 
https://www.youtube.com/watch?v=7HSkc9TLF5U 
https://www.youtube.com/watch?v=SY_h_W5I0Jo 
https://www.youtube.com/watch?v=61NFKCDqXpw 
https://www.youtube.com/watch?v=KE2xFslDA08 
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Module Learning Unit Duration 

Module A: Plan & Organize Work 

Aim: Plan & Organize Work 

Aim: After successful completion of 
this module, the student is competent 
in maintain safe work environment 
according to professional standards 
and by respecting safety and health 
regulations 

 

 

 
LU1: Set objectives and plan work activities 
LU2: Plan and schedule work activities 
LU3: Implement work plans 
LU4: Monitor work activities 
LU5: Review and evaluate work plans and activities 

 

 

30 Hrs 

Module C: Develop Library 

Aim: After successful completion of 
this module, the student is competent 
in performing buffing operation 
according to professional standards 
and by respecting safety and health 
regulations. 

 
LU1: Collect Storyboard/Script 
LU2: Collect Stock Footage 
LU3: Grab Video 
LU4: Grab Audio 

 

 

20 Hrs 

Module D: Perform Compositing 

Aim: After successful completion of 
this module, the student is competent 
in performing hydraulic press operation 
according to professional standards 
and by respecting safety and health 
regulations 

 

 
LU1: Review Project Brief 
LU2: Set Compositing Properties 
LU3: Import Media 
LU4: Set Compositing Duration 
LU5: Create Animation 
LU6: Make Revisions 

 

 

80 Hrs 

Module E: Design Graphics 

Aim: After successful completion of 
this module, the student is competent 
in performing ironing operation 
according to professional standards 
and by respecting safety and health 
regulations 

 
LU1: Review Design Brief 
LU2: Select Tools for Designing Graphics 
LU3: Prepare a Design Layout 
LU4: Use Techniques for Designing Graphic 
 

 

80 Hrs 

 

 

Module summary 

Module Learning Unit Duration 



Module Learning Unit Duration 

Module F: Mix Sound 

Aim: After successful completion of 
this module, the student is competent 
in performing measuring operation 
according to professional standards 
and by respecting safety and health 
regulations 

 
LU1: Prepare sound equipment 
LU2: Record sound 
LU3: Mix sound 
 

 

80 Hrs 

Module G: Carryout Non-Liner 
Editing 

Aim: After successful completion of 
this module, the student is competent 
in performing measuring operation 
according to professional standards 
and by respecting safety and health 
regulations 

 
LU1: Set project properties 
LU2: Import Data 
LU3: Set Sequence 
LU4: Balance Audio 
LU5: Perform Color Balancing/ Grading 
LU6: Prepare Roughcut 
LU7: Make Revisions 
LU8: Prepare Final Cut 
LU9: Generate Output 
 

 

100 Hrs 

 

 



Frequently Asked Questions: 

1. What is Competency Based 
Training (CBT) and how is it 
different from currently offered 
trainings in institutes? 

Competency-based training (CBT) is an approach to vocational education and 
training that places emphasis on what a person can do in the workplace as a result 
of completing a program of training. Compared to conventional programs, the 
competency based training is not primarily content based; it rather focuses on the 
competence requirement of the envisaged job role. The whole qualification refers to 
certain industry standard criterion and is modularized in nature rather than being 
course oriented. 

2. What is the passing criterion for 
CBT certificate? 

You shall be required to be declared ―Competent‖ in the summative assessment to 
attain the certificate. 

3. What are the entry requirements for 
this course? 

The entry requirement for this course is 8th Grade or equivalent.  

4. How can I progress in my 
educational career after attaining 
this certificate?  

You shall be eligible to take admission in the National Vocational Certificate Level-3 
in Leather Products Development Technician (Pattern Maker). You shall be able to 
progress further to National Vocational Certificate Level-4 in Leather Products 
Development Technician (Computerized Pattern Designer); and take admission in a 
level-5, DAE or equivalent course. In certain case, you may be required to attain an 
equivalence certificate from The Inter Board Committee of Chairmen (IBCC). 

5. If I have the experience and skills 
mentioned in the competency 
standards, do I still need to attend 
the course to attain this certificate? 

You can opt to take part in the Recognition of Prior Learning (RPL) program by 
contacting the relevant training institute and getting assessed by providing the 
required evidences. 

6. What is the entry requirement for 
Recognition of Prior Learning 
program (RPL)? 

There is no general entry requirement. The institute shall assess you, identify your 
competence gaps and offer you courses to cover the gaps; after which you can take 
up the final assessment. 

7. Is there any age restriction for entry 
in this course or Recognition of 
Prior Learning program (RPL)? 

There are no age restrictions to enter this course or take up the Recognition of Prior 
Learning program 



8. What is the duration of this course? The duration of the course work is 1,510 hrs. (11 months) 

9. What are the class timings? The classes are normally offered 25 days a month from 08:00am to 01:30pm. 
These may vary according to the practices of certain institutes. 

10. What is equivalence of this 
certificate with other qualifications? 

As per the national vocational qualifications framework, the level-4 certificate is 
equivalent to Matriculation. The equivalence certificate can be obtained from The 
Inter Board Committee of Chairmen (IBCC). 

11. What is the importance of this 
certificate in National and 
International job market? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
These standards are also recognized worldwide as all the standards are coded 
using international methodology and are accessible to the employers worldwide 
through NAVTTC website. 

12. Which jobs can I get after attaining 
this certificate? Are there job for this 
certificate in public sector as well? 

You shall be able to take up jobs in the leather products making companies in the 
functions of cutting, stitching and finishing of leather gloves and garments. 

13. What are possible career 
progressions in industry after 
attaining this certificate? 

You shall be able to progress up to the level of supervisor after attaining sufficient 
experience, knowledge and skills during the job. Attaining additional relevant 
qualifications may aid your career advancement to even higher levels. 

14. Is this certificate recognized by any 
competent authority in Pakistan? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
The official certificates shall be awarded by the relevant certificate awarding body. 

15. Is on-the-job training mandatory for 
this certificate? If yes, what is the 
duration of on-the-job training? 

On-the-job training is not a requirement for final / summative assessment of this 
certificate. However, taking up on-the-job training after or during the course work 
may add your chances to get a job afterwards. 

16. How much salary can I get on job 
after attaining this certificate? 

The minimum wages announced by the Government of Pakistan in 2019 are PKR 
17,500. This may vary in subsequent years and different regions of the country. 
Progressive employers may pay more than the mentioned amount. 

17. Are there any alternative certificates There are some short courses offered by some training institutes on this subject. 



which I can take up? Some institutes may still be offering conventional certificate courses in the field.  

18. What is the teaching language of 
this course? 

The leaching language of this course is Urdu and English. 

19. Is it possible to switch to other 
certificate programs during the 
course? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field. 

20. What is the examination / 
assessment system in this 
program? 

Competency based assessments are organized by training institutes during the 
course which serve the purpose of assessing the progress and preparedness of 
each student. Final / summative assessments are organized by the relevant 
qualification awarding bodies at the end of the certificate program. You shall be 
required to be declared ―Competent‖ in the summative assessment to attain the 
certificate. 

21. Does this certificate enable me to 
work as freelancer? 

You can start your small business of stitching leather garments, gloves of other 
products. You may need additional skills on entrepreneurship to support your 
initiative. 

  



Test Yourself (Multiple Choice Questions) 

MODULE 1 Plan & Organize Work    

      

MODULE  2     

Question 1 The brain of any computer system is  A ALU 

     B Monitor  

    Xx C CPU  

     D None of the above 

 

Question 2 Which part of the computer shows you 

information from the computer? 

 A Mouse  

     B Keyboard   

    Xx C Monitor  

  

 

   D None of the above 

Question 3 Which computer part can you point and 

click with? 

 A Keyboard  

 



    Xx B Mouse  

    C Speaker 

Question 4 Which part of the computer is used to 

type in information into the computer? 

Xx A Keyboard  

 

     B Mouse 

 

     C Joystick  

 

    D None of the above 

Question 5 Which is not basic part of computer   A CPU 
 

    B Hard drive  

    C Monitor  

   Xx D Camera  

Question 6 Keyboard is not output device   A True  

    B False  



Question 7 CPU is central _______________ unit  A Power  

     B Picture 

   Xx C Processing  

 

     D None of the above  

Question 8 A ________Copies pictures and pages, 
and turns them into images that can be 
saved on a computer.  

Xx A Scanner  

     B Printer 

    C Camera  

 

    D None of the above 

Question 9 Which is not storage device    A Hard drive  

    Xx B Mother board  

    C CD 

 

    D USB 



Question 10 Hardware refers to the physical 
_____________of a computer. 

 A Equipment  

     B Power 

   Xx C Components  

    D None of the above 



Module  3     

Question 1 A _______________ is a visual outline 
for your video 

 A Script  

    Xx B Storyboard   

    C Concept  

    D None of the above 

Question 2 A video shot log is a written record of 

the shots on a tape or disk 

Xx A log  

    B book 

    C Not  

    D None of the above 

      



Question 3 _____________video usually requires 

encoding or post-production software 

 A Recording  

    Xx B Capturing 

     C Distortion  

Question 4 the processor chip on the capture card 

stores the video images into a memory 

area called a buffer 

Xx A True  

    B False  

Question 5 ____________ is a term used to 

describe any sound or noise that is 

within a range the human ear is capable 

of hearing. 

Xx A Audio 

    B Video 

    C Sound  

    D All of above 

 

Question 6 Which is not Audi format  Xx A AVI 

    B MP3 

    C WAV 

https://www.computerhope.com/jargon/s/sound.htm


    D AAC 

 

Question 7 MP3 and WAV is not Audio formats   A True 

   Xx B False  

Question 8 ACC is video format   A True  

   Xx B False 

Question 9 we can capture audio and video 

separately 

Xx A True  

    B False 

Question 10 Log sheets saves time Xx A True  

    B False 

Module  4     

Question 1 Compositing is the ___________of 
multiple layers of images or video 
elements to render a final still or moving 
image 

Xx A Combination 

    B File  

https://whatis.techtarget.com/definition/image


    C Part 

    D All of above 

 

Question 2 Adobe After Effects is a digital visual 
effects, motion graphics, 
and ___________ software.   

 A Typing  

   Xx B Compositing 

    C Editing  

    D None of the above 

Question 3 Animation is a method in which pictures 
are manipulated to appear as moving 
images 

Xx A True 

    B False  

Question 4 _____________ animation implies that 
the object is two dimensional. 

 A 2B 

   Xx B 2D 

Question 5 3D animation comprises of objects in 
height, width, and __________ 

 A Direction  

   Xx B Depth 

https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Motion_graphics
https://en.wikipedia.org/wiki/Compositing


    C Rang  

    D None of the above  

Question 6 3D animation is all about 
_____________ 

Xx A Movements 

    B Frame 

    C Direction  

    D None of the above  

Question 7 Which is not video format   A AVI 

   Xx B WAV 

    C MP4  

   Xx D MP3  

Question 8 FLV files are videos that are encoded 
by Adobe ____________ 

 A Photoshop  

   Xx B Flash 

    C Premier  



    D Aftereffect   

Question 9 4:3 and 16:19 is not aspect ratio   A True  

   Xx B False  

Question 10 Cameras in aftereffects can work on 2d 
layers? 

Xx A True  

    B False  

Question 11 We cannot change composition size 
and duration any time. 

 A True  

   Xx B False  

Question 12 We cannot import audio in aftereffects  A True  

    B False  

Question 13 2d layers cannot be changed to 3d in 
composition. 

 A True  

    B False  



    B Animation  

   Xx C Graphic design 

    D Video Editing  

Question 2 Raster images, also known as bitmaps  Xx A True  

    B False   

Question 3 Raster graphics based on 
___________ 

 A Line  

    B Vector   

   Xx C Pixel  

Question 4 Vector graphics is based line  Xx A True  

    B False  

Question 5 Which color mode is used for Broadcast 
Graphics? 

Xx A RGB 

    B CMYK 

 

 

   C Bitmap  

Module  5     

Question 1 ____________is the craft of creating 
visual content to communicate 

 A Compositing   

 D Gray Scale  

https://www.printcnx.com/resources-and-support/addiational-resources/raster-images-vs-vector-graphics/


 

 

  

Question 6 What does DPI stands for?  A Digits per inch         

   Xx B Dot per inch 

    C Design per inch  

    D Double Pixel inject  

Question 7 Photoshop cannot be used for web 
layout designing. 

 A True  

   Xx B False   

Question 8 We cannot save an image with 
transparent background in Photoshop. 

 A True  

   Xx B False   

Question 9 Pen tool is not selection tool.  A True  

   Xx B False   

Question 10 A megapixel is equal to ______million 
pixels 

Xx A One 

    B Two 



Module  6     

Question 1 Audio means of _______or of the 
reproduction of __________ 

Xx A Sound  

    B Layer  

    C Voice  

    D Vocal  

Question 2 Audio is not a more technical term, 
referring to sound coming from a 
recording, transmission or electronic 
device.  

 A True  

   Xx B False   

Question 3 stereo uses two channels, but it can 
use more 

Xx A True  

    B False   

Question 4 XLR cable is not use for Audio  A True  

   Xx B False   

Question 5 MIDI cables are not used to sync and 
communicate instructions between MIDI 
compatible gears 

 A True  

Xx B False   



   

Question 6 ______________capture sound and 
transform it into electrical impulses that 
are sent to the video recorder 

Xx A Microphone  

    B Speaker  

Question 7 A ___________ is a long pole to which 
a microphone is attached 

 A Beam  

   Xx B Boom 

    C Codeless  

    D Hand Mic  

Question 8 A windscreen is a small cover, usually 
of foam rubber, that fits over the top of 
the microphone. 

Xx A True  

    B False  

Question 9 A sound mixer is a device which takes 
two or more audio________ 

Xx A Voice  

    B Frequency  

    C Signals 

 D None of the above 



   

Question 10 Sound recording is 
the _____________ of sound  

 A Rendering  

   Xx B Storage 

    C Capture 

    D Grape  

Module  7     

Question 1 ___________is the process of 
manipulating and rearranging video 
shots to create a new work 

 A Compositing  

   Xx B Video editing  

    C Sound editing  

    D Graphic Designing  

Question 2 Which is type of video editing   Xx A Non-Linear Editing 

    B Raster  

 C Compositing  

 D None of the above 

https://simple.wikipedia.org/wiki/Sound
https://simple.wikipedia.org/wiki/Recording


   

   

Question 3 A hardware or firmware device used to 
convert analogue video into digital 
video is called______________ 

Xx A Capture Device 

    B Compressors & Codecs 

    C Encoding 

    D None of the above 

Question 4 
An editing method which uses computer 
software to edit the footage is called 
_____________ 

 A Linear Editing 

   Xx B Non Linear Editing 

    C Encoding 

    D None of the above 

Question 5 Sound recording is 
the _____________ of sound  

 A Rendering  

   Xx B Storage 

 C Capture 

 D Grape  

https://simple.wikipedia.org/wiki/Sound
https://simple.wikipedia.org/wiki/Recording


   

   

Question 6 __________ is also terminology of 
video editing   

 A Pre Production  

   Xx B Post Production 

    C Rendering  

    D None of the above 

Question 7 Vfx Stand For  A Various effect   

   Xx B Visual Effects 

    C Video Frame 

    D None of the above 

Question 8 What Is The Standard Frame Rate For 
NTCS Television? 

 A 24 frames per second 

   Xx B 29.97 frames per second 

    C 16 frames per second 

 D None of the above 



   

Question 9 What Is The Shortest Transition In 
Editing? 

Xx A Cut  

    B Pest  

    C Round 

    D None of the above 

Question 10 The Dimensions In Pixels Of A 16:9 
1080p High Definition Frame Are 

Xx A 1920 x 1080 pixels 

    B 750 x 565 pixels 

    C 2000 x 1080 pixels 

    D None of the above 



MODULE 1 Plan & Organize Work    

MODULE  2     

Question 1 The brain of any computer system is  C CPU  

Question 2 Which part of the computer shows you 

information from the computer? 

 C Monitor  

Question 3 Which computer part can you point and 

click with? 

 B Mouse  

Question 4 Which part of the computer is used to 

type in information into the computer? 

 A Keyboard  

 

Question 5 Which is not basic part of computer   D Camera  

Question 6 Keyboard is not output device   A True  

 

ANSWERS 



Question 7 CPU is central _______________ unit  C Processing  

 

Question 8 A ________Copies pictures and pages, 
and turns them into images that can be 
saved on a computer.  

 A Scanner  

Question 9 Which is not storage device    B Mother board  

Question 10 Hardware refers to the physical 
_____________of a computer. 

 C Components  

Module  3     

Question 1 A _______________ is a visual outline 
for your video 

 B Storyboard   

Question 2 A video shot log is a written record of 

the shots on a tape or disk 

 A log  

Question 3 _____________video usually requires 

encoding or post-production software 

 B Capturing 

Question 4 the processor chip on the capture card 

stores the video images into a memory 

area called a buffer 

 A True  

Question 5 ____________ is a term used to 

describe any sound or noise that is 

within a range the human ear is capable 

of hearing. 

 A Audio 

Question 6 Which is not Audi format   A AVI 

Question 7 MP3 and WAV is not Audio formats   B False  

https://www.computerhope.com/jargon/s/sound.htm


Question 8 ACC is video format   B False 

Question 9 we can capture audio and video 

separately 

 A True  

Question 10 Log sheets saves time  A True  

Module  4     

Question 1 Compositing is the ___________of 
multiple layers of images or video 
elements to render a final still or moving 
image 

 A Combination 

Question 2 Adobe After Effects is a digital visual 
effects, motion graphics, 
and ___________ software.   

 B Compositing 

Question 3 Animation is a method in which pictures 
are manipulated to appear as moving 
images 

 A True 

Question 4 _____________ animation implies that 
the object is two dimensional. 

 B 2D 

Question 5 3D animation comprises of objects in 
height, width, and __________ 

 B Depth 

Question 6 3D animation is all about 
_____________ 

 A Movements 

Question 7 Which is not video format   B WAV 

    D MP3  

https://whatis.techtarget.com/definition/image
https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Visual_effects
https://en.wikipedia.org/wiki/Motion_graphics
https://en.wikipedia.org/wiki/Compositing


Question 8 FLV files are videos that are encoded 
by Adobe ____________ 

 B Flash 

Question 9 4:3 and 16:19 is not aspect ratio   B False  

Question 10 Cameras in aftereffects can work on 2d 
layers? 

 A True  

Question 11 We cannot change composition size 
and duration any time. 

 B False  

Question 12 We cannot import audio in aftereffects  B False  

Question 13 2d layers cannot be changed to 3d in 
composition. 

 B False  

Module  5     

Question 1 ____________is the craft of creating 
visual content to communicate 
messages 

 C Graphic design 

Question 2 Raster images, also known as bitmaps   A True  

Question 3 Raster graphics based on 
___________ 

 C Pixel  

Question 4 Vector graphics is based line   A True  

Question 5 Which color mode is used for Broadcast 
Graphics? 

 A RGB 

https://www.printcnx.com/resources-and-support/addiational-resources/raster-images-vs-vector-graphics/


Question 6 What does DPI stands for?  B Dot per inch 

Question 7 Photoshop cannot be used for web 
layout designing. 

 B False   

Question 8 We cannot save an image with 
transparent background in Photoshop. 

 B False   

Question 9 Pen tool is not selection tool.  B False   

Question 10 A megapixel is equal to ______million 
pixels 

 A One 

Module  6     

Question 1 Audio means of _______or of the 
reproduction of __________ 

 A Sound  

Question 2 Audio is not a more technical term, 
referring to sound coming from a 
recording, transmission or electronic 
device.  

 B False   

Question 3 stereo uses two channels, but it can 
use more 

 A True  

Question 4 XLR cable is not use for Audio  B False   

Question 5 MIDI cables are not used to sync and 
communicate instructions between MIDI 
compatible gears 

 B False   

Question 7 A ___________ is a long pole to which 
a microphone is attached 

 B Boom 



Question 8 A windscreen is a small cover, usually 
of foam rubber, that fits over the top of 
the microphone. 

 A True  

Question 9 A sound mixer is a device which takes 
two or more audio________ 

 C Signals 

Question 10 Sound recording is 
the _____________ of sound  

 B Storage 

Module  7     

Question 1 ___________is the process of 
manipulating and rearranging video 
shots to create a new work 

 B Video editing  

Question 2 Which is type of video editing    A Non-Linear Editing 

Question 3 A hardware or firmware device used to 
convert analogue video into digital 
video is called______________ 

 A Capture Device 

Question 4 
An editing method which uses computer 
software to edit the footage is called 
_____________ 

 B Non Linear Editing 

Question 5 Sound recording is 
the _____________ of sound  

 B Storage 

Question 6 __________ is also terminology of 
video editing   

 B Post Production 

Question 7 Vfx Stand For  B Visual Effects 

https://simple.wikipedia.org/wiki/Sound
https://simple.wikipedia.org/wiki/Recording
https://simple.wikipedia.org/wiki/Sound
https://simple.wikipedia.org/wiki/Recording


Question 8 What Is The Standard Frame Rate For 
NTCS Television? 

 B 29.97 frames per second 

Question 9 What Is The Shortest Transition In 
Editing? 

 A Cut  

Question 10 The Dimensions In Pixels Of A 16:9 
1080p High Definition Frame Are 

 A 1920 x 1080 pixels 

 

 




